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1 Introduction 
 
This manual is intended as a reference guide for users during the training and implementation of 
version 1 of the RM Billing module. This module offers an effective way of bulk billing students for 
items such as subject charges, camps and excursions etc., and also for receipting payments. 
 
In addition to student billing, RM Billing supports billing of external customers – companies or 
individuals outside of the school environment. Customer records can be created, billing and 
receipting can take place and statements and invoices can be produced. 
 
This module is fully integrated with the suite of Integris education management software. Core 
school data such as student details, parent/guardian details and subject information is accessed by 
the RM Billing module so there is no need to re-enter key information.  
 
RM Billing is also linked to the RM Finance accounting package. This enables all receipts to be 
automatically transferred to RM Finance and allocated against the appropriate budget and analysis 
codes. 
 

1.1 Commonly Used Icons 

The following icons are commonly used throughout the RM Billing module. 
 

Icon Meaning  Description 

 
Student Find Tool Allows students to be found using a 

wide variety of criteria. See the 
Administration Manager manual for full 
details. 

 
Load All Loads all records into the window. 

 
Open Details Opens the details window for the 

selected item. 

 
Print List Prints the records shown on the screen. 

 
Print Selected Prints the records which have been 

highlighted on the screen. 

 
Hide Selected Hides all lines on the window which 

have been selected (highlighted). 

 
Hide Unselected Hides all lines on the window which 

have not been selected (not 
highlighted). 

 
Add pencil Allows an item to be added. 

 
Edit pencil Allows the selected item to be edited. 

 
Delete button Allows the selected item to be deleted. 

 
Return to view Returns the user to the front list screen. 
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2 Getting Started 
 
Before you can use the RM Billing module your school will need to be operational with the Integris 
Administration Manager software (General and Admin modules). If you wish to use RM Billing to 
bill students for subject contributions and charges based on their timetabled subjects, then you will 
also need to have the Timetabling module installed. 
 

Note: If your school does not use the Timetabling module it is still possible to use the RM 

Billing module. 

 

2.1 Logging on to Integris 

 

 Double-click on the  icon on your desktop 

 After a short delay the login screen is displayed 

 Enter your User Name and Password 

 Click on Login 
 

Note: If you do not have a user name and password, contact the System Administrator for 

Integris in your school. 

It is assumed that users will have some knowledge of the Integris General and Administration 
modules. Please consult the Integris Administration Manager manual if more details are required in 
these areas. 
 

2.2 Integris setup for RM Billing 

The RM Billing module relies on the quality of the data held in the Integris General module. In 
particular, it is necessary to ensure that all student details and parent/contact information is 
accurate and up-to-date before the RM Billing module is added. 
 
This should be done before implementing RM Billing. 
 
Every student to be billed must have one contact nominated as the ‘fees biller’. This should be the 

person who is responsible for paying any costs incurred by the student. It is not possible to have 
more than one Fees Biller for a student at any one time. 
 

2.2.1 Setting Parent/Guardian 1 as the Fees Biller 

If Parent/Guardian 1 is the nominated Fees Biller: 
 

 Click on the General sidebar 

 Click on Student Details 

 Find the appropriate student 

 Click on the edit pencil 
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 Click on the Family Group tab 

 The Parent/Guardian 1 tab is selected 

 Tick the Fees Billing checkbox 

 Ensure all details are correct and complete 

 Click on OK to save 
 

 

 
 

2.2.2 Setting Parent/Guardian 2 as the Fees Biller 

 
If Parent/Guardian 2 is the nominated Fees Biller: 
 

 Click on the General sidebar 

 Click on Student Details 

 Find the appropriate student 

 Click on the edit pencil 

 Click on the Family Group tab 

 The Parent/Guardian 1 tab is selected 

 Ensure the Fees Billing checkbox is not ticked for PG1 

 Click on the Parent/Guardian 2 tab 

 Tick the Fees Billing checkbox 

 Ensure all details are correct and complete 

 Click on OK to save 
 

2.2.3 Setting another contact as the Fees Biller 

 
If another contact is the nominated Fees Biller: 
 

 Click on the General sidebar 

 Click on Student Details 

 Find the appropriate student 
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 Click on the edit pencil 

 Click on the Family Group tab 

 The Parent/Guardian 1 tab is selected 

 Ensure the Fees Billing checkbox is not ticked for PG1 

 Click on the Parent/Guardian 2 tab 

 Ensure the Fees Billing checkbox is not ticked for PG2 

 Click on the Other Contacts tab 

 Highlight the contact to be nominated as the Fees Biller 

 Click on the edit pencil on the right hand side 

 Tick the Fees Billing checkbox 

 Ensure all details are correct and complete 

 Click on OK to save 

 Ensure that no other contacts have the Fees Billing marker checked (you will need to edit 
the contact to view this option) 

 Click on OK to save 
 
 

IMPORTANT 

If you do tick more than one contact for Fees Billing in the 
Administration module then RM Billing will use the first contact found 

with the Fees Billing marker ticked. It will search the contacts in the 
order of Parent Guardian 1, followed by Parent Guardian 2, followed by 
any other contacts in the order listed. The first one found with the fees 
billing marker ticked will be the person that RM Billing will see as being 

responsible for the student’s associated costs. 

 

2.2.4 Using Speed Edit to Update the Fees Billing Marker 

Speed Edit can be used as a quick way to set the Fees Billing marker for a number of students at 
once. 
 
To set Parent/Guardian 1 as the Fees Biller using Speed Edit: 
 

 Click on the Admin sidebar 

 Click on Speed Edit 

 Click on the Area drop down list 

 Select Parent/Guardian 1 Fees Billing 

 Use the Student Find Tool to select the group of students 

 Highlight all students to be edited 

 Place a tick in the New Value check box 
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 Click on the blue tick  to modify the records 

 Click on  to save the modifications 
 
 

Note: This method can also be used to set Parent/Guardian 2 Fees Billing. 

2.2.5 Students on the Admissions roll 

Students on the Admissions Roll can be billed in the same manner as students on the current roll. 
A contact must be nominated as the fees biller before the students can be seen in RM Billing. 

2.2.6 Students on the External roll 

If your school uses an external roll then these students can be billed also. Again a contact must be 
nominated as the fees biller before the students can be accessed in RM Billing. 
 

2.2.7 Students on the Former roll 

In most cases it will probably not be necessary to bill students on the former roll. However, it is 
possible to do so by marking a fees biller for them (as for students on any roll). If students on the 
current roll have been billed in RM Billing and they then move to the former roll, their billing records 
and details will be retained in RM Billing and can be accessed and dealt with as necessary. 
 

2.2.8 Preferences 

It is assumed that preferences have already been set up, but the following will affect the operation 
of RM Billing and should be checked. 
 
Preferences are accessed via General > Control > Preferences. 
 
Paths tab:  Ensure all paths are set correctly. 
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Advanced tab:  Ensure the Academic Year display is set to single year. 

 
Defaults tab:              Ensure the Enable Fees Billing check box is ticked. 

 

 
 
 

2.3 RM Finance Setup for RM Billing 

Your school’s RM Finance datafile should also be checked before beginning to use RM Billing. You 
need to ensure that all necessary analysis, budget and supplier codes are present in your RM 
Finance datafile. 
 
The following section is included as a guide only. You should refer to the RM Billing 
Implementation Notes and the RM Finance manual for more detail if necessary. 
 

2.3.1 Checking and Creating Analysis Codes 

As a minimum, check that the following analysis codes are present in your RM Finance datafile.  
 
N3100E 
N3100I 
D4600 
 
If they do not exist you will need to create them. Refer to the RM Finance manual for further detail 
if required. 
 

2.3.2 Checking and Creating Budget Codes 

As a minimum, check that the following budget code is present in your RM Finance datafile.  
 
N3199 
 
If this code is not present it will need to be added. 
 

2.3.3 Create the Billing Supplier Code 
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It is necessary to create a general Billing Supplier Code within RM Finance. This will be used for 
any refunds entered in RM Billing which are exported to RM Finance. The exact details of the 
refund will be available in RM Billing. 
 

 RM Finance 

 Click on Records 

 Click on Income Sources/Suppliers 

 Click on New Record 

 Make the following entries on the General tab 

 

 
 

 Click on the EFT/BPAY tab 

 Make the following entries on the EFT/BPAY tab 
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 Click on OK to save 

 

IMPORTANT  

Check your entry to make sure that the short name is BILL99.  This 
must be exact – no spaces – no additional characters etc. 

 

2.4 Adding the RM Billing Module 

 

 Start Integris 

 When the login screen is presented check that the version of Integris you are running is 
correct.  

IMPORTANT  

Do not add the module unless training has been undertaken and a 
support officer from DET is in attendance to complete the 

implementation process. 

 
 

 
 

 If the version number and date are not correct – STOP. WA schools should contact the 
Customer Service Centre on 9264 5555 before proceeding. 

 

 If the version number and date are correct, login with a user name that has System 
Administration Access rights. 

 

 Check that all users are logged out of Integris. Go to General> Control > Users and check 
the ‘logged in’ column. The only user logged in should be yourself.  If other users are 
logged in then contact them to ensure they log out. 

 

x.xx.xx (dd/mm/yy) 
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IMPORTANT 

All Users (including yourself) must be logged out of Integris before 
backing up. A DoE support officer must be in attendance to assist. 

 Log out. 
 

 Make a backup of your Integris datafile 
 

 Create two additional folders on the G:\ drive.  
 

 Log into Integris as the same user. 
 

 Ensure everyone else is logged out. 
 

 Switch to Single User Mode. Go to File>Single User Lock. 
 

 Enter the password that you used when you logged in and click on OK. 

 
 

 Edit the message to appear when another user tries to log onto the system. 
 

 
 

 Click on OK. 
 

 Integris is now in single user mode.  
 

 Log out of Integris. 
 

 Now copy and paste the new RM Billing library and the new BILL library into the bin folder. 
A DET support officer will assist. 

 

 Start Integris and Log in as the same user as before. 
 

 Add the RM Billing module - Go to General>Control>Add Module. 

 

 Select the file RMBILL when prompted. 
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 A working message ‘Initialising the RM Billing module’ may be briefly displayed. 
 

 When the module has been successfully added the following message will appear: 

 
 

 Click on OK. 

 The RM Billing module will now appear on the side bar: 
 

 
 
 

IMPORTANT 

 If your school has been using the old Billing module your old data will 
have been automatically archived. It is available for ‘read only’ purposes 

in the ‘Archived Billing’ module which now appears on the side bar. 

 

 Go to Help > System Information and check the version number and date for RMBILL. 

 

 
 

 

 If your school was running the old Billing module you should also have the version of BILL 
displayed below (1.82.13 20/09/07). This is the Archived version of the Billing module. 

 

  
 

 Click on Close. 
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2.5 Using RM Billing for the First Time 

This section outlines the basic process to be followed when using RM Billing for the first time. 
Additional detail on these items can be found in the relevant chapters as referenced below. 
 

2.5.1 Set the Billing Parameters 

 

 Select RM Billing from the Sidebar. 

 Select Parameters. 

 The following message is displayed: 
 

 
 

 Click on Yes. 
 

 If the RM Finance datafile location and name is K:\RMDB\fin73.df1, the RM Finance 
login screen may be presented for user authorisation. If the RM Finance datafile has a 
different name or is located elsewhere or the current Integris user name and password 
corresponds to the initials and password of an RM Finance user, then this step will be 
bypassed. 

 
 

 If the above screen appears a valid RM Finance user name and password must be entered. 
 

 The following message is then displayed: 
 

 

 
 

 Select Yes. 
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 You will be taken directly to the Parameters > Billing Parameters window with the General 
tab displayed as shown below: 

 

 
 
 

Note: To configure the Billing Parameters click on the Change Parameters button. 

 

IMPORTANT  

These billing parameters must now be correctly configured. Please refer 
to Chapter 0 on page 3-2 for detailed instructions on their configuration. 

2.5.2 Initialise the Billing Codes 

Once the Billing Parameters have been configured, clicking on any icon on the RM Billing sidebar 
will cause the following message to be displayed: 
 

 
 

 Click on Yes and the Billing Codes window will be automatically opened as illustrated 
below.  The two billing codes NA and SUS have been created by the system – however, 
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the budget and analysis codes that relate to them must be set by the user before 
proceeding. 

 

 
 
Please refer to section 3.1 for instructions on setting up the billing codes. 
 

Note: Additional Billing Codes may be created at this time or at any time in the future as 

required. 

 

2.5.3 Open the Students window 

The final step in the implementation process is to open the Students window. 
 

 Click on Students on the RM Billing sidebar 
 

The first time this window opens (i.e. the first time RM Billing is used) the process may take 
several minutes. This is because RM Billing needs to create the Billing Student Records 
internally. Whilst this is occurring the following working message will be displayed: 
 

 
 

On subsequent openings of the window the Billing Student Records are only created for any new 
students which have not been accessed in RM Billing previously.  The student balances are always 
calculated when the window opens, if the option to ‘Automatically show student balances’ is ticked 
in the Billing Parameters section. Please refer to section 3.4.1 on page 3-7 for further information 
on this option. 
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RM Billing is now ready to be used. 

 

2.6 User Access Rights 

2.6.1 Validation of RM Finance Connected User 

In addition to the security measures already in place within Integris, RM Billing performs certain 
validation within the linked RM Finance datafile based on the RM Finance user login.  In order to 
achieve this validation, the user’s RM Finance login details are saved within RM Billing for the 
user’s current login session. 
 
The first time a user attempts to access RM Billing they may be presented with a window similar to 
the RM Finance login screen (illustrated below).  The user must validate themselves before 
proceeding. 
 

 
 
Once a valid RM Finance user has been determined either by the user name and password 
matching the RM Finance user and password or a valid user and password combination being 
entered on the RM Finance login screen, the RM Finance user initials are saved.  The saved RM 
Finance user is used to check access rights. 
 
If the logged in user leaves RM Billing and enters another module on the sidebar and then returns 
to RM Billing (without logging out), the user name is not checked again.  The user name remains 
saved for that user’s log in session and is not retained for future login sessions.  The RM Finance 
screen is not displayed again. 
 
When another user logs in (for example in a multi-user environment), the matching RM Finance 
initials is also saved for this user and the correct validation used for each user respectively. 
 
If an incorrect username/password combination is entered then the following message will be 
displayed. 
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If they choose to cancel the operation then they will be denied access to RM Billing and a message 
similar to the following will be displayed: 
 

 
 
If the current Integris User name corresponds to the initials of a valid user in RM Finance and their 
passwords are the same then the user is accepted as being validated and no window is presented 
to the user for validation. 
 
If the current Integris User name corresponds to the initials of a valid user in RM Finance but their 
passwords are different, then the RM Finance window will be displayed and they will have to enter 
a valid user name and password before proceeding. 
 
If RM Finance is configured in RM Billing, but for whatever reason the datafile cannot be opened, 
or some system related error has occurred then the user will not be allowed to access RM Billing.  
The following error message will be shown.  This is to circumvent users from bypassing the 
security system: 
 

 
 
In this scenario, any Integris user with Administrator Status shall be granted access to the Billing 
Parameters only to allow for the configuration errors to be addressed. The following message will 
be displayed: 
 

 
 
If ‘Yes’ is selected the Billing Parameters window will be opened. If ‘No’ is selected RM Billing 
cannot be accessed. 
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3 Parameters 
 
The Parameters section allows certain settings to be customised by the user. 
 
When Parameters is selected from the RM Billing sidebar the options appear as shown below: 
 

 
 

3.1 Billing Codes 

 
Billing Codes provide a link between RM Finance and RM Billing. 
 
In RM Billing the Billing Code represents a general type of item for which a student can be billed.  
For example we could create a billing code for Voluntary Contributions – Years 8 to 10. The billing 
code is linked to a specific analysis code and budget code within RM Finance which, for this 
example, would relate to the Voluntary Contributions for years 8 to 10.  
 
Billing Codes must also be linked to a billing category. The billing categories are the standard 
education categories – Voluntary Contributions, Charges, Other Optional Costs, Voluntary 
Approved Requests, Residential Boarding Fees, Adult Student Fees and Temporary Visa 
Overseas Students. An additional category of ‘Not Applicable’ is also available. This can be used 
for items which do not fit into any of the above categories.  
 

3.1.1 System-created Billing Codes 

There are two system-created billing codes – NA and SUS. These are automatically created by the 
system when the RM Billing module is added. 
 
NA This billing code can be used for subject costs which you do not want to display on the 

Charges and Contributions sheet.  
 
SUS This billing code relates to the suspense account in RM Finance. It is used to record any 

income received that is not assigned to any billing items as yet (unallocated credit). 
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Editing the System-Created Billing Codes 

 
The system-created billing codes must each have an analysis and budget code assigned before 
you can proceed with RM Billing. Follow the steps below to assign the codes to each. 
 

 Highlight the NA billing code 

 Click on the edit pencil (yellow pencil)  

 Enter N3100I into the Analysis field (note you can press <tab> in this field for a look up list 

of analysis codes from the RM Finance datafile) 

 Enter N3199 into the Budget field (note you can press <tab> in this field for a look up list of 

budget codes from the RM Finance datafile) 

 Click on OK to save 

 
 

 Highlight the SUS billing code 

 Click on the edit pencil (yellow pencil)  

 Enter N3100I into the Analysis field (note you can press <tab> in this field for a look up list 

of analysis codes from the RM Finance datafile) 

 Enter N3199 into the Budget field (note you can press <tab> in this field for a look up list of 

budget codes from the RM Finance datafile) 

 Click on OK to save 

 

Note: System created Billing Codes cannot be deleted. The code, description and category 
cannot be changed. The analysis and budget codes can only be edited until the code has 

been used. 
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3.1.2 User-defined Billing Codes 

It will be necessary to create some additional billing codes to be used at your school. These Billing 
Codes will represent the items/activities for which your students are commonly billed. 
 
For example, Voluntary Contributions Yrs 8-10, Charges Year 11, School Camps, Excursions, 
School Magazine etc. Each Billing Code must be attached to the correct billing category to ensure 
that the types of costs are correctly classified. 
 
There is a standard naming convention which should be followed when you are creating the billing 
codes for your school.  
 
Each Billing Code should begin with a standard 3 letter code followed by a two digit number. Refer 
to the table below for details: 
 
Standard Naming Convention for Billing Codes 
 

Code Begins with For Category Code Used For (examples) 

VOL Voluntary Contributions Secondary Subject Voluntary 
Contributions 
Primary Voluntary Contributions 

CHG Charges Subject Charges 
School Camps 
School Excursions 

OOC Other Optional Costs School Magazine 
Yearbook 

VAR Voluntary Approved 
Requests 

P&C Contributions 
Chaplain 

NA Not Applicable This should be attached to any 
subjects for which you do not want 
the costs from the subjects table 
to appear on the Charges and 
Contributions Sheet 

TVS Temporary Visa 
Overseas Students 

Temporary Visa Student Fees 

ADU Adult Student Fees Adult Student Fees 
RBF Residential Boarding 

Fees 
Residential Boarding Fees 

 
 
General Rules for Creating Billing Codes 

 

 Determine which category the Billing Code fits into 

 Use the appropriate first three letters given in the table above 

 Add a two digit number to the end of the code (no spaces) eg. VOL01 

 Give the code a description 

 Assign an Analysis Code to the billing code 

 Assign a Budget Code to the billing code 

 Assign a billing category to the billing code 
 

3.2  To create a new billing code 

 

 Click on the Parameters icon on the sidebar 
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 Double-click on Billing Codes 

 Click on the Add pencil (red pencil)  

 Enter the Billing code and press <tab> 

 Enter the description and press <tab> 

 Enter the Analysis Code (or press <tab> for a look-up list) and press <tab> 

 Enter the Budget Code (or press <tab> for a look-up list) and press <tab> 

 Select the appropriate category from the drop down list 

 Click on OK to save 

 
 

3.2.1  To edit a billing code 

 

 Click on the Parameters icon on the sidebar 

 Double-click on Billing Codes 

 Highlight the appropriate code 

 Click on the edit pencil (yellow pencil)  

 Update the required details 

 Click on OK to save 

Note: Once a Billing Code has been used in a transaction only the description can be 

edited. 

 

3.2.2  To delete a billing code 

 

 Click on the Parameters icon on the sidebar 

 Double-click on Billing Codes 

 Highlight the appropriate code 

 Click on the delete button (rubbish bin)  

 Answer ‘yes’ to the message 

 

Note: Once a Billing Code has been used in a transaction it cannot be deleted. 

 

3.2.3  To print a list of billing codes 

 

 Click on the Parameters icon on the sidebar 

 Double-click on Billing Codes 

 Click on the Print button 
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3.2.4 Refund Billing Codes 

 
At times it may be necessary to issue a refund via RM Billing. Refund transactions need to relate to 
a ‘D’ account (expenditure) in RM Finance. Therefore special refund type codes need to be created 
in RM Billing which link to the refund analysis and budget codes in RM Finance. 
 
It is important to tick the refund checkbox before you begin adding the details for the code. This is 
because the expenditure type accounts (‘D’ accounts) will not be available in the look up lists 
unless the refund box is ticked. 
 

3.3  To create a refund type billing code 

 

 Click on the Parameters icon on the sidebar 

 Double-click on Billing Codes 

 Click on the Add pencil (red pencil)  

 Tick the Refund checkbox 

 Enter the Billing code and press <tab> 

 Enter the description and press <tab> 

 Enter the Analysis Code (or press <tab> for a look-up list) and press <tab> 

 Enter the Budget Code (or press <tab> for a look-up list) and press <tab> 

 Select the appropriate category from the drop down list 

 Click on OK to save 
 

Note: ‘D’ accounts will only be available for selection once the refund checkbox has been 

ticked. Make sure you tick this box before you enter your analysis and budget codes. 
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3.4 Billing Parameters 

When the Billing Parameters window is opened it appears as shown below: 
 

  
 

3.4.1 General tab 

The following settings are available on the General tab: 
 

General Tab  

Monetary Value Warning Limit   Set by the system to $1000.  
When processing, if an entered amount exceeds the value 
defined in this box a warning message will be displayed 
asking for confirmation that the entered amount is correct. 
 
It is recommended to leave this setting as is. 

Date Warning Limit Set by the system to 30 days.  

When processing, if the date that is entered against a 
transaction is older than the number of days specified in the 
Date Warning Limit box a message will be displayed asking 
for confirmation that the date entered is correct. 
 
It is recommended to leave this setting as is. 

School’s Biller Code 1 If you have elected to display the BPAY logo on any of the 
relevant documents, enter your school’s BPAY Biller Code 
into this field. 

School’s Biller Code 2 This field should be left blank. It is a provision for possible 
future functionality. 

 
  

This location and 
name is set by 
default to 
K:\RMDB\finance.df1 
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Last Year End The 31st December of the previous year should be entered 
in this field. For example, if the current year is 2009, then 
the last year end date should be entered as 31/12/08. This 
means your current billing year will be 2009. 

BE CAREFUL when making this setting. 
Once saved it cannot be changed! 

Current Billing Year Once the Last Year End date has been saved, this is set by 
the system to the year following the last year end. 

Last Rollover The system will store the actual date on which the year end 
roll over is carried out. 

Accounting System Set by the system to RM Finance. 

ABN Enter your school’s ABN into this field.  

Automatically Show Student 
Balances 

This option is ticked by default. When it is ‘on’, the student 
balances will be calculated and displayed on the RM Billing 
> Students window each time the window is opened. If this 
option is not ticked then the student balances will not be 
calculated and the student balance column will be hidden 
when the RM Billing > Students window is opened. 

RM Finance Datafile The location and name is set initially by default to 
K:\RMDB\fin73.df1. You will need to change this to the 
current location and name of your school’s RM Finance 
datafile when the RM Billing module is installed. (e.g. 
K:\RMDB\finance.df1.) 

Enable Export To RM Finance When this option is not selected, schools will not be able to 
export transactions automatically into RM Finance. When 
schools are ready to begin exporting transactions into RM 
Finance, this option can then be selected.  
Note that once this option is ticked and saved it can never 
be ‘un-ticked’. 

RM Billing Archive Folder This will be automatically set by the system to the path of 
the RM Finance datafile (as listed above – without the 
filename), followed by \OLDDATA\Billing Archive\. 
For example K:\RMDB\OLDDATA\Billing Archive.  
This pathway will be used to store reports created by the 
‘Purge Former Roll Students’ utility. 
The pathway can be changed if required, by clicking on the 
Change Parameters button and then choosing the ‘Browse’ 
button to the right of the Archive Folder path. 

Secondary Financial Assistance This path is Optional, however schools may set a default 
path for the use of saving files created by the Secondary 
Financial Assistance export. 
The pathway can be changed if required, by clicking on the 
Change Parameters button and then choosing the ‘Browse’ 
button to the right of the Archive Folder path. Suggested 
pathway is K:\RMDB\SECONDARY ASSISTANCE 
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IMPORTANT  

It is recommended that Secondary Schools do not tick the Enable 
Export to RM Finance option initially. When your school is ready to 

begin exporting to RM Finance, contact the ICT Support desk for 
approval. Primary Schools should tick this option when commencing to 

use RM Billing. 

 

  
 

3.4.2 Charges and Contributions tab 

If you are going to use RM Billing to produce a Charges and Contributions Sheet you will also need 
to set up the Parameters for the Charges and Contributions tab. If you are not producing Charges 
and Contributions Sheets then this section can be bypassed. 
 
The following settings are available: 
 

Charges and Contributions Tab  

Show School Address   Tick this box if you would like the school 
name and address to be printed at the top 
of the Charges and Contributions Sheet. If 
un-ticked the school name and address 
will not appear so that so that school 
letterhead can be used. 

Show School Logo on right hand side Tick this box if you would like the school 
logo to appear on the right hand side of 
the header. 

 

Note: These will be set 
to K: Drive folders in 

schools. 
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Show Department Logo on left hand side Tick this box if you would like the 
Department’s logo to appear on the left 
hand side of the header. 

Narrow Logo/Wide Logo If you have elected to show the 
Department’s Logo then choose the 
correct radio button to indicate whether 
the narrow or wide version of the logo is 
being used. 

Department Logo Path If you have elected to show the 
Department’s Logo then click on the spy 
glass to the right of this field and navigate 
to the location where the logo is stored. 

Show BPAY Logo Tick this box if you would like the BPAY 
logo to be displayed on the Charges and 
Contributions Sheet. 

Show Remittance Advice Tick this box if you would like a remittance 
advice slip to be printed at the end of each 
Charges and Contributions report.  
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3.4.3 Statements tab 

The following settings relating to the layout for Statements are available: 
 

Statements Tab  

Default Statement Message The message entered here will appear by default on 
the bottom of the statement. Note that the message 
can be edited/altered at the time of printing if 
required.  
 

Show School Address  If this box is ticked then the school name and 
address will be printed at the top of the statement. If 
un-ticked the statement header will be left blank so 
that school letterhead can be used. 
This setting also applies to the Reminder Notice.* 

Show School Logo on right hand side Tick this box if you would like the school logo to 
appear on the right hand side of the header. 
This setting also applies to the Reminder Notice.* 

Show BPAY Logo Tick this box if you would like the BPAY logo to be 
displayed on the Statement. 
This setting also applies to the Reminder Notice.* 

Show Remittance Advice Tick this box if you would like a remittance advice 
slip to be printed at the end of each Statement.  
This setting also applies to the Reminder Notice.* 

Show Student Number (Schools 
Curriculum and Standards Authority 
Number) 

Tick this box if you would like the student’s Student 
Number to be displayed on the Statement. This 
setting is applicable to the Student Statement only 
(not the Customer Statement). 
This setting also applies to the Reminder Notice.* 

Default Reminder Notice Message The message entered here will appear by default on 
the bottom of the Reminder Notice*. Note that the 
message can be edited/altered at the time of printing 
if required.  
 

 
*Reports > Financial Reports > Reminder Unpaid Billing Items – Students (see section 8.6.4 on 
page 8-29). 
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3.4.4 Invoices tab 

The following settings are available relating to the layout for Invoices: 
 

Invoices Tab  

Show BPAY Logo Tick this box if you would like the BPAY logo to be 
displayed on the Invoice. 

Show Remittance Advice Tick this box if you would like a remittance advice 
slip to be printed at the end of each Invoice.  

Default Invoice Message Enter an invoice message which can be used for 
both Students and Customers 
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3.5  To change/set the Billing Parameters 

 
Click on the Parameters icon on the sidebar 

Double-click on Billing Parameters 

Click on  
Make the required settings on all tabs (refer to the tables above) 
Click on OK to save 

 
Once you have clicked on the OK button, certain warning messages may be displayed as shown 
below. 
 

3.5.1 Future Date warning 

If the Last Year End date is in the future, the following message will be displayed: 
 

 
 
Check the date. If you have a reason for setting a future date then select ‘Yes’ to proceed. 
Otherwise select ‘No’ and edit the date as required. 
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3.5.2  Last Year End Date warning 

 
A message similar to the following will always be displayed before the date is saved. Read the 
message carefully and ensure you have selected the correct date. 

IMPORTANT  

Once this date has been saved it cannot be changed! 

 

 
 
If you are certain that the entered date is correct then select ‘Yes’ to proceed. Otherwise select ‘No’ 
and edit the date as required. 
 
Once all settings have been saved, close the Billing Parameters window by clicking on the exit 

cross  in the top right hand corner. 
 

3.5.3 To Enable the Link to RM Finance 

If you have not been exporting to RM Finance previously and wish to do so from now please 
contact your DFAO for approval. Once approval has been granted, follow the steps below to 
enable the export to RM Finance functionality. 
 

3.5.4  Finalise All Batches Entered Prior to Turning on the Export 

All RM Billing receipts batches (except Government Subsidy batches) must be finalised and closed 
before the ‘Enable Export to RM Finance’ function can be turned on. 
 
This means that these batches must be manually closed and the data in these batches input 
manually into RM Finance. 
 
Follow the process below to finalise any batches: 
 

 Print the Daily Banking Summary (Receipts > For Selected > Print Daily Banking) 

 Enter the details for the batch onto the Finance batch register 

 Print the Receipts Summary report (detailed version) and file it (Receipts > For Selected 

> Print Receipts Summary) 

 Close the batch (Receipts > For Selected > Close Batch) 

 Print the ‘Totals Only’ version of the Receipts Summary report as part of the Close Batch 
process 

 Ensure the batch is closed and the transactions marked as posted (answer ‘Yes’ to the 

message) 

 Input the transactions manually into RM Finance  
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3.6  Print Re-allocation Transactions 

At times the allocation of receipts may change in RM Billing. For example, a parent may pay some 
money in advance to be used throughout the year. The money is entered in RM Billing as 
unallocated credit. It is then transferred into RM Finance and posted against the suspense account 
(N3199). 
 
Then the student is billed for a camp and the parent instructs for some of the money to used. So 
the money is now allocated in RM Billing to the Camp billing items for the student.  
 
What has happened is that the allocations in RM Billing have changed, and therefore a change 
needs to be made in RM Finance to ‘move’ the money out of the suspense account and into the 
appropriate ‘C’ account for the camp. 
 
The ‘Print Re-allocation Transactions’ function produces a report similar to the Receipts Summary 
report which lists these types of changes only, so that the necessary adjustments can be made in 
RM Finance. 
 
This report must be printed and the transactions marked as posted before the Export to RM 
Finance can be turned on. 
 
To print any re-allocation transactions: 
 

 RM Billing > Reports 

 Click on the Transactional Reports folder 

 Click on Print Re-allocation Transactions 

 

 
 

 Click on Print 

 Select the report destination as Printer 

 The Detailed report is printed, followed by the Totals Only report (example below) 
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 Go to the printer and check whether the report has printed successfully. 

 The following message is then displayed: 
 

 
 

 If the report has not printed correctly click on ‘No’ and restart this process. 

 If the report has printed successfully click on ‘Yes’. 

 If ‘Yes’ has been selected then the transactions will be marked as posted and the following 
message will be displayed: 

 

 
 

 Click on OK. 
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Note: The transactions will not be marked as posted if the report is printed to the screen. In 

this case the following message will be displayed: 

  

 The transactions listed in the report should now be entered into RM Finance as 
previously discussed. 

 

Note: The overall total of the Print Re-allocation Transactions report will always be zero. 
This is because it represents the movement of monies between accounts (e.g. debit one 
account and credit another, so the overall effect is zero). In the sample report shown above 
an income correction transaction for $20 would be entered against the suspense account 
(N3199), and an income transaction for $20 would be entered against the C account (C1001). 

3.7  Enable the Export to RM Finance 

WARNING  

Once the ‘Enable Export to RM Finance’ function has been turned on it 
cannot be disabled. Do not turn this function on until you are sure you 

are ready to begin exporting automatically. 

 

 RM Billing > Parameters > Billing Parameters 

 Click on the Change Parameters button  

 Place a tick in the Enable Export to RM Finance tick box  

 Click OK to save 

 The following message is displayed: 
 

 
 

 Click on Yes to enable the link 
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Note: When attempting to enable the link to RM Finance the following error message may 

be displayed: 

 

To correct the error check the following:  

All Receipts Batches have been closed and transactions marked as posted, as outlined in 

these notes.  

All re-allocation transactions have been printed directly to the printer and marked as 

posted, as outlined in these notes. 

 
 

3.8 GST Codes 

There are five GST codes available within RM Billing. These align to the GST codes used in RM 
Finance. Initially the codes and rates are created by the system as shown below: 
 

 
 

3.8.1 To edit a GST code 

 

 Click on the Parameters icon on the sidebar 

 Double-click on GST Codes 

 Highlight the code to be edited 

 Click on the edit pencil (yellow pencil)  

 Make the required changes 

 Click on OK to save 
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Note: The GST code number cannot be edited. The code description is editable, however, 
you cannot change the meaning of the code by changing its description. For example, you 
cannot use any code other than 8 for ‘Outside Scope’. 

 

IMPORTANT  

WA schools should not edit these codes unless notified to do so by the 
WA Department of Education. These codes must be set up as illustrated 
above to comply with Australian GST requirements and the link to RM 

Finance. 

 

3.9 Subjects 

The Subjects section of RM Billing can only be used if the Timetabling module is installed. 
 
If the Timetabling module is not installed and the Subjects section is selected, the following error 
message is displayed: 
 

 
 
If the Timetabling module is installed, then when the Subjects window opens for the very first time 
all subjects under the control of Timetabling for the current billing year will be loaded into RM 
Billing. Subjects which have been entered in the Administration module but are not under the 
control of Timetabling will not be available in RM Billing. 
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Note 1: If the Timetable has not been set up for the current/selected billing year the 
following message will be displayed. The Subjects window will open but no subjects will be 
displayed for the current/selected billing year.    

        

Note 2: The Timetable does not have to be finalised to use the Subjects section in RM 

Billing. The structure must be set up and the primary preferences entered for the students.                                                                                              

It is possible to associate all timetabled subjects with their respective costs. Each subject may 
have a Voluntary component, a Charges component, a component for Adult Student Fees and a 
component for Temporary Visa Overseas Student fees. Within the software all components are 
optional – it is entirely up to the user to set the costs associated with each subject. 
 
Each cost has a related tax code (T) and Billing Code (Code). 
 
The costs entered into the subjects table will be used on the Charges and Contributions Sheet for 
each student. 
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3.9.1 Year drop down selection list  

 
 
The Year drop down selection list will display the previous billing year, the current billing year (as 
defined in Parameters > Billing Parameters) and any future years which have been created in the 
datafile. 
 
Data for the previous billing year cannot be altered. If an attempt is made to change the values for 
the previous year the following error message is displayed: 
 

 
 

3.9.2 Print List  

 
This option will print a list of all subjects and their associated costs. 
 
 

3.9.3 Print Selected  

 
This option will print a list of all selected subjects and their associated costs. 
 

3.9.4 Hide Selected  

 
This option will hide all subjects which have been selected (highlighted). 
 

3.9.5 Hide Unselected  

 
This option will hide all subjects which have not been selected (highlighted). 
 

3.9.6 Update Subjects (after Timetable Changes)  

 
This option will display any new subjects which have been added to the Timetable for the selected 
year since the RM Billing > Parameters > Subjects window was first opened (or since the Update 
Subjects option was last selected). 
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3.9.7  To display all Timetabled Subjects 

You should click on the Update Subjects button if you cannot see a Timetabled Subject appearing 
in the Subjects list. 
 

3.9.8 For Selected Menu 

The For Selected menu contains the following options. 
 

 
 

3.9.9  Set Values 

This option enables the user to select a group of subjects and set the values associated with these 
subjects in one operation. 
 

 
 
The row tick boxes can be used individually or together to enable the required combination of 
values to be set for the selected subjects. 
 
Example: To set a Charges amount of $35 for each Year 11 subject 
 

 RM Billing > Parameters > Subjects 

 Highlight all Year 11 subjects 

 Click on For Selected > Set Values 

 Place a tick in the Charges tick box on the left hand side 

 Enter the amount as $35, the GST code of 0 and choose the billing code for Charges Year 
11 (press <tab> for a list) 

 

 
 

 Click on OK to save 

 

3.9.10  Copy Costs to Year 
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This option enables costs for selected subjects to be copied from the displayed year to a future 
year. 
 
To copy costs from one year to another: 
 

 Select the year to be ‘copied from’ from the Year drop down selection list 

 Highlight the subjects for which the values are to be copied 

 Click on For Selected > Copy Costs to Year 

 A message similar to the following is displayed: 
 

 
 

 Select the year to be ‘copied to’ from the Select Year drop down list (note that only future 

years are displayed here) 

 Click on OK  

 The subject values are copied to the selected year 
 

Note: If any of the selected subjects exist in the ‘From’ year but do not exist in the ‘To’ year 
then an error message similar to the following will be displayed: 
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3.10 Valid Payment Types 

The following valid payment types are automatically created by the system. 
 

 
 

3.10.1 To Create a Payment Type 

Note: Although it is possible to create payment types, this is not a recommended practice. 
WA schools should not create payment types unless instructed to do so by the WA 
Department of Education and Training.  

 

 Click on Parameters 

 Double-click on Valid Payment Types 

 Click on the Add pencil  

 Enter  a code for the payment type and press <tab> 

 Enter a description for the payment type 

 Click on OK to save 
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3.10.2 To edit a Payment Type 

Note:  

System-created payment types cannot be edited at all. 

User-created payment types can be edited freely if they have no transactions against them. 
If a user-created payment type has been used in a transaction then only the payment type 
description may be edited. 

 

 Click on Parameters 

 Double-click on Valid Payment Types 

 Click on the payment type to be edited 

 Click on the edit pencil  

 Make the required changes 

 Click on OK to save 

 
 

3.10.3 To delete a Payment Type 

 

Note:  
System-created payment types cannot be deleted. 

User-created payment types cannot be deleted if they have transactions against them.  

 

 Click on Parameters 

 Double-click on Valid Payment Types 

 Click on the payment type to be deleted 

 Click on the delete button  

 Click on Yes in answer to the message 
 
  



 
 
 
  

Students 

4 
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4 Students 
 
The students section is the ‘heart’ of the RM Billing module. When the Students icon is selected on 
the RM Billing sidebar the Students window will open as illustrated below. 
 

4.1.1 Students - Default Display 

 

 
 
All students on the current roll will initially be displayed. The following information is displayed for 
each student: 
 
Name 

Student surname and known name (as entered in the Integris Administration module). 

Note: If the surname and/or known name of a student is changed (i.e. edited) in the 
Administration module after this student has been viewed in RM Billing, then the new name 
details need to be updated in the RM Billing module. See section 4.11 on page 4-41 for 

further details. 

Notes 

If the student has one or more notes entered on their Notes tab then a tick will be displayed in this 
column. 
 
Year  
The current academic year group of the student (as in the Integris Administration module). 
 
Form 

The current form class of the student (as in the Integris Administration module). 
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Category 

The student billing category of the student for the current billing year (see section 4.8 on page 4-
16). 
 
Balance  
The balance outstanding (across all years) for the student. 
 

4.1.2 Students - Alternative Display 

If the option  is not ticked in Parameters > Billing Parameters, then 
the student balances will not be calculated and displayed every time the Students window is 
opened. 
 
The Balance column will be suppressed and the window will appear as illustrated below. 
 

 
 

4.1.3 Show Balances 

To display the student balances click on the  button. This will display the 
student balances temporarily on the screen.  

Note that if this window is closed by clicking on the exit cross , or by drilling down on a student, 
when it is re-opened the student balances will not be displayed. 
 
It should also be noted that clicking on the ‘Show balances’ button will load all current students into 
the window (if not all are displayed) along with their current balances (i.e. any user selection is lost 
when this button is clicked). 
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4.1.4 To Sort the List of Students 

The student list can be sorted by clicking on any of the list headings.  
 
For example, to sort the list in order of balances, click on the Balance heading. The list is sorted 

with the balances in ascending order. 
 
To sort the list in reverse order, click on the Balance heading again. The list is now sorted with the 

balances in descending order. 
 
To sort the list in order of student name, click on the Name heading. 
 

4.1.5 To Select a Group of Students 

Students can be selected on this screen in a number of ways. 
 

 By dragging the mouse over a consecutive group of students 

 By holding down the <Ctrl> key and clicking on each student to be selected 

 By using the Integris Find Tool  
 

Note: More information on the Integris Find Tool can be found in the Administration 

Manager manual. 

 

4.1.6 Quick Search on Student Surname 

 
A quick search on student surname is available on this window. For example, if you click on the 
first student in the list and then type the letter ‘B’ the cursor will move to the first student whose 
surname begins with ‘B’. If you type the entire surname (e.g. BORN), the first student in the list with 
that surname will be highlighted. 
 

4.2 Student Icons 

The following icons are available on the Student List screen: 
 

 Standard Student Find Tool   

 Load Current Students – Displays all students on the current roll 

 Open Details – Opens the drill down facility for the selected student 

 Print – Prints all students displayed in the list view 

 Print Selected – Prints all selected (highlighted) students in the list view 

 Hide Selected – Hides all selected students 

 Hide Unselected – Hides all unselected students 

 Show/Hide Deleted Students – Displays/hides students who have been deleted from the 
Administration module but still have a record in RM Billing 
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4.2.1 Drill Down Facility 

Drill down functionality is instigated by double-clicking on a student, highlighting the student and 
pressing <enter> or highlighting a student and using the Open Details icon. The Student Details 
View will now be displayed. Refer to section 4.10 on page 4-38 for further details. 
 

4.2.2 For Selected Menu 

The For Selected menu contains the following options: 
 

 
 

4.2.3 Print Statement 

This option allows a statement to be printed for the selected students. 
 

4.2.4  To Print Statements for Students 

 Select (highlight) the students from whom statements are to be printed 

 Click on the For Selected menu 

 Click on Print Statement 

 A window similar to the following will be displayed: 
 

 
 
 
The ‘From’ date will default to the first day of the current month. All transactions from this date 

onwards will be listed on the statement. Any transactions dated prior to this date will be 
summarised in an ‘opening balance’ figure. If this is the first statement you are sending to the 
parent/guardian then it is advisable to enter an earlier date so that all transactions for the 
current year are listed. 

 
The ‘To’ date will appear blank but will default to today’s date if left blank. Otherwise an end date 

may be entered. Transactions dated after the ‘To’ date will not be included on the statement. 
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The default message entered in the Billing Parameters section will be displayed. This can be 

edited at this point if required but the changes will be used for this statement run only and will 
not be saved. 

 
Change the settings as required 
Click on OK 

Select the report destination 
Statements for the selected students are printed to the selected destination 
 

Note: Statements can also be printed from the Reports section. Refer to section 8.3.2 on 

page 8-16 for further details and a sample statement. 

 

Note: Statements with zero balances will be printed if transactions have been processed 
against the student. If no transactions have been entered for the selected student then a 
statement will not be printed. 

4.2.5  To print statements for outstanding debtors only 

Sometimes it may be useful to only print statements for students who have outstanding balances. 
 

 Click on Students 

 Click on the Balance heading twice so students with balances are displayed at the top of 

the list 

 Highlight all the students with balances 

 Click on the For Selected menu 

 Click on Print Statement 

 Follow the steps outlined above to print the statements 
 

4.3 Print Charges and Contributions 

This option allows a Charges and Contributions Sheet to be printed for the selected students. 

Note: Refer to section 8.1.1 on page 8-1 for details of how to create a Charges and 

Contributions sheet template.  

 

4.3.1  To Print Charges and Contributions Sheets for Students 

 Select (highlight) the students from whom the sheets are to be printed 

 Click on the For Selected menu 

 Click on Print Charges and Contributions 

 A window similar to the following will be displayed. This window will display all the Charges 
and Contributions templates which have previously been created. 
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 Highlight the template to be used  

 Click on OK 

 A window similar to the following will then appear: 
 
 

 
 
 

 Select either the current or proposed year/form. (The proposed year/form can be used 

when printing sheets in advance for next year. Note that this information must be set up in 
the Administration module before it can be used in RM Billing.) 

 The default message (as entered in the chosen template) will be displayed. This can be 
edited at this stage if required, but any changes will be used for this print run only and will 
not be saved to the template. 

 Click on OK 

 Select the report destination 

 Charges and Contributions sheets for the selected students are printed to the selected 
destination 

 

Note: Charges and Contributions Sheets can also be printed from the Reports section. See 
section 8.1.8 on page 8-8 for details and also for a sample Charges and Contributions 

report. 
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4.4  Print Notes 

This option allows a report to be produced which prints all notes attached to the selected students. 
 

4.4.1  To Print Notes for Selected Students 

Select (highlight) the students for whom the notes are to be printed 
Click on the For Selected menu 

Click on Print Notes 
Select the required Date Range of leave blank for all 
 

 
 
Select the Report Destination 

A report similar to the following will be printed to the selected destination 
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4.5  Apply Subsidies Manually 

This option allows Government Subsidies to be applied manually to a group of students. The 
system will automatically allocate the entered subsidy amount to each student to pay off their 
Billing Items in a specified order, according to regulations.   

IMPORTANT 

This option should not be used where the Secondary Financial 
Assistance forms are completed using the software, and the Export and 

Import utilities are being used to export applications and import 
receipts. See Section 4.9 of this Manual for details.  

 

4.5.1  To Apply Government Subsidies to Students 

 Select (highlight) the students for whom the subsidies are to be applied 

 Click on the For Selected menu 

 Click on Apply Subsidies 

 If any future years have been created in the datafile, then the following message box will be 
displayed. (If future years have not been created, this step will be omitted.) Only the current 
billing year (as set in RM Billing > Parameters > Billing Parameters) and any future years 
created in the datafile will be displayed in the drop down list. 
 

 
 

 Select the year for which the subsidy is to be applied. (e.g. If it is 2015 Subsidy money then 
2015 should be selected). 

 Click on OK 

IMPORTANT  

The subsidy will only be applied to billing items which belong to the 
selected year. Any amount which cannot be applied to billing items in 

the selected year will become unallocated credit. 

 If the above ‘Select Year’ box does not appear this means that no future years have been 
created in the datafile and the subsidy will be automatically applied to the current billing 
year (as set in Billing Parameters). 

 

 A window similar to the following will then be displayed: 
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 Enter the receipts batch to hold the subsidies (or press <tab> for a list) 

 The date will default to the current date (this can be changed if required) 

 Enter the amount of the subsidy (the amount to be applied to each student) 

 The payment type defaults to GV and cannot be changed 

 Enter a comment (e.g. 2015 $235 Education Program Allowance) 

 Click on OK to save 

 

4.5.2  Rules for Applying Government Subsidies 

 
The government subsidy is applied to the billing items for the selected year for each student in a 
particular order, according to the student billing category of the student. The table below shows the 
order in which the types of billing items will be paid by the subsidy. 
 

Student Billing Category Priority for applying subsidies 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Voluntary, Charges, Residential, Other Optional Costs, 
Voluntary Approved Requests followed by any other item 
which has a category assigned (other than Not Applicable). 
 

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which has a 
category assigned (other than Not Applicable). 
 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional Costs, 
Voluntary Approved Requests followed by any other item 
which has a category assigned (other than Not Applicable). 
 

Adult Students Adult student fees, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any other 
item which has a category assigned (other than Not 
Applicable). 
 

Full Fee Paying Overseas 
Students 

Not applied, since these students are not eligible for 
Government Subsidies. 
 

 
If the full amount of the subsidy cannot be applied to the student because the total amount of the 
subsidy exceeds the total amount of billing items for the selected year, then any remaining subsidy 
amount will become unallocated credit (i.e. a credit amount which is not assigned to any billing 
items). 
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4.5.3  Apply Subsidies Exception Report 

There may be certain circumstances under which government subsidies cannot be applied to 
students. The reason could be any of the following: 
 

Student does not have a fees biller 

Student does not have a student billing category defined for the selected year 

Student is a Full Fee Paying student 

 
If for any of the above reasons the subsidy cannot be applied to a student an exception report will 
be displayed listing the student/s and the reason/s. 
 
A sample exception report appears below: 
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4.6  Apply Receipts 

This option assists with ‘bulk-receipting’ – that is, applying receipts to several students at the one 
time.    
 
This method is useful if a group of students are all paying the same amount for charges and 
contributions.  The system will automatically allocate the entered amount to each student to pay 

off their Billing Items in a specified order, according to regulations.   

 

4.6.1  To Apply Receipts to Students 

 Select (highlight) the students for whom the receipts are to be applied 

 Click on the For Selected menu 

 Click on Apply Receipts 

 If any future years have been created in the datafile, then the following message box will be 
displayed. (If future years have not been created, this step will be omitted.) Only the current 
billing year (as set in RM Billing > Parameters > Billing Parameters) and any future years 
created in the datafile will be displayed in the drop down list. 
 

 
 

 Select the year for which the receipt is to be applied. (e.g. If it is money which is being paid 
for 2015 items then 2015 should be selected). 

 Click on OK 
 

IMPORTANT  

The receipt will only be applied to billing items which belong to the 
selected year. Any amount which cannot be applied to billing items in 

the selected year will become unallocated credit. 

 If the above ‘Select Year’ box does not appear this means that no future years have been 
created in the datafile and the receipt will be automatically applied to the current billing year 
(as set in Billing Parameters). 

 

 A window similar to the following will be displayed: 
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 Enter the receipts batch to hold the receipts (or press <tab> for a list) 

 The date will default to the current date (this can be changed if required) 

 Enter the amount of the receipt (the amount to be applied to each student) 

 Enter the payment type (or press <tab> for a list) 

 Enter a comment (e.g. Charges and Contributions) 

 Click on OK to save 

 

4.6.2  Rules for Applying Receipts 

 
The receipt is applied to the billing items for the selected year for each student in a particular order, 
according to the student billing category of the student. The table below shows the order in which 
the types of billing items will be paid by the receipt. 
 
Billing Items will be paid off in the following order:   
 

Student Billing Category Priority for applying receipts 

Kindergarten, Pre-Primary, 
Primary, Secondary (Vol,Chg) 

Charges, Residential, Voluntary, Other Optional Costs, 
Voluntary Approved Requests followed by any other 
item which has a category assigned including Not 
Applicable.   

Secondary (Chg) Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 

Temporary Visa Overseas 
Students 

Temp Visa, Charges, Residential, Other Optional 
Costs, Voluntary Approved Requests followed by any 
other item which has a category assigned including 
Not Applicable. 

Adult Students Adult Student Fees, Charges, Residential, Other 
Optional Costs, Voluntary Approved Requests followed 
by any other item which has a category assigned 
including Not Applicable. 

Full Fee Paying Overseas 
Students 

Charges, Residential, Other Optional Costs, Voluntary 
Approved Requests followed by any other item which 
has a category assigned including Not Applicable. 

 
If the full amount of the receipt cannot be applied to the student because the total amount of the 
receipt exceeds the total amount of billing items for the selected year, then any remaining receipt 
amount will become unallocated credit (i.e. a credit amount which is not assigned to any billing 
items). 
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4.6.3  Apply Receipts Exception Report 

There may be certain circumstances under which receipts cannot be applied to students. The 
reason could be any of the following: 
 

Student does not have a fees biller 

Student does not have a student billing category assigned for the selected year 

 
If for any of the above reasons the receipt cannot be applied to a student an exception report will 
be displayed listing the student/s and the reason/s. 
 
A sample exception report appears below: 
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4.7  Add Students to Billing Item Batch 

This option assists with ‘bulk-billing’ – that is, billing several students at the one time.    
 

4.7.1  To Bulk-Bill Students 

 Select (highlight) the students who are to be billed 

 Click on the For Selected menu 

 Click on Add to Billing Item Batch 

 If any future years have been created in the datafile, then the following message box will be 
displayed. (If future years have not been created, this step will be omitted.) Only the current 
billing year (as set in RM Billing > Parameters > Billing Parameters) and any future years 
created in the datafile will be displayed in the drop down list. 

 

 
 

 Select the year for which the billing is to be carried out (e.g. If creating billing items for 2008 
then 2008 should be selected). 

 Click on OK 

 If the above ‘Select Year’ box does not appear this means that no future years have been 
created in the datafile and only billing item batches for the current billing year (as set in 
Billing Parameters) can be selected  

 A list of billing item batches for the selected billing year will then be displayed (these must 
have been previously created via the Billing Items section) 

 

 
 

 Highlight one or more batches in the above window (dragging or <Ctrl> click can be used 
for multiple selection) 

 Click on OK 

 A short message may be displayed whilst the students are added to the billing item batch 
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4.8  Set Student Billing Category 

This option allows the student billing category to be set for the selected students for selected year.   
The following student billing categories are available. 
 

 Kindergarten 

 Pre-Primary 

 Primary 

 Secondary (Vol, Chg) 

 Secondary (Chg) 

 Adult 

 Temporary Visa 

 Full Fee Paying 

 

4.8.1  To Set the Student Billing Category  

 Select (highlight) the required students  

 Click on the For Selected menu 

 Click on Set Student Billing Category 

 The following window appears: 
 

 
 

 Select the required billing year from the year drop down list (only the current billing year 
and any future years will appear here) 

 Select the required student billing category from the category drop down list 

 Click on OK to save 

 

Note: Each student can have a student billing category tied to each billing year. Only the 
student category for the current billing year will be displayed on the front student list 
screen. 
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4.9 Secondary Financial Assistance Allowances 

The Secondary Financial Assistance Allowances option allows schools to create an application for 
Secondary Financial Assistance for students who qualify for these allowances. To qualify for the 
Financial Assistance, a student must have a parent who is eligible for and holds one of the 
following Concession Cards:  
 

 Centrelink Health Care Card 

 Centrelink Pensioner Concession Card 

 Veteran’s Affairs Pensioner Card (Blue Card) 
 
A student may qualify for Secondary Financial Assistance if they are an Independent Student, in 
which case they must produce a letter from Centrelink. 
 

4.9.1 Completing a Secondary Financial Assistance Application Form 

To complete a Secondary Financial Assistance Allowance Application: 
 
Highlight the student/s you wish to create an application for 
 

 
 
Go to the For Selected Menu 
Select Secondary Financial Assistance Allowance 
 

 
 
Where a student or students does not have a Student Number (SCSA) a warning message will 
display. All students must have a Student Number to be eligible to apply for Secondary Financial 
Assistance. 
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The contacts for the students will display. Only one contact can be the signatory on a Secondary 
Financial Assistance Allowance application. This person must be the Concession Card holder. 
 
Highlight the Contact making the application and click OK 
 

 
 
The Confirm Contact window will display. Any other selected students who have the same contact 
person will appear in this screen. There may also be additional selected students however if the 
contact is not the same, they will need to be processed on a separate application. 
 

 
 
Click Confirm to continue if the students are siblings 
Select the appropriate Allowance Type (See next pages) 
Click OK 
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Note: Allowance Types are Secondary Assistance Scheme (G) which is a full $235 subsidy, 
or the Abstudy Supplement Allowance (ASA) which applies if parents have claimed a partial 
subsidy for Indigenous students through their Centrelink Payments. The ASA is a top up 

supplement to this payment to bring the total received to $235. 

If the Secondary Assistance Scheme (G) Allowance Type is selected the following form will 
display. 

Secondary Assistance Scheme Allowance Form 

 
 

 
 
An Application for Secondary Assistance Scheme (G) Allowance includes the option to have the 
Clothing Allowance Payment (an additional $115 payment) made payable to the school directly or 
to the parent.  
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If the Abstudy Supplement Allowance (ASA) Allowance Type is selected the following form will 
display. 
 

 

Abstudy Supplement Allowance Form 

 
 
Select the Concession Type (This concession type must be the one used by the parent making the 

claim. This person must be present to sign the printed form) 
 

 
 
Add the Concession Card Number, Start Date and End Date from the card 
Select whether the Clothing Allowance is to be paid to the parent or direct to the school 
Tick the box for the Parent/Guardian Declaration 
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Note: If the Parent option is selected for the Clothing Allowance, the Bank Account Details 

must be completed. 

If the Form is ready to be finalized click Print (See Section 4.9.2) 
If the parent does not have all their documentation click Save and Close (See Section 4.9.3) 
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4.9.2 Print and Finalise an Application 

Where the Print option has been selected, this will finalise the application and the following 
sequence of messages will appear. 
 

 
 
Make sure the printer is ready and click OK 
 

 
 
Check the report has printed ok and click Yes 
Make sure you have witnessed the Concession Card 
 

 
 
Click Yes to the message 
 

 
 
Click OK to complete the application process 
 
The Printed Form must be signed by the parent and witnessed by a school staff member. See the 
next Page for a sample completed form. 
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Sample Printed Application Form 
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Completed Applications can be viewed in the Student Record. Completed Applications will display 
as Pending until they are exported. 
 
Open the Student Details record to view the application 
Click on the Sec Fin Assist Tab in the student record 
 

 
 

4.9.3 Saving and Editing Incomplete Secondary Assistance Applications 

If the Save and Close option is used because some information is still required from the parent, 

the application will still be added to the student record, but will be marked as Incomplete. 
 

 
 
To complete the application: 
 

Click on edit  
Add the details required and click Print 
Follow the steps from the previous section to finalise 
 
The Status of the application will be updated to Pending. 
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4.9.4 Edit a Completed Application 

There may be occasions where an application that has been finalised needs to be edited. It may be 
that dates are incorrect or perhaps parent bank details change. 
 
To edit a completed application: 
 
Open the Student Record 

Click on edit  
Click Yes to the warning message 
 

 
 
Make changes to the application 
Click Print 
Follow the Print prompts to finalise the application 

Note: If Save and Close is then selected when editing a completed application, the Status of 
the application will change to Incomplete. If Print is selected, then the prompts to print and 

finalise the application will display. 

4.9.5 Cancelling a Pending Application 

If a student has ceased school for any reason, then the Secondary Assistance Application should 
be cancelled before it is exported. 
 
To cancel an application: 
 
Locate the student and open their record 
Ensure the application is highlighted 
 

 
 

Click Cancel the Selected Application  
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Click Yes to Cancel the Application 
 

 
 
Add a reason for the cancellation 
 

 
 
Click OK 
 

 
 
The Application will appear as Cancelled before Sent as it has not been exported.  
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4.9.6 Remove a Student from an Application 

Occasionally, in a sibling group, one or more of the students may not need to be included in the 
application. They can be removed from the application form if required. 
 
When siblings are originally confirmed when the contact making the application is selected, 
multiple students will appear on the form. 
 

 
 

 
 
To remove one of the students, click in the select checkbox 
 

 
 

Click on delete  
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Click Yes to Confirm removing students from the application 
 

 
 
The student selected will be removed from the application. 
 

 
 

4.9.7 Exporting Secondary Assistance Applications 

Secondary Assistance Applications can be exported at any time prior to the cut-off date. This date 
will vary from year to year and you should seek clarification for DoE if unsure. 
 
Applications can be exported as they are completed, or schools may wish to export multiple 
applications at once. Sending multiple applications is preferred as this requires less handling. 
 
To Export completed applications: 
 
Navigate to Billing | Utilities 
 

 
 
Double click on Export Secondary Financial Assistance 
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Check the Confirmation Email message and Click Yes if the address is correct 
 

 
 

 
 
The file will be exported. The location of the file is dependent on the file path set up in the Billing 
Parameters. See Section 3.4 of this Manual for details. 
 
Once a file has been exported, the student record will be updated so that the Status of the 
application is changed to Sent. 

 

 
 
The exported file can be viewed at the saved location. The File will be a text file containing the 
details of the applications included in the current export. Each export file will be uniquely named 
with the school code and date and time values (See example below). 
 

 
 
This file must be emailed as an attachment to student.allowances@education.wa.edu.au at 
Schools Resourcing and Support Directorate at the Department of Education. 
  

mailto:student.allowances@education.wa.edu.au
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4.9.8 Import Receipts for Secondary Assistance 

Once the Export file has been sent to the Schools Resourcing and Support Directorate, it will be 
evaluated and then Import Receipts files will be emailed back to the school. These files will need to 
be imported to create Secondary Assistance receipts for the students in the application. 
 
Files may be for Education Program Allowance (EPA-GV Payment for $235), Abstudy Allowance 
(ASA-GV Payment for $79) or Clothing Allowance (CLA-GV Payment for $115) if the parent has 
nominated that the Clothing Allowance be paid directly to the school (See Samples Below). All 
these Receipt files are imported in the same way. 

Sample Education Program Allowance Receipt File 

 
 
Sample Abstudy Allowance Receipt File 

 

 

Sample Clothing Allowance Receipt File 

 
 
To Import the Receipts: 
 
Navigate to Billing | Utilities 
 

 
 
Double Click on Import Secondary Financial Assistance Receipts 
Navigate to the location where the Import File was saved 
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Double Click on the file or highlight and click Open 
Click OK and OK to the messages 
 

 
 

 
 
Importing receipts in this way will create a Receipts Batch for the Secondary Assistance receipts. 
These batches can be viewed in Billing | Receipts and will be named according to the type of 

allowance and the date the file was created. 
 

 
 
 
 

4.9.9 View Imported Receipt Batches 
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The details of the imported receipts can be viewed in the Receipts window and a receipt is added 
to each of the students in the file. 
 
 To view the details of the Imported Receipts: 
 
Navigate to Billing | Receipts 
 

 
 
Double Click on the Imported Receipts Batch 
Click on the Batch Receipts Tab 
 

 
 
Imported batches will receipt money against the student as Unallocated Credit. This money must 
be allocated to the student record based on the rules for applying Government Subsidies as 
described in Section 4.5.2 of this Manual. 
 

Important: Secondary Assistance receipts should be applied to 
students prior to receipting any parent payments. 
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4.9.10 View Imported Receipts in Students 

To view an imported receipt in the Student Record: 
 
Navigate to Billing | Students 

Locate the student and open their Student Record 
Go to the Receipts Tab to view the receipt 
 

 
 
Any Imported Receipt will result in Unallocated GV Credit for each of the students in the file. All this 
credit can be viewed from the Unallocated Credit Listing report. 
 
The Unallocated Credit Listing report will show all credit that belongs to Government Subsidies. 
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4.9.11 Allocating Imported SFA Receipts Batches 

When Importing SFA Receipts for students, receipts should be imported in the order below. Each 
Education Program Allowance Receipt (EPA) and Abstudy Receipt (ASA) should be allocated to 
the student’s Billing Items before importing any Clothing Allowance Receipts (CLA). 
 

1. Education Program Allowance (EPA) Receipts 
2. Abstudy Receipt (ASA) Receipts 
3. Clothing Allowance (CLA) Receipts 

 

Important: The order of importing and allocating the SFA Receipts 
Batches is critical in ensuring the Credit is allocated correctly. 

4.9.12 Allocate the Imported Receipt 

To allocate the Imported Receipt credit: 
 
Navigate to Billing | Students 
Locate the student and open their Student Record 
Go to the Billing Items Tab 
Click on Show Billing Items with Outstanding Amounts 
 

 
 
Highlight Items to at least the value of the GV Receipt credit 
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Click Allocate 
Enter the full amount of the GV credit 
 

 
 
Click OK 
Check the Receipt is fully allocated on the Receipts tab of the student record 
 

 
 

Note: Unallocated GV Credit can also be allocated in bulk (for multiple students) in Billing 
Items using the Auto Allocate process. This is explained in Section 5.14.2 of this Manual. 
This should be done using Billing Items in an order that matches the rules for the allocation 
of Government Subsidies.  
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4.9.13 Importing Clothing Allowance Receipts 

Clothing Allowance Receipts are imported in the same way as the Education Program Allowance 
Receipts.  

Important: This should be done after EPA and ASA Receipts have been 
imported and allocated.  

A Receipts Batch will be created and unallocated credit of $115 will be applied to each student in 
the Import File. 
 
This unallocated credit is classified as a parent payment, however it will be imported as a payment 
Type of GV and needs to be allocated in the same way as the GV credit from the EPA Receipt. 
 

  

Receipts- Batch Receipts Tab 
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Student Record-Receipts Tab 

  

Unallocated Credit Listing Report showing CLA (Clothing Allowance) Credit 

 
 

Important: Clothing Allowance Receipts batches do not need to be 

exported or manually entered into RM Finance as they deposited 
directly into the school’s bank account in the same way as the $235 

EPA Payment. 
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4.10  Student Details View 

The Student Details view can be displayed in three ways: 
 
Either 

Click on a student and then select the Open Details icon  

 
OR 
 
Double-click on the required student 

 
OR 
 
Highlight the required student and press <enter> 

 
The Student Details view will then be displayed as illustrated below: 
 

 
 

4.10.1 Toolbar – Student Details View 

The toolbar on the Student Details View appears as shown below: 
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4.10.2  Year Drop Down List 

 

 
 
The Year Drop Down List displays all years present in the datafile along with an additional ‘All 
Years’ option.  Selecting a particular year from the list will enable data for that year to be displayed 
on the selected tab pane. Note that the year selection does not apply to all tab panes. 
 

4.10.3  Browse Set Button 

 
This button has the same functionality as that in General > Student Details.  If no browse set has 
been selected from the students list view then on entry to the Details tab it will be greyed out.  If a 
group of students are selected using the Find Tool, then that selection becomes the browse set 
and the button becomes red to show a browse set has been selected.  The browse set can be 
cleared by clicking on the red button. In this case the following message is displayed: 
 

 
 

4.10.4  Blue Chevrons and Find Tool 

 

 
 
These icons have the same functionality as in the Administration module. Once a browse set has 
been selected the blue chevrons can be used to scroll through the students in the browse set only 
(either forwards or backwards). 
 

4.10.5  Print Button 

 
 
The functionality of this button differs slightly depending on which tab pane is selected. See each 
individual section for more details. 
 

4.10.6  Return to View 

 
 
Clicking once on this icon will display the Student List View (front screen) with all selected students 
displayed (if a current browse set is in place).  If no selection is in place then all students on the 
current roll are displayed. 
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4.10.7 Red Fields 

 
 
The red fields of Surname and Known Name are scroll fields. Clicking on the red surname or 
known name will display the next student in the list. <Shift> clicking will scroll through the students 
in reverse order.  Known Name operates in the same fashion. 
 
To find a student perform a right mouse click in the surname field. Enter a name or part thereof and 
press <enter> and the first or closest match will be displayed. 
 
Note that if there is a browse set in place then the red fields will operate only on that browse set.   
 

Note: It is advisable (and quicker) to search for students from within the drill down section 
rather than always returning to the front screen. Either the red fields or the binoculars can 

be used. 

 

 

 

4.10.8 Last Modified By 

 

 
 
At the bottom of all the tab panes (i.e. common to all) is a section showing the date and time that 
any of the tab panes for the selected student were last modified and the initials of the user who 
made the modification.  It does not matter which pane has been modified – these details are 
updated each time a change is made and displayed at the bottom of all the panes for the selected 
student. 
 

4.10.9 Notes Indicator Icon  

 
The Notes indicator icon may appear adjacent to the above information on this bar. This will only 
be displayed for students who have one or more notes attached and it will appear no matter which 
tab pane is selected.  
 

 
 

4.10.10 Details tab 

The Details tab displays the following information. 
 
Actual First Name 

The actual first name (1st Name) of the student as entered in the Administration Manager module 
(General > Student Details). 
 
Surname 
The surname of the student as entered in the Administration Manager module (General > Student 
Details). 
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Year 

The current year group of the student as entered in the Administration Manager module (General > 
Student Details). 
 
Form 
The current form group of the student as entered in the Administration Manager module (General > 
Student Details). 
 
Student Number 
The current Student Number (Schools Curriculum and Standards Authority Number) of the student 
as entered in the Administration Manager module (General > Student Details). 
 
Billing Category 

The student billing category for the selected year for the student (as entered in RM Billing > 
Students > For Selected > Set Student Billing Category). 
 
Billing Name 

The name of the current fees biller for the student as nominated in the Administration Manager 
module (General > Student Details). Refer to section 2.2.1 on page 2-2 for more information on the 
fees biller. 
 
Billing Address 
The address of the current fees biller for the student as nominated in the Administration Manager 
module (General > Student Details). Refer to section 2.2.1 on page 2-2 for more information on the 
fees biller. 
 
Phone 

The telephone number of the current fees biller for the student as nominated in the Administration 
Manager module (General > Student Details). Refer to section 2.2.1 on page 2-2 for more 
information on the fees biller. 
 
Mobile 
The mobile telephone number of the current fees biller for the student as nominated in the 
Administration Manager module (General > Student Details). Refer to section 2.2.1 on page 2-2 for 
more information on the fees biller. 
 
Balance Owing 

The total balance outstanding for the student (across all years). 
 

4.11  Update student name from Admin  

   
If either the surname of the student and/or the preferred name (known name) of the student is 
changed in the Administration module after that student has been viewed in RM Billing, then the 
light globe icon will appear on this screen. This indicates that there is a mismatch between the 
name stored in Administration and the name stored in RM Billing. 
 
In the example below, the student was entered into the Administration module as Mary Albert. The 
student was viewed in RM Billing and these details were saved. 
 
The surname of the student has since been edited to ‘Alberto’. This change is not yet saved in RM 
Billing. 
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Click on the light globe icon to update the student name change/s in RM Billing. Once the icon is 
clicked, the screen will appear as shown below, with the name/s listed correctly. 
 

 
 

Note: The ‘Known Name’ field shown in RM Billing is the same as the ‘Preferred Name’ field 
in Administration. This is a different field to the ‘Actual First Name’ field in Administration. If 
a student’s known name (preferred name) is changed in Administration, that change may 
not be evident on the above screen because the Preferred Name field from Administration is 
not displayed. In cases such as this the light globe icon will appear, but the difference in 

name may not be obvious to the user. An illustration of this appears below. 

 

 
 
The light globe should be clicked to update the changes. 
 

Name saved in RM 
Billing 

Name saved in 

Administration 
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Note: A process is available for updating all student name changes in bulk as an alternative 

to viewing individual student records. Refer to section 9.6 on page 9-21 for further details. 

4.12  Details tab – Year selection 

 
If the year selection is changed whilst on the Details tab, the information which can change is the 
Billing Category. This is because each student has one billing category per year. If the year 
selection is changed to ‘All Years’ then the screen display is as shown below: 
 
 

  
 
 

4.12.1  Details tab – Print button 

 
If the print button is selected whilst on the Details tab, the information is printed in the format 
illustrated below: 
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4.13  Subjects tab 

Note: If the Timetabling module is not installed then no information will be displayed on this 
tab pane. 

The Subjects tab is only relevant when the Timetabling module is installed. All the primary 
preferences entered in the Timetabling module for the selected student and the selected year will 
be displayed on this window in the format illustrated below: 
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4.13.1  Subjects tab – Year selection 

 
If the year selection is changed whilst on the Subjects tab, the primary preferences from the 
Timetabling module will be displayed for the newly selected year, assuming the timetable for that 
year is available. If the timetable does not exist for the selected year then the subject display will 
be blank.  
 
If the year selection is changed to ‘All Years’ then the screen display is as shown below: 
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4.13.2  Subjects tab – Print button 

If the Print button is selected whilst on the Subjects tab then the subjects are printed in the format 
shown below: 
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4.14  Billing Items tab 

This window will display all billing items for the selected student for the selected year in the format 
illustrated below: 
 

 
 
The following information is displayed on this window: 
 
Ref 

The transaction reference number of the billing item. This is a unique sequential number assigned 
by the system to every transaction when it is created. 
 
Date 
The date the transaction was created. 
 
Type 
The transaction type. For a billing item this could be one of the following: 
 
DR Debit (normal billing item) 
RV Reversal 
AD Adjustment 
 
Amount 
The amount of the original billing item (before any discount). 
 
GST 
The GST code of the billing item. 
 
Disc 

The discount amount (in dollars) applied to the billing item (if any). 
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Paid 

The amount paid against the billing item. 
 
Balance 

The balance owing on the billing item. 
 
Bill Code 

The billing code attached to the billing item. 
 
Batch # 

The batch number of the billing items batch which holds the transaction. 
 
Comment 

The comment attached to the billing item. For subject billing items this will be the subject code, 
followed by the subject name, followed by the year to which the subject belongs. For non-subject 
billing items this will be the comment entered for the tied billing item in the batch. 
 
Status 

This column will show the status of a billing item that has been reversed or adjusted. The status 
could be blank (not reversed or adjusted) or one of the following: 
 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
A Transaction which has been adjusted 
T Transaction created as the result of an adjustment 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Reason 
If a transaction has been modified in some way (i.e. discounted, reversed, adjusted, written off or 
cancelled) then the reason field will begin with standard system-generated text (as shown below) 
followed by the reason entered by the operator. 
 

Transaction Reason begins with  

Original transaction reversed Reversed - 

Reversal transaction created (RV) Reversal -  

Original transaction adjusted by user Adjusted -  

Adjustment transaction created (AD) (user initiated) Adjustment -  

Original transaction adjusted by refund Refunded -  

Adjustment transaction created (AD) by refund Refund -  

Original transaction discounted Discounted -  

Original transaction written off Written off - 

Adjustment transaction created for writeoff Writeoff - 

Original transaction cancelled Cancelled -  

Adjustment transaction created for cancellation Cancellation -  

 
Totals 

The Amount, Discount, Paid and Balance fields are totalled at the bottom of the window. 

4.14.1  Show Billing Items with Outstanding Amounts 

If a student has a number of billing items and a variety of operations have been performed on 
these transactions (e.g. some have been paid, reversed, discounted, adjusted etc.), it can be 
difficult to see at a glance which billing items still have amounts owing against them. 
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When the ‘Show Billing Items with Outstanding Amounts’ button is clicked, the display changes to 
show the transactions in a format which summarises those with outstanding balances only. 
 
 
Transactions are displayed as follows: 
 

 No reversed or reversal transactions are shown. 

 No transactions created as a result of an adjustment are shown. 

 Fully paid transactions are not displayed. 

 Original transactions which have not been reversed or adjusted and still have an 
outstanding balance are shown. 

 Original transactions which have been adjusted but still have a partial balance owing will be 
displayed, with the total outstanding balance reported in the balance column. 

 Transactions which have been discounted but still have an outstanding balance will be 
shown. 
 

When this button is clicked the display changes as illustrated below. Note that the button now 
reads ‘Show All Transactions’ and some explanatory text appears highlighted in yellow above the 
button. 
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4.14.2  Show All Transactions 

To return the screen to the original display, click ‘Show All Transactions’. 
 

4.14.3  Add Billing Item  

This button allows one or more billing items to be added to a student record.  
 
If the Timetabling module is installed then both subject billing items and non-subject billing items 
can be added. 
 
If the Timetabling module is not installed then the choice to add a subject billing item is not 
available. 
 

4.14.4 To Add a Subject Billing Item (Timetabling only) 

 

Note: Subject billing items can only be added through this section after the utility to create 
subject billing items has been run for the selected student in the selected year. If an attempt 
is made to create subject billing items before the utility has been run the following error 

message will be displayed. Refer to section 9.1 for details on this process. 

 

Once the process to create subject billing items has been run, the Add Billing Item button 
can be used to add new subject billing items to the student for any timetable changes which 

have occurred after this point in time. 

 
 

 RM Billing > Students 

 Double-click on the required student 

 Click on the Billing Items tab 

 Click on Add Billing Item 

 If future years have been created in the datafile then the year selection box is displayed.  (If 
no future years exist then this step will be omitted and the current billing year (as set in 
Billing Parameters) will be used). 
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 If the above window is displayed, select the required year and click on OK 

 The following window then appears (only if Timetabling is installed) 
 

 
 

 Click on Add Subject Billing Item 

 Click on OK 

 A screen showing the current primary preferences as entered in the Timetabling module 
for this student is displayed: 

 

 
 

 Highlight the required subject (multiple subjects can be selected by <Ctrl> Click) 

 Click on OK 

 A short message may be displayed whilst a billing item is automatically created for the 
selected subject(s) 

 

Note: Refer to section 9.1 for details on how subject billing items are created. 

 

4.14.5 To add a non-subject billing item 

 

 RM Billing > Students 

 Double-click on the required student 

 Click on the Billing Items tab 

 Click on Add Billing Item 

 If future years have been created in the datafile then the year selection box is displayed.  (If 
no future years exist then this step will be omitted and the current billing year (as set in 
Billing Parameters) will be used). 
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 If the above window is displayed, select the required year and click on OK 

 If Timetabling is installed then the following window then appears (if Timetabling is not 
installed then this step is omitted) 

 

 
 

 If the above window is displayed select Add to Billing Item Batch and click on OK 

 A list of billing item batches for the selected year is then displayed: 
 

 
 

 Highlight one or more batches in the above window (dragging or <Ctrl> click can be used 
for multiple selection) (Note: individual batches can be edited before billing if required – see 
below) 

 Click on OK 

 A short message may be displayed whilst the billing items are created 
 

4.14.6 Editing billing items before billing 

Billing items in a batch may be edited during the above process if required. When the billing batch 
selection screen is displayed an ‘Edit’ button is present which is initially ‘greyed out’ and disabled. 
The Edit button will become enabled if one (and only one) batch is selected (highlighted). 
 
To edit billing items in the selected batch 
 

 Follow the steps listed above until the billing batch selection screen appears 
 

 Highlight one batch in the billing batch selection screen 
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 The Edit button is enabled 

 Click on Edit 

 The following screen appears  
 

 
 

 Highlight the line to be edited 

 Click on the edit pencil  

 Make the required changes to the billing item 

 Click on the green tick  

 Click on OK to bill the student using the newly edited items 
 

Note: New billing items can be added by using the add button  on the above screen. 
Billing items which are not required for this student can be deleted by using the delete 

button  on this screen. 
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IMPORTANT: Any changes made to the above screen are used for 
billing this student only. They are not saved to the billing items batch. 

 

4.15  Reversals 

 
Billing items can be reversed by using the reversal button on the Students > Billing Items tab. 
When a billing item is reversed an equal and opposite ‘reversal’ transaction is created which 
negates the original transaction.  
 

4.15.1 To reverse a billing item 

 

 Students > Billing Items tab 

 Highlight the Billing Item to be reversed 

 Click on the Reversal button 

 The following message appears: 
 

 
 

 Click on Yes 

 The following screen is then displayed: 
 

 
 

 Enter a reason for the billing item reversal 

 Click on OK to save 
 
The status of the original transaction is marked with an ‘R’ to show it has been reversed and the 
transaction reference number of the newly created reversal transaction appears in the status 
column. 
 
The reversal transaction which has been created is marked with a ‘V’ followed by the transaction 
number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

4.15.2 Restrictions on Reversals 

The following items cannot be reversed: 
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 Items which have a discount applied 

 Items which have already been reversed or adjusted 

 Transactions created as the result of a reversal or an adjustment 
 
When using the reversal facility available from the Students > Billing Items section, transactions 
must be reversed individually (one at a time).  
 

4.15.3 Bulk Reversal Facility 

A bulk reversal facility which allows multiple transactions to be reversed in one operation is 
available from the Billing Items section. Please refer to section 6.11 on page 6-16  for further 
information regarding bulk reversals. 
 
 

4.16  Adjustments 

 
Billing items can be adjusted by using the Adjustment button on the Students > Billing Items tab. 
When a billing item is adjusted the overall amount is reduced by the amount of the adjustment. An 
adjustment transaction (negative transaction) is created which reduces the overall amount billed. 
 

4.16.1.1.1 To adjust a billing item 

 

 Students > Billing Items tab 

 Highlight the Billing Item to be adjusted 

 Click on the Adjustment button 

 The following message appears: 

 
 

 Click on Yes 

 The following screen is then displayed: 
 

 
 

 Enter the amount to adjust down by 

 Enter a reason for the adjustment 

 Click on OK to save 
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The status of the original transaction is marked with an ‘A’ to show it has been adjusted and the 
transaction reference number of the newly created adjustment transaction appears in the status 
column. 
 
The adjustment transaction which has been created is marked with a ‘T’ followed by the  
transaction number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

4.16.2 Restrictions on Adjustments 

The following items cannot be adjusted: 
 

 Items which have a discount applied 

 Items which have been reversed 

 Items which have been fully adjusted (to zero) 

 Transactions created as the result of a reversal or an adjustment 
 
Transactions must be adjusted individually (one at a time). Multiple transactions cannot be 
adjusted in one operation. 

4.17  Discounts 

 
Billing items can be discounted by using the Add Discount button on the Students > Billing Items 
tab. When a billing item is discounted the overall amount is reduced by the discount percentage.  
Several items can be discounted at once if required. 
 

4.17.1 To add a discount to a billing item 

 

 Students > Billing Items tab 

 Highlight the Billing Item to be discounted (or select multiple items) 

 Click on the Add Discount button 

 The following message appears: 
 

 
 

 Enter the percentage by which the item is to be discounted 

 Enter a reason for the discount 

 Click on OK to save 

 
The dollar amount of the discount is calculated and displayed in the Disc column and the balance 
on the billing item is recalculated accordingly. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
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4.17.2 To remove a discount from a billing item 

 

 Students > Billing Items tab 

 Highlight the Billing Item from which the discount is to be removed (or select multiple 

items) 

 Click on the Remove Discount button 

 The following message appears: 
 

 
 

 Click on Yes 
 
The discount is removed, the Disc column is cleared and the balance on the billing item is 
reinstated accordingly. The reason field is cleared of the discount information. 

4.17.3 Restrictions on Discounts 

The following items cannot be discounted: 
 

 Items which are fully paid 

 Items which already have a discount applied (see below) 

 Items which have been reversed or adjusted 

 Transactions created as the result of a reversal or an adjustment 
 
A partly paid item can have a discount applied but the amount of the discount must be less than or 
equal to the balance owing on the item. 
 
If a further discount needs to be applied to an item which has already been discounted, then the 
original discount should be removed and the new (larger) discount applied. 
 

4.17.4 Bulk Discount Facility 

 
An additional bulk discount facility which allows multiple items to be discounted for different 
students in one operation is available from Billing Items section. Please refer to section 6.12 on 
page 6-18 for further information.  

4.18  Unallocated Credit 

 
There will be times when unallocated credit is created. This is a credit amount which is not 
allocated to any billing items. If a paid billing item is reversed, the amount paid will become 
unallocated credit. It is also possible when adding a receipt not to allocate the receipt to any billing 
items thereby creating unallocated credit. 
 
If any unallocated credit exists it will be displayed on the Billing Items tab for the student as 
illustrated below. If there is no unallocated credit for the student then this information will not 
appear. 
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Note: There is also a report (Unallocated Credit Listing) which can be used to identify 

unallocated credit. Please refer to section 8.6.6 on page 8-30  for further details. 

4.18.1 To allocate unallocated credit 

At times it may be necessary to allocate the unallocated credit to unpaid billing items for the 
student.  
 

 Students > Billing Items tab 

 Highlight the Billing Item/s to which the credit should be applied  

 Click on the Allocate button 

 The following message appears: 
 

 
 

 Enter the amount to be allocated 

 Click on OK to save 

 
Credit can only be allocated to unpaid billing items. Items which have been reversed or are 
correction transactions cannot be allocated against. Items which have been partially adjusted but 
still have an outstanding balance can be allocated against. If ineligible items are selected for the 
allocation then one of the following warning messages will be displayed: 
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4.18.2 Automatic Allocation of Unallocated Credit 

A facility to automatically allocate unallocated credit is available from the Billing Items section. 
Please refer to section 6.13 on page 6-20 for further information. 

4.18.3  Billing Items tab – Year selection 

 
If the year selection is changed whilst on the Billing Items tab, then only billing items which belong 
to the selected year will be displayed. If the ‘All Years’ option is selected then all billing items for 
the student across all years will be displayed. 
 
 

4.18.4  Billing Items tab – Print button 

 
If the Print button is selected on the billing items tab then the billing items currently displayed will 
be printed in the format illustrated below: 
 
 

 
 
 
 

4.19 Receipts  

This window will display all receipts for the selected student for the selected year in the format 
illustrated below: 
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If a receipt is highlighted in the top window, the billing items to which the receipt is allocated are 
displayed in the lower window. 
 
The following information is displayed for each receipt: 
 
Ref 
The transaction reference number of the receipt. This is a unique sequential number assigned by 
the system to every transaction when it is created. 
 
Rec # 
The actual receipt number assigned to the receipt. This is a unique sequential number assigned by 
the system to receipt related transaction only. 
 
Date 

The date the transaction was created. 
 
Type 

The transaction/payment type. For a receipt this could be any valid payment type (from Parameters 
> Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
Amount 

The amount of the receipt. 
 
Batch # 
The batch number of the receipts batch which holds the transaction. 
 
Comment 
The comment attached to the receipt. This will be the comment input by the operator when the 
receipt is entered. 
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Unallocated Credit 

If there is any unallocated credit contained in the receipt, the amount of unallocated credit will be 
reported in this column. Note that this amount could be negative. 
 
Status 
This column will show the status of a receipt that has been reversed or refunded. The status could 
be blank (not reversed or refunded) or one of the following: 
 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
F Transaction which has been refunded 
D Transaction created as the result of a refund 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Reason 
If a transaction has been modified in some way (i.e. reversed or refunded) then the reason field will 
begin with standard system-generated text (as shown below) followed by the reason entered by 
the operator. 
 

Transaction Reason begins with  

Original transaction reversed Reversed - 

Reversal transaction created  Reversal -  

Original transaction refunded Refunded -  

Refund transaction created Refund -  

 

4.19.1  Show Unallocated Credit 

If a student has unallocated credit it can be difficult to see at a glance which receipts contain credit 
which is available to be allocated to other items. 
 
When the ‘Show Unallocated Credit’ button is clicked, the display changes to show the 
transactions in a format which summarises those with available credit only. 
 
 
Transactions are displayed as follows: 
 

 No reversed or reversal transactions are shown. 

 No transactions created as a result of a refund are shown. 

 Fully allocated receipts are not displayed. 

 Original transactions which have not been reversed or refunded and contain unallocated 
credit will be shown. 

 Receipts which have been refunded but still have a portion of unallocated credit available 
will be displayed, with the total unallocated credit available displayed in the Unalloc column. 
 

When this button is clicked the display changes as illustrated below. Note that the button now 
reads ‘Show All Receipts’ and some explanatory text appears highlighted in yellow above the 
button. Also, the lower window is greyed out in this state. 
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4.19.2  Show All Receipts 

 
To return the screen to the original display, click ‘Show All Receipts’. 
 

4.19.3  

4.19.4  Add Receipt 

 
This button allows a receipt to be entered against a student record.  

4.19.5 To add a receipt 

 

 RM Billing > Students 

 Double-click on the required student 

 Click on the Receipts tab 

 Click on Add Receipt 

 The following screen appears: 
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 Enter the receipts batch number for the receipt (or press <tab> for a list) 

 Enter the payment type (or press <tab> for a list) 

 The date will default to today’s date (this can be changed if required – future dates are not 

permitted) 

 Enter the amount of the receipt 

 Enter the comment for the receipt (this will appear on the receipt) 

 Edit the ‘received from’ fields if required (see note below) 

 Allocate the receipt against the required billing items in the list. Type the amount to 

allocate to each billing item in the ‘applied’ column. If nothing is to be allocated zero can be 
entered. Press the <tab> key to move between fields. 

 Click on OK to save 

 
 
If no amounts are allocated to the items listed in the billing items table then the receipt will become 
unallocated credit. The following confirmation message will be displayed in this instance: 
 

 
 

Note: The ‘Received From’ fields will default to the name of the current fees biller for the 
student. These can be edited if the payment is being made by a different person. These 

details are stored with the receipt for future reference. 
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4.19.5.1  Reversals 

 
Receipts can be reversed by using the reversal button on the Students > Receipts tab. When a 
receipt is reversed an equal and opposite ‘reversal’ transaction is created which negates the 
original transaction.  
 

4.19.6 To reverse a receipt 

 

 Students > Receipts tab 

 Highlight the Receipt to be reversed 

 Click on the Reversal button 

 The following message appears: 
 

 
 

 Click on Yes 

 The following screen is then displayed: 
 

 
 

 Enter a reason for the receipt reversal 

 Click on OK 

 The batch selection screen will be displayed as illustrated below. This window lists all open 
receipts batches. The batch containing the original receipt (if open) will be marked with an 
asterisk (*). 

 
 

 

 Highlight the original receipts batch (if open) 
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 If the original batch is not open then select the Corrections batch 

 Click on OK to save 

 

Note: If the original receipts batch is still open it is best to place the reversal into this batch. 
The reversal will negate (cancel) the original transaction.  

If the original batch has been closed then the reversal should be placed into the current 

open ‘Corrections’ batch. 

 
The status of the original transaction is marked with an ‘R’ to show it has been reversed and the 
transaction reference number of the newly created reversal transaction appears in the status 
column. 
 
The reversal transaction which has been created is marked with a ‘V’ followed by the transaction 
number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

4.19.7 Restrictions on Reversals 

The following transactions cannot be reversed. 
 

 Receipts which have already been reversed or refunded (full or partial) 

 Transactions created as the result of a reversal or a refund 
 
Transactions must be reversed individually (one at a time). Multiple transactions cannot be 
reversed in one operation. 
 

4.20  Refunds 

 
Receipts can be refunded by using the Refund button on the Students > Receipts tab. When a 
receipt is refunded a refund transaction (negative transaction) is created for the amount which is 
refunded. In addition, the billing items to which this amount was allocated are adjusted down by the 
system to indicate that they are no longer outstanding. There are 3 options available for receipt 
refunds. 

1. Manual Cheque refund 
2. System Generated Cheque refund 
3. EFT refund 

 
If clicking the Refund button and the ‘Export to RM Finance’ flag is NOT enabled, then the user can 
only refund by manual cheque and the Manual Cheque window will automatically open. 

4.20.1 To refund a receipt- Manual cheque refund 

 

 Students > Receipts tab 

 Highlight the receipt to be refunded 

 Click on the Refund button 

 The following window appears: 
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 Enter the refund amount 

 Enter the name of the person receiving the refund 

 Enter the reason for the refund 

 Enter the amount to refund on each billing item in the ‘Adjust By’ column 

 Enter the refund billing code for each item in the ‘Ref Code’ column or press <tab> for a 

list. Only refund type billing codes can be selected. 

 Enter the manual cheque number (if known) into the ‘Cheque Number’ field 

 Click on OK to save 

 The batch selection screen will be displayed as illustrated below. This window lists all open 
receipts batches. The batch containing the original receipt (if open) will be marked with an 
asterisk (*). 

 

 
 

 Highlight the Refunds batch 

 Click on OK to save 
 
The status of the original transaction is marked with an ‘F’ to show it has been refunded and the 
transaction reference number of the newly created refund transaction appears in the status 
column. 
 
The refund transaction which has been created is marked with a ‘D’ followed by the  transaction 
number of the original transaction. 
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The reason field is updated to contain the standard text followed by the reason entered. 
 
If clicking the Refund button and the ‘Export to RM Finance’ flag IS enabled, a window will open 
where the user can select the Refund Method from ‘Manual Cheque’ refund, ‘System Generated 
Cheque’ refund or ‘EFT’ Refund. 
 

 
 

4.20.2 Manual Cheque 

When this button is selected, the Manual Cheque refund window will display and data can be 
entered as described in 4.25.1.  The text ‘Refund Method’: Manual Cheque is displayed in the top 

right hand corner. 
 
 

 
 
 
 
 

4.20.3 System Generated Cheque 

When this button is selected, the System Generated Cheque refund window will display and data 
can be entered with the exception of the Cheque Number label and field which is no longer 
available. .  The text ‘Refund Method’: ‘System Generated Cheque’ is displayed in the top right 

hand corner. 
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4.20.4 EFT 

When this button is selected, the EFT window will display and data can be entered with the 
exception of the Cheque Number label and field which is no longer available.   The text ‘Refund 
Method’: ‘EFT’ is displayed in the top right hand corner and a field for the EFT Reference, which 
will display on the recipient’s bank statement, appears under the Refund Method. 
 

 
 
If refunding to a Parent/Guardian, they will need to be entered as a supplier.  Users can add/edit 
supplier records which are required in the ‘Refunded to:’ field.  When users press <tab> in this 
field, the Supplier window is displayed.  Users can also type one or more characters into this field 
and press <tab>.  This partially matches the entered data and returns the matched suppliers. 
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Users can also enter the first letter of the supplier, for example, by typing in ‘A’ and pressing <tab> 
will display all supplier codes beginning with ‘A’ and display them in the Supplier selection window 
 
 

 
 
 
 

4.20.5 Add New Supplier 

If the supplier does not already exist in the RM Finance datafile, then the user may create the 

supplier by clicking the ‘Add Record’ icon from the Supplier selection window .  Providing the 
user has the appropriate access levels, the following window will display 
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The required data can be entered and then the OK button can be selected to save the new supplier 
record.  Validation checks are set up to ensure the mandatory fields have been entered before 
saving the new supplier record. 
 

4.20.6 Edit Supplier 

The Edit Record  button is displayed from the Supplier selection window.  Once a supplier has 
been highlighted and the Edit Record button is selected, the following window will display 
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The window is the same as the New Suppliers window except it is pre-populated with the chosen 
supplier details and the field ‘Short Name’ and ‘Full Name’ are both locked and un-editable.  Users 
can edit the other unlocked fields and the same validation checks remains in place before changes 
can be saved. 

4.20.7 Restrictions on Refunds 

The following transactions cannot be refunded. 
 

 Government Subsidies (i.e. receipts of type GV) 

 Receipts which have been reversed 

 Receipts which have been fully refunded (if only partially refunded then a further refund can 
be carried out) 

 Transactions created as the result of a reversal or a refund 
 
Transactions must be refunded individually (one at a time). Multiple transactions cannot be 
refunded in one operation. 
 
 

4.20.8 Refunds of Unallocated Credit 

If any part of the receipt being refunded is unallocated credit, then this will be reflected in the 
refunds screen as illustrated below. 
 

 
 
The system billing code of SUS is automatically placed as the Ref Code in the unallocated credit 
line – an alternative refund code cannot be entered by the user. This is to ensure that all refunds of 
unallocated credit are correctly entered against the Suspense account in RM Finance. 
 

4.20.9  Receipts tab – Year selection 

 
If the year selection is changed whilst on the Receipts tab, then only receipts which belong to the 
selected year will be displayed. If the ‘All Years’ option is selected then all receipts for the student 
across all years will be displayed. 
 

4.20.10  Receipts tab – Print button 
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Receipts or ‘records of receipt allocations’ can be printed from the Receipts tab by using the print 
button on the toolbar. 
 

4.20.11 To print a receipt 

 

 Students > Receipts tab 

 Highlight the receipt to be printed (multiple receipts may be selected) 

 Click on the Print button 

 The following window appears: 
 

 
 

 Select Receipts 

 Click on OK 

 Select the report destination 

 The receipt is printed in A4 format as illustrated below: 
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4.20.12 Draft/Copy text on receipts 

 
There will only be one original receipt printed to the printer. If a receipt has never been printed to 
the printer and is displayed to the screen it will contain the text ‘Draft Only’.  
 
If the receipt is sent to the printer via the screen display it will still contain the text ‘Draft Only’. 
 
To obtain the original printout of the receipt it must be printed directly to the printer (not via the 
screen display first).  In this case the receipt will not contain any additional text. 
 
If a receipt has already been printed directly to the printer then any subsequent print outs of this 
receipt will contain the text ‘Copy’. 
 

4.20.13 Restrictions on Printing Receipts 

 
Receipts cannot be printed for the following transactions: 
 

 Receipts which have been reversed or refunded 

 Transactions created as a result of a reversal or a refund 

 Receipts of type GV (Government Subsidies) 
 
A record of receipt allocations can be printed for these types of transactions. 

4.20.14 Record of receipt allocations 

An alternative to printing the actual (official) receipt is to print the record of receipt allocations. This 
will list the billing items to which the receipt is allocated at the time of printing. Note that these 
allocations can change if circumstances change. 
 
To print the record of receipt allocations: 
 

 Students > Receipts tab 

 Highlight the required receipt(s) (multiple receipts may be selected) 

 Click on the Print button 

 The following window appears: 
 

 
 

 Select Record of receipt allocations 

 Click on OK 

 Select the report destination 

 The record of receipt allocations is printed in A4 format as illustrated below: 
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Note: Draft/Copy text does not apply to the record of receipt allocations – only to the official 

receipt.  

The total amount of unallocated credit for this receipt is summarised and listed on the 
record of receipt allocations. 

 

4.21  Export EFT and System Generated Cheques to RM Finance 

There are three different possible types of refund transactions, Manual Cheque, System Generated 
Cheque and EFT therefore validation of Supplier Codes must be made .  As the EFT and System 
Cheque transactions to be exported contain a variety of Supplier Codes, these codes must be 
checked to ensure they exist in the RM Finance datafile before an export can occur.  If a matching 
record cannot be found, a report will generate and display the heading ‘Export to RM Finance 
Supplier Code Error Report’, as illustrated below 
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Once all validation has been passed, the required database fields are updated.  The update can 
proceed in the usual manner. 
 

4.21.1 Refund Summary Report 

The Refund Summary Report assists users with reconciling the EFT, System Generated and 
Manual Cheque totals for Refunds.  The Summary Report is accessed through the Receipts > For 
Selected window. 
 

 
 
The user can highlight one or more batches on the Receipts Batches List View screen and select 
this option 
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4.21.2 Receipt Batch Export Summary (Report) 

The Receipt Batch Export Summary (Report) displays EFT and System Generated cheques.  If an 
EFT refunds batch has been created for export, then an additional section is added to the report 
after the “Batches Exported’ section and before the ‘Comment’ section as shown below 
 

 
 
If no EFT Refunds batch has been created, then this section of the report is suppressed.  When 
printed, a heading is displayed “Refund Breakdown on Batches Exported’. 
 

 
 
Under this text, ‘RM Finance Batch Ref:’ is displayed, followed by the batch number created by the 
system for this export (e.g. RMB000001EFT).  Under this heading, the report displays each RM 
Billing receipts batch from which EFT Refund transactions were exported in this export batch. 
Once all batches have been reported, the total for EFT Refunds across the listed batches is 
calculated and reported.   
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Following this, another sub-heading ‘Cheque Refunds’ is displayed. 
 

 
Under this heading, the report displays each RM Billing Receipts batch from which cheque refunds 
(either manual or system-generated) were exported in this export. 
Once all batches have been reported, the total for Cheque Refunds across the listed batches is 
calculated and reported. 
 

 

4.21.3 Re-print Receipts Batch Export Summary 

It is possible to Re-print the Receipts Batch Export Summary Report via Reports > Audit Reports > 
Re-print Receipts Batch Export Summary 
 

 
 
When the user highlights this report, the re-print options are displayed on the right hand side 
 

 
 
Reports which have been previously printed are listed in date/time order descending with the most 
recent report appearing at the top of the list. 
Two radio buttons appear at the bottom of the report. The first radio button displays the text ‘Show 
reports after’, followed by a date.  The default date displayed is set to three months prior to the 
current system date.  The date selector is displayed to the right of this field and standard 
functionality applies. 
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The second radio button displays the text ‘Show all reports’.  If the user selects this radio button, 
then all reports which have been previously printed using a previous version of RM Billing are 
displayed in the list.  The user can select one report to re-print by highlighting it in the list on the 
right hand side.  When the user clicks the Print button, the report destination screen is displayed.  
Once the user has selected the required destination the report is printed. 
 

4.22  Transactions  

This window provides a listing of all transactions (both billing items and receipts) for the student for 
the selected year in the format illustrated below: 
 

 
 
The following information is displayed on this screen: 
 
Ref 
The transaction reference number of the transaction. This is a unique sequential number assigned 
by the system to every transaction when it is created. 
 
Date 

The date the transaction was created. 
 
Type 

The transaction type/payment type.  
 
For a receipt this could be any valid payment type (from Parameters > Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
For a billing item this could be one of the following: 
 
DR Debit (normal billing item) 
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RV Reversal 
AD Adjustment 
 
Comment 

The comment attached to the transaction.  
 
Disc 

This applies to billing items only. If a billing item has a discount applied the letter ‘Y’ will appear in 
this column. Otherwise it will be blank. 
 
Billing Items 

If the transaction is a billing item then the amount of the billing item (after any discount) will be 
displayed. 
 
Receipts 

If the transaction is a receipt then the amount of the receipt will be displayed. 
 
Running Bal 

This column displays the ‘running balance’ up to and including the current line - all billing items and 
receipts are totalled and the overall balance is displayed. 
 
Status 

This column will show the status of a transaction. The status could either be blank or one of the 
following: 
 
For Billing Items  
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
A Transaction which has been adjusted 
T Transaction created as the result of an adjustment 
 
For Receipts 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
F Transaction which has been refunded 
D Transaction created as the result of a refund 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Totals 
Totals are displayed at the bottom of the window for the Billing Items, Receipts and Running 
Balance columns. If the total balance is an amount which is owing (debit amount) then the letters 
DR will appear after the number. If the total balance is a credit figure then the letters CR will follow 
the number. 

4.22.1  Transactions tab – Year selection 

 
If the year selection is changed whilst on the Transactions tab, then only transactions which belong 
to the selected year will be displayed.  
 
Any transactions which belong to years prior to the selected year will be totalled and displayed on 
the ‘Transactions for Previous Year/s’ line. 
 
Any transactions which belong to years following the selected year will be totalled and displayed on 
the ‘Transactions for Following Year/s’ line. 
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The overall totals displayed at the bottom of the window will not change when the year selection is 
changed. 
 
If the ‘All Years’ option is selected then all transactions for the student across all years will be 
displayed. (The transactions for previous and following years summary lines will not be displayed 
in this case). 

4.22.2  Transactions tab – Print button 

 
If the Print button is selected on the Transactions tab then the transactions currently displayed will 
be printed in the format illustrated below: 
 

 

 

4.23  Notes  

The Notes tab can be used to record any relevant information about the student, parent or account 
that should be noted and kept for reference. 
 
The Notes tab appears as illustrated below: 
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4.23.1 To add a note 

 Click on the add button on the right hand side  

 The following screen appears: 
 

 
 
 

 Enter the subject and press <tab> 

 Enter the details in the lower window 

 Click on OK to save 
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Note: Once a note is added to the student record the notes indicator icon appears on the 

status bar as illustrated below. 

 

  
 

4.23.2 To edit a note 

 

 Highlight the note to be edited 

 Click on the edit pencil on the right hand side  

 Make any required changes 

 Click  OK to save 

 

4.23.3 To delete a note 

 

 Highlight the note to be deleted 

 Click on the delete button the right hand side  

 The following message appears: 
 

 
 

 Click  Yes 
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Note: If all notes for a student are deleted, the notes indicator icon is no longer displayed 

on the status bar. 

 

4.23.4 Notes tab – Year selection 

 
Changing the year selection whilst on the Note tab will have no effect on the displayed 
information.  
 

4.23.5 Printing Notes 

There are two options for printing Notes.  Notes can be printed from the Notes tab in the student 
screen.  If no notes are highlighted and the Print button is selected on the Notes tab then all notes 
will be printed in the format illustrated below. 
 

 
 
To print one or more notes, firstly highlight the note/s to be printed and then select the Print button. 
Only the highlighted note will be printed. 
 

 
 
Notes entered against student records will appear in the Student window and are identified by a 
single ‘Tick’.  Clicking twice on the ‘Notes’ Header, will group the student notes at the top of the 
screen. 
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Notes can be printed from this screen by highlighting the ‘Ticks’ and clicking on the ‘For Selected’ 
menu > Print Notes.   
 

 

 
Prior to the report destination screen being displayed, a window allowing for a date range to be 
entered opens where the user can enter a date range for printing notes.  If a student has been at 
the school for a number of years, they may have numerous notes entered against their record.  
Entering a date range will allow the user to view current notes as printing an entire Note history for 
the student is not always necessary. 
 

 
 
Both the ‘From’ and ‘To’ date fields is set to blank initially 
 
Both fields are optional 
 
The ‘From’ date must be before the ‘To’ date 
 
If the user does not enter any dates, the report operates without a date range and returns all the 

notes recorded for the selected student 
 
If the user enters a ‘From’ date but does not enter a ‘To’ date, the report prints all notes from the 

start date onwards (including any future dated notes which may have been entered in error) 
 
If the user enters a ‘To’ date, but does not enter a ‘From’ date, the report prints all notes up to and 

including the ‘To’ date 
 
Once the date selection has been entered and validated, the report destination screen is displayed 
 
Only notes which are dated within the date range (inclusive) are printed 
 
If not date range is entered, then all notes for the selected students are printed 
 
If the user has selected a date range, then this is added after the heading ‘Student Notes Report’ 
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4.24  Invoices  

The first time that a billing item is created for a student an invoice is automatically created by the 
system. Future billing items created for the student are automatically added to the same open 
invoice until it is ‘closed’ (see further explanation below). 
 
The Invoices tab appears as shown below: 
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Highlighting an invoice in the top part of the window will cause the billing items assigned to that 
invoice to be displayed in the lower window. 
 
The following information is displayed in the upper window: 
 
Invoice 
The invoice number. This is a unique sequential number assigned by the system to every invoice 
when it is created. 
 
Date 
The date the invoice was created. 
 
Year 
The billing year to which the invoice belongs. This will be the current billing year (as defined in 
Billing Parameters) when the invoice is created. 
 
Amount 
The amount of the invoice. 
 
Balance 
The balance owing on the invoice. 
 
Printed 
If the invoice has never been printed straight to the printer then this column will contain the letter 
‘N’. Once the invoice has been printed straight to the printer then this column will display the letter 
‘Y’. 
 
Once an invoice has been printed directly to the printer no further items can be added to that 
invoice (i.e. it is closed). A new invoice is automatically created for items billed after that point. 
 

4.24.1 Invoices tab – Year selection 

If the year selection is changed whilst on the Invoices tab, then only invoices which belong to the 
selected year will be displayed. If the ‘All Years’ option is selected then all invoices for the student 
across all years will be displayed. 

 

4.24.2 Invoices tab – Print button 

 
Invoices can be printed from the Invoices tab by using the print button on the toolbar. 
 

4.24.3 To print an invoice 

 Students > Invoices tab 

 Highlight the invoice to be printed (multiple invoices may be selected) 

 Click on the Print button 

 If a default message has been entered in Billing Parameters > Invoice tab, the message is 
automatically displayed in the Print Invoice message window.   

 The user may accept the default message or enter a new message 
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If no default message has been entered, the message field will be blank and a message may be 

entered  
This message (if entered) is added to the invoice immediately underneath the key. 
Select the report destination 
The invoice is printed to the selected destination in the format illustrated below: 
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Note: The BPAY logo and the Remittance Advice will only be displayed if these options 

have been selected in Parameters > Billing Parameters > Invoices tab.  

 
 

4.24.4 Draft/Copy/Amended text on invoices 

To obtain an original invoice, the invoice must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Invoices printed directly to the printer for the first time will contain no additional text. They will also 
be ‘closed’ by printing them straight to the printer.  
 
Invoices viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. 
 
Copies of invoices printed to the printer for the second or subsequent time will contain the text 
‘COPY’. 
 
Invoices may also contain the text ‘Amended’ followed by a date. If an invoice is amended (i.e. 
changes are made to the billing items attached to the invoice once it has been closed) then an 
amendment number will be attached to the original invoice number (e.g. 36-1). The invoice will 
contain the ‘Amended’ text and the date of amendment. It is possible for an invoice to be amended 
more than once. Invoices will be amended if the billing items attached to them are reversed, 
adjusted or discounted once the invoice is closed. 
 

4.24.5 Secondary Financial Assistance Tab 

The Secondary Financial Assistance Tab will display applications made for students for the 
Secondary Assistance Allowances. These include: 
 
Education Program Allowance 
Clothing Allowance  
Abstudy Supplement Allowance 
 
 
 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 4-89 

© 2016 Civica Education Pty Ltd 
 

Applications for Assistance are normally made in Term 1 for students. The parent applying for the 
assistance must be the holder of an eligible concession card. 
 

 
 
Highlighting an application and clicking on the Printer Icon will print a copy of the application. 
 

 
 
Details of how to create and export applications for Secondary Financial Assistance and 
subsequently importing receipts for students who qualify for this assistance is explained in detail in 
Section 4.9 of this Manual. 
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5 Customers 
An External Customer may be anyone the school deals with who is not a student or a 
parent/guardian – i.e. companies or individuals outside of the school environment. 
 
External customers have their own section in RM Billing – the ‘Customers’ section on the side bar. 
 
Unlike students, the customer details are not drawn from the Integris datafile. All Customer Details 
need to be entered manually into RM Billing. 
 
When the Customers icon is selected on the RM Billing sidebar the Customers window will open as 
illustrated below: 
 

 
 
Initially there will be no customer records in the datafile. These need to be created by the operator. 
 
The following columns are displayed on the Customer window: 
 
Customer Name 
The name of the customer (Customer Name Line 1).  
 
Address 

The address of the customer. 
 
BPAY Ref 

The BPAY Reference for the customer. This is calculated and assigned by the system according to 
a set of specific rules in accordance with Bank and BPAY requirements. The BPAY Reference will 
be calculated automatically each time a new customer is added. Once created it cannot be 
changed. 
 
Balance 

The balance outstanding (across all years) for the customer. 
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5.1 To Sort the List of Customers 

The customer list can be sorted by clicking on any of the list headings.  
 
For example, to sort the list in order of balances, click on the Balance heading. The list is sorted 

with the balances in ascending order. 
 
To sort the list in reverse order, click on the Balance heading again. The list is now sorted with the 

balances in descending order. 
 
To sort the list in order of customer name, click on the Customer Name heading. 

 
 

5.2 Quick Search on Customer Name 

 
A quick search on customer name is available on this window. For example, if you click on the first 
customer in the list and then type the letter ‘B’ the cursor will move to the first customer whose 
name begins with ‘B’. If more than one letter of the customer name is entered then the cursor will 
move to the first customer in the list whose name begins with the letters entered. 
 
 

5.3 Customer Icons 

The following icons are available on the Customer List screen: 
  

 Load All – Displays all customers in the datafile  

 Open Details – Opens the drill down facility for the selected customer 

 Print – Prints all customers displayed in the list view 

 Print Selected – Prints all selected (highlighted) customers in the list view 

 Hide Selected – Hides all selected customers 

 Hide Unselected – Hides all unselected customers 

 Add Customer – Allows a new customer record to be created 

 Edit Customer – Allows the selected customer record to be edited (some restrictions apply) 

 Delete Customer – Allows the selected customer record to be deleted (some restrictions 
apply) 

 

5.4 Drill Down Facility 

Drill down functionality is instigated either by double-clicking on a customer or highlighting the 
customer and pressing <enter> or highlighting a customer and using the Open Details icon. The 
Customer Details View will now be displayed. Refer to section 5.8 on page 5-6   for further details. 
 

5.5 To Create a New Customer Record 

 Click on Customers 

 Click on the Add pencil  
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 The following window appears: 
 

 
 

 Enter the customer details as required (Customer Name Line 1 is mandatory but the other 

fields are optional) 

 Click on OK to save 

 

5.6 To Edit a Customer Record 

 Click on Customers 

 Highlight the customer record to be edited 

 Click on the Edit pencil  

 The following screen listing the customer details appears: 
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 Make the required changes 

 Click on OK to save 

 

Note: If transactions have been entered against the customer record then Customer Name 
Line 1 is locked and cannot be edited. If no transactions have been entered for the 

customer then all fields can be edited freely. 

 

5.7 To Delete a Customer Record 

 Click on Customers 

 Highlight the customer record to be deleted 

 Click on the Delete button  

 The following message appears: 
 

 
 

 Click on Yes 

 If no transactions have been entered against the customer then the record is deleted 

 If transactions have been entered against the customer then the following message is 
displayed: 
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Note: If transactions have been entered against the customer record then the record cannot 

be deleted.  

 
 

5.8 Customer Details View 

The Customer Details view can be displayed in three ways: 
 
Either 

Click on a customer and then select the Open Details icon  

or 
Double-click on the required customer 
or 
Highlight the required customer and press <enter> 

 
The Customer Details view will then be displayed as illustrated below: 
 

 
 

5.8.1 Toolbar – Customer Details View 
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The toolbar on the Customer Details View appears as shown below: 
 

 
 

5.8.2 Year Drop Down List 

 
 
The Year Drop Down List displays all years present in the datafile along with an additional ‘All 
Years’ option.  Selecting a particular year from the list will enable data for that year to be displayed 
on the selected tab pane.  

5.8.3 Browse Set Button 

 
Although this button is visible on the toolbar it is greyed out and non-operational.   
 

5.8.4  Print Button 

 
 
The functionality of this button differs slightly depending on which tab pane is selected. See each 
individual section for more details. 
 

5.8.5  Return to View 

 
 
Clicking once on this icon will display the Customer List View (front screen).  
 

5.8.6 Red Field 

 
 
The red field of Customer Name is a scroll field. Clicking on the red name will display the next 
customer in the list. <Shift> clicking will scroll through the customers in reverse order.   
 
To find a customer perform a right mouse click in the customer name field. Enter a name or part 
thereof and press <enter> and the first or closest match will be displayed. 
 

Note: It is advisable (and quicker) to search for customers from within the drill down 

section by using the red field rather than always returning to the front screen.  
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5.8.7 Last Modified By 

 

 
 
At the bottom of all the tab panes (i.e. common to all) is a section showing the date and time that 
any of the tab panes for the selected customer were last modified and the initials of the user who 
made the modification.  It does not matter which pane has been modified – these details are 
updated each time a change is made and displayed at the bottom of all the panes for the selected 
customer. 
 

5.8.8 Details tab 

The Details tab displays the following information: 
 
Customer Name Line 1 
The customer name as entered by the operator (mandatory field). 
 
Customer Name Line 2 
An additional (optional) line which may be used as required. 
 
Address Line 1 
Line 1 of the customer address. 
 
Address Line 2 

Line 2 of the customer address. 
 
Address Line 3 

Line 3 of the customer address. 
 
Address Line 4 

Line 4 of the customer address. 
 
Town/Sub 

The town or suburb of the customer address. 
 
State 

The state of the customer address. 
 
Postcode 

The post code of the customer address. 
 
Country 
The country of the customer address. 
 
Email 
The e-mail address of the customer. 
 
Contact 

The name of the contact person for the customer. 
 
Phone 

The telephone number of the customer. 
 
Fax 

The facsimile number for the customer. 
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Balance Owing 

The total balance outstanding for the customer (across all years). 
 
BPAY Ref 

The BPAY Reference for the customer. This is calculated and assigned by the system according to 
a set of specific rules in accordance with Bank and BPAY requirements. The BPAY Reference will 
be calculated automatically each time a new customer is added. Once created it cannot be 
changed. 

Note: All fields are display only. 

5.8.9  Details tab – Year selection 

 
Changing the year selection whilst on the Details tab will have no effect on the displayed 
information. 
 

5.8.10  Details tab – Print button 

 
If the print button is selected whilst on the Details tab, the information is printed in the format 
illustrated below: 
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5.9 Billing Items tab 

This window will display all billing items for the selected customer for the selected year in the 
format illustrated below: 
 

 
 
The following information is displayed on this window: 
 
Ref 

The transaction reference number of the billing item. This is a unique sequential number assigned 
by the system to every transaction when it is created. 
 
Date 

The date the transaction was created. 
 
Type 

The transaction type. For a billing item this could be one of the following: 
 
DR Debit (normal billing item) 
RV Reversal 
AD Adjustment 
 
Amount 

The amount of the original billing item (before any discount). 
 
GST 

The GST code of the billing item. 
 
Disc 

The discount amount (in dollars) applied to the billing item (if any). 
 
Paid 
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The amount paid against the billing item. 
 
Balance 
The balance owing on the billing item. 
 
Bill Code 
The billing code attached to the billing item. 
 
Batch # 

The batch number of the billing items batch which holds the transaction. 
 
Comment 

The comment attached to the billing item. This will be the comment entered for the tied billing item 
in the batch. 
 
Status 

This column will show the status of a billing item that has been reversed or adjusted. The status 
could be blank (not reversed or adjusted) or one of the following: 
 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
A Transaction which has been adjusted 
T Transaction created as the result of an adjustment 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Reason 
If a transaction has been modified in some way (i.e. discounted, reversed, adjusted, written off or 
cancelled) then the reason field will begin with standard system-generated text (as shown below) 
followed by the reason entered by the operator. 
 

Transaction Reason begins with  

Original transaction reversed Reversed - 

Reversal transaction created (RV) Reversal -  

Original transaction adjusted by user Adjusted -  

Adjustment transaction created (AD) (user initiated) Adjustment -  

Original transaction adjusted by refund Refunded -  

Adjustment transaction created (AD) by refund Refund -  

Original transaction discounted Discounted -  

Original transaction written off Written off - 

Adjustment transaction created for writeoff Writeoff - 

Original transaction cancelled Cancelled -  

Adjustment transaction created for cancellation Cancellation -  

 
Totals 

The Amount, Discount, Paid and Balance fields are totalled at the bottom of the window. 
 

5.10  Add Billing Item  

 
This button allows one or more billing items to be added to a customer record.  
 
 
 

5.10.1 To add a billing item 
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 RM Billing > Customers 

 Double-click on the required customer 

 Click on the Billing Items tab 

 Click on Add Billing Item 

 If future years have been created in the datafile then the year selection box is displayed.  (If 
no future years exist then this step will be omitted and the current billing year (as set in 
Billing Parameters) will be used). 

 

 
 

 If the above window is displayed, select the required year and click on OK 

 A list of billing item batches for the selected year is then displayed: 
 

 
 

 Highlight one or more batches in the above window (dragging or <Ctrl> click can be used 

for multiple selection) 

 Click on OK 

 A short message may be displayed whilst the billing items are created 

5.10.2 Editing billing items before billing 

Billing items in a batch may be edited during the above process if required. When the billing batch 
selection screen is displayed an ‘Edit’ button is present which is initially ‘greyed out’ and disabled. 
The Edit button will become enabled if one (and only one) batch is selected (highlighted). 

5.10.3 To edit billing items in the selected batch 

 

 Follow the steps listed above until the billing batch selection screen appears 

 Highlight one batch in the billing batch selection screen 
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 The Edit button is enabled 

 Click on Edit 

 The following screen appears 
 

 
 

 Highlight the line to be edited 

 Click on the edit pencil   

 Make the required changes to the billing item  

 Click on the green tick   

 Click OK to bill the customer using the newly edited items 

 
 

Note: New billing items can be added by using the add button  on the above screen. 
Billing items which are not required for this customer can be deleted by using the delete 

button    on this screen. 
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IMPORTANT 

Any changes made to the above screen are used for billing this 
customer only. They are not saved to the billing items batch. 

 

5.11  Reversals 

 
Billing items can be reversed by using the reversal button on the Customers > Billing Items tab. 
When a billing item is reversed an equal and opposite ‘reversal’ transaction is created which 
negates the original transaction.  
 

5.11.1 To reverse a billing item 

 

 Customers > Billing Items tab 

 Highlight the Billing Item to be reversed 

 Click on the Reversal button 

 The following message appears: 
 

 
 

 Click on Yes 

 The following screen is then displayed: 
 

 
 

 Enter a reason for the billing item reversal 

 Click on OK to save 

 
The status of the original transaction is marked with an ‘R’ to show it has been reversed and the 
transaction reference number of the newly created reversal transaction appears in the status 
column. 
 
The reversal transaction which has been created is marked with a ‘V’ followed by the transaction 
number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

5.11.2 Restrictions on Reversals 
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The following items cannot be reversed. 
 

 Items which have a discount applied 

 Items which have already been reversed or adjusted 

 Transactions created as the result of a reversal or an adjustment 
 
When using the reversal facility available from the Customers > Billing Items section, transactions 
must be reversed individually (one at a time).  
 

5.11.3 Bulk Reversal Facility 

A bulk reversal facility which allows multiple transactions to be reversed in one operation is 
available from the Billing Items section. Please refer to section 6.11 on page 6-16 for further 
information regarding bulk reversals. 
 

5.12  Adjustments 

 
Billing items can be adjusted by using the Adjustment button on the Customers > Billing Items tab. 
When a billing item is adjusted the overall amount is reduced by the amount of the adjustment. An 
adjustment transaction (negative transaction) is created which reduces the overall amount billed. 
 

5.12.1 To adjust a billing item 

 

 Customers > Billing Items tab 

 Highlight the Billing Item to be adjusted 

 Click on the Adjustment button 

 The following message appears: 

 
 

 Click on Yes 

 The following screen is then displayed: 
 

 
 

 Enter the amount to adjust down by 

 Enter a reason for the adjustment 

 Click on OK to save 
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The status of the original transaction is marked with an ‘A’ to show it has been adjusted and the 
transaction reference number of the newly created adjustment transaction appears in the status 
column. 
 
The adjustment transaction which has been created is marked with a ‘T’ followed by the  
transaction number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

5.12.2 Restrictions on Adjustments 

The following items cannot be adjusted: 
 

 Items which have a discount applied 

 Items which have been reversed 

 Items which have been fully adjusted (to zero) 

 Transactions created as the result of a reversal or an adjustment 
 
Transactions must be adjusted individually (one at a time). Multiple transactions cannot be 
adjusted in one operation. 
 

5.13  Discounts 

 
Billing items can be discounted by using the Add Discount button on the Customers > Billing Items 
tab. When a billing item is discounted the overall amount is reduced by the discount percentage.  
Several items can be discounted at once if required. 
 

5.13.1 To add a discount to a billing item 

 

 Customers > Billing Items tab 

 Highlight the Billing Item to be discounted (or select multiple items) 

 Click on the Add Discount button 

 The following message appears: 
 

 
 

 Enter the percentage by which the item is to be discounted 

 Enter a reason for the discount 

 Click on OK to save 

 
The dollar amount of the discount is calculated and displayed in the Disc column and the balance 
on the billing item is recalculated accordingly. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
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5.13.2 To remove a discount from a billing item 

 

 Customers > Billing Items tab 

 Highlight the Billing Item from which the discount is to be removed (or select multiple 

items) 

 Click on the Remove Discount button 

 The following message appears: 
 

 
 

 Click on Yes 
 
The discount is removed, the Disc column is cleared and the balance on the billing item is 
reinstated accordingly. The reason field is cleared of the discount information. 
 

5.13.3 Restrictions on Discounts 

The following items cannot be discounted. 
 

 Items which are fully paid 

 Items which already have a discount applied (see below) 

 Items which have been reversed or adjusted 

 Transactions created as the result of a reversal or an adjustment 
 
A partly paid item can have a discount applied but the amount of the discount must be less than or 
equal to the balance owing on the item. 
 
If a further discount needs to be applied to an item which has already been discounted, then the 
original discount should be removed and the new (larger) discount applied. 
 

5.13.4 Bulk Discount Facility 

 
An additional bulk discount facility which allows multiple items to be discounted for different 
customers in one operation is available from Billing Items section. Please refer to section 6.12 on 
page 6-18 for further information.  
 

5.14  Unallocated Credit 

 
There will be times when unallocated credit is created. This is a credit amount which is not 
allocated to any billing items. If a paid billing item is reversed, the amount paid will become 
unallocated credit. It is also possible when adding a receipt not to allocate the receipt to any billing 
items thereby creating unallocated credit. 
 
If any unallocated credit exists it will be displayed on the Billing Items tab for the customer as 
illustrated below. If there is no unallocated credit for the customer then this information will not 
appear. 
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Note: There is also a report (Unallocated Credit Listing) which can be used to identify 

unallocated credit. Please refer to section 8.6.6 on page 8-30  for further details. 

 

5.14.1 To allocate unallocated credit 

At times it may be necessary to allocate the unallocated credit to unpaid billing items for the 
customer.  
 

 Customers > Billing Items tab 

 Highlight the Billing Item/s to which the credit should be applied  

 Click on the Allocate button 

 The following message appears: 
 

 
 

 Enter the amount to be allocated 

 Click on OK to save 

 
Credit can only be allocated to unpaid billing items. Items which have been reversed or are 
correction transactions cannot be allocated against. Items which have been partially adjusted but 
still have an outstanding balance can be allocated against. If ineligible items are selected for the 
allocation then one of the following warning messages will be displayed: 
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5.14.2 Automatic Allocation of Unallocated Credit 

A facility to automatically allocate unallocated credit is available from the Billing Items section. 
Please refer to section 6.13  on page 6-20 for further information. 
 

5.14.3  Billing Items tab – Year selection 

 
If the year selection is changed whilst on the Billing Items tab, then only billing items which belong 
to the selected year will be displayed. If the ‘All Years’ option is selected then all billing items for 
the customer across all years will be displayed. 
 

5.14.4  Billing Items tab – Print button 

 
If the Print button is selected on the Billing Items tab then the billing items currently displayed will 
be printed in the format illustrated below: 
 
 

 
 
 

5.14.5 Receipts tab 

This window will display all receipts for the selected customer for the selected year in the format 
illustrated below: 
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If a receipt is highlighted in the top window, the billing items to which the receipt is allocated are 
displayed in the lower window. 
 
The following information is displayed for each receipt: 
 
Ref 

The transaction reference number of the receipt. This is a unique sequential number assigned by 
the system to every transaction when it is created. 
 
Rec # 
The actual receipt number assigned to the receipt. This is a unique sequential number assigned by 
the system to receipt related transaction only. 
 
Date 

The date the transaction was created. 
 
Type 
The transaction/payment type. For a receipt this could be any valid payment type (from Parameters 
> Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
Amount 
The amount of the receipt. 
 
Batch # 
The batch number of the receipts batch which holds the transaction. 
 
Comment 
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The comment attached to the receipt. This will be the comment input by the operator when the 
receipt is entered. 
 
Status 

This column will show the status of a receipt that has been reversed or refunded. The status could 
be blank (not reversed or refunded) or one of the following: 
 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
F Transaction which has been refunded 
D Transaction created as the result of a refund 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Reason 

If a transaction has been modified in some way (i.e. reversed or refunded) then the reason field will 
begin with standard system-generated text (as shown below) followed by the reason entered by 
the operator. 
 

Transaction Reason begins with  

Original transaction reversed Reversed - 

Reversal transaction created  Reversal -  

Original transaction refunded Refunded -  

Refund transaction created Refund -  

 
 

5.14.6  Add Receipt 

 
This button allows a receipt to be entered against a customer record.  

5.14.7 To add a receipt 

 

 RM Billing > Customers 

 Double-click on the required customer 

 Click on the Receipts tab 

 Click on Add Receipt 

 The following screen appears: 
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 Enter the receipts batch number for the receipt (or press <tab> for a list) 

 Enter the payment type (or press <tab> for a list) 

 The date will default to today’s date (this can be changed if required – future dates are not 
permitted) 

 Enter the amount of the receipt 

 Enter the comment for the receipt (this will appear on the receipt) 

 Edit the ‘Received From’ fields if required (see note below) 

 Allocate the receipt against the required billing items in the list. Type the amount to 

allocate to each billing item in the ‘applied’ column. If nothing is to be allocated zero can be 
entered. Press the <tab> key to move between fields. 

 Click on OK to save 
 
 
If no amounts are allocated to the items listed in the billing items table then the receipt will become 
unallocated credit. The following confirmation message will be displayed in this instance: 
 

 
 

Note: The ‘Received From’ fields will default to the name and address of the customer as 
entered on the customer record. These can be edited if the payment is being made by a 

different person. These details are stored with the receipt for future reference.   
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5.15  Reversals 

 
Receipts can be reversed by using the reversal button on the Customers > Receipts tab. When a 
receipt is reversed an equal and opposite ‘reversal’ transaction is created which negates the 
original transaction.  
 

5.15.1 To reverse a receipt 

 

 Customers > Receipts tab 

 Highlight the Receipt to be reversed 

 Click on the Reversal button 

 The following message appears: 
 

 
 

 Click on Yes 

 The following screen is then displayed: 
 

 
 

 Enter a reason for the receipt reversal 

 The batch selection screen will be displayed as illustrated below. This window lists all open 
receipts batches. The batch containing the original receipt (if open) will be marked with an 
asterisk (*). 

 
 

 

 Highlight the original receipts batch (if open) 

 If the original batch is not open then select the Corrections batch 
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 Click on OK to save 

 

Note: If the original receipts batch is still open it is best to place the reversal into this batch. 

The reversal will negate (cancel) the original transaction.  

If the original batch has been closed then the reversal should be placed into the current 
open ‘Corrections’ batch. 

 
The status of the original transaction is marked with an ‘R’ to show it has been reversed and the 
transaction reference number of the newly created reversal transaction appears in the status 
column. 
 
The reversal transaction which has been created is marked with a ‘V’ followed by the transaction 
number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

5.15.2 Restrictions on Reversals 

The following transactions cannot be reversed: 
 

 Receipts which have already been reversed or refunded (full or partial) 

 Transactions created as the result of a reversal or a refund 
 
Transactions must be reversed individually (one at a time). Multiple transactions cannot be 
reversed in one operation. 
 

5.16  Refunds 

 
Receipts can be refunded by using the Refund button on the Customers > Receipts tab. When a 
receipt is refunded a refund transaction (negative transaction) is created for the amount which is 
refunded. In addition, the billing items to which this amount was allocated are adjusted down by the 
system to indicate that they are no longer outstanding.  
 
 

5.16.1 To refund a receipt  

 

 Customers > Receipts tab 

 Highlight the receipt to be refunded 

 Click on the Refund button 

 The following window appears: 
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 Enter the refund amount 

 Enter the reason for the refund 

 Enter the amount to refund on each billing item in the ‘Adjust By’ column 

 Enter the refund billing code for each item in the ‘Ref Code’ column or press <tab> for a 

list. Only refund type billing codes can be selected. 

 Enter the manual cheque number (if known) into the ‘Cheque Number’ field 

 Click on OK to save 

 The batch selection screen will be displayed as illustrated below. This window lists all open 
receipts batches. The batch containing the original receipt (if open) will be marked with an 
asterisk (*). 

 

 
 

 Highlight the Refunds batch 

 Click on OK to save 
 
 
The status of the original transaction is marked with an ‘F’ to show it has been refunded and the 
transaction reference number of the newly created refund transaction appears in the status 
column. 
 
The refund transaction which has been created is marked with a ‘D’ followed by the transaction 
number of the original transaction. 
 
The reason field is updated to contain the standard text followed by the reason entered. 
 

5.16.2 Refunds of Unallocated Credit 

If any part of the receipt being refunded is unallocated credit, then this will be reflected in the 
refunds screen as illustrated below. 
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The system billing code of SUS is automatically placed as the Ref Code in the unallocated credit 
line – an alternative refund code cannot be entered by the user. This is to ensure that all refunds of 
unallocated credit are correctly entered against the Suspense account in RM Finance. 
 

5.16.3 Restrictions on Refunds 

The following transactions cannot be refunded: 
 

 Receipts which have been reversed 

 Receipts which have been fully refunded (if only partially refunded then a further refund can 
be carried out) 

 Transactions created as the result of a reversal or a refund 
 
Transactions must be refunded individually (one at a time). Multiple transactions cannot be 
refunded in one operation. 
 
 
 

5.16.4  Receipts tab – Year selection 

 
If the year selection is changed whilst on the Receipts tab, then only receipts which belong to the 
selected year will be displayed. If the ‘All Years’ option is selected then all receipts for the customer 
across all years will be displayed. 
 

5.16.5  Receipts tab – Print button 

 
Receipts or ‘records of receipt allocations’ can be printed from the Receipts tab by using the print 
button on the toolbar. 
 

5.16.6 To print a receipt 

 

 Customers > Receipts tab 

 Highlight the receipt to be printed (multiple receipts may be selected) 
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 Click on the Print button 

 The following window appears: 
 

 
 

 Select Receipts 

 Click on OK 

 Select the report destination 

 The receipt is printed in A4 format as illustrated below: 
 

 
 
 
 

5.16.7 Draft/Copy text on receipts 

 
There will only be one original receipt printed to the printer. If a receipt has never been printed to 
the printer and is displayed to the screen it will contain the text ‘Draft Only’.  
 
If the receipt is sent to the printer via the screen display it will still contain the text ‘Draft Only’. 
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To obtain the original printout of the receipt it must be printed directly to the printer (not via the 
screen display first).  In this case the receipt will not contain any additional text. 
 
If a receipt has already been printed directly to the printer then any subsequent print outs of this 
receipt will contain the text ‘Copy’. 
 

5.16.8 Restrictions on Printing Receipts 

 
Receipts cannot be printed for the following transactions: 
 

 Receipts which have been reversed or refunded 

 Transactions created as a result of a reversal or a refund 

 Receipts of type GV (Government Subsidies) 
 
A record of receipt allocations can be printed for these types of transactions. 
 
 

5.16.9  

5.16.10 Record of receipt allocations 

An alternative to printing the actual (official) receipt is to print the record of receipt allocations. This 
will list the billing items to which the receipt is allocated at the time of printing. Note that these 
allocations can change if circumstances change. 
 
To print the record of receipt allocations: 
 

 Students > Receipts tab 

 Highlight the required receipt(s) (multiple receipts may be selected) 

 Click on the Print button 

 The following window appears: 
 

 
 

 Select Record of receipt allocations 

 Click on OK 

 Select the report destination 

 The record of receipt allocations is printed in A4 format as illustrated below: 
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Notes: Draft/Copy text does not apply to the record of receipt allocations – only to the 

official receipt.  

The amount of unallocated credit (if any) in a receipt will be summarised and printed on the 

Record of receipt allocations 

 

 

5.17 Transactions 

This window provides a listing of all transactions (both billing items and receipts) for the customer 
for the selected year in the format illustrated below: 
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The following information is displayed on this screen: 
 
Ref 
The transaction reference number of the transaction. This is a unique sequential number assigned 
by the system to every transaction when it is created. 
 
Date 
The date the transaction was created. 
 
Type 
The transaction type/payment type.  
 
For a receipt this could be any valid payment type (from Parameters > Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
For a billing item this could be one of the following: 
 
DR Debit (normal billing item) 
RV Reversal 
AD Adjustment 
 
Comment 
The comment attached to the transaction.  
 
Disc 
This applies to billing items only. If a billing item has a discount applied the letter ‘Y’ will appear in 
this column. Otherwise it will be blank. 
 
Billing Items 
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If the transaction is a billing item then the amount of the billing item (after any discount) will be 
displayed. 
 
Receipts 

If the transaction is a receipt then the amount of the receipt will be displayed. 
 
Running Bal 

This column displays the ‘running balance’ up to and including the current line - all billing items and 
receipts are totalled and the overall balance is displayed. 
 
Status 

This column will show the status of a transaction. The status could either be blank or one of the 
following: 
 
For Billing Items  
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
A Transaction which has been adjusted 
T Transaction created as the result of an adjustment 
 
For Receipts 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
F Transaction which has been refunded 
D Transaction created as the result of a refund 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Totals 

Totals are displayed at the bottom of the window for the Billing Items, Receipts and Running 
Balance columns. If the total balance is an amount which is owing (debit amount) then the letters 
DR will appear after the number. If the total balance is a credit figure then the letters CR will follow 
the number. 
 

5.17.1  Transactions tab – Year selection 

 
If the year selection is changed whilst on the Transactions tab, then only transactions which belong 
to the selected year will be displayed.  
 
Any transactions which belong to years prior to the selected year will be totalled and displayed on 
the ‘Transactions for Previous Year/s’ line. 
 
Any transactions which belong to years following the selected year will be totalled and displayed on 
the ‘Transactions for Following Year/s’ line. 
 
The overall totals displayed at the bottom of the window will not change when the year selection is 
changed. 
 
If the ‘All Years’ option is selected then all transactions for the customer across all years will be 
displayed. (The transactions for previous and following years summary lines will not be displayed 
in this case). 
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5.17.2  Transactions tab – Print button 

 
If the Print button is selected on the Transactions tab then the transactions currently displayed will 
be printed in the format illustrated below: 
 

 
 

5.18  Notes  

 
The Notes tab can be used to record any relevant information about the customer or account that 
should be noted and kept for reference. 
 
The Notes tab appears as illustrated below: 
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5.18.1  To add a note 

 Click on the add button on the right hand side  

 The following screen appears: 
 

 
 

 Enter the subject and press <tab> 

 Enter the details in the lower window 

 Click on OK to save 

5.18.2  To edit a note 

 

 Highlight the note to be edited 
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 Click on the edit pencil on the right hand side  

 Make any required changes 

 Click on OK to save 

 

5.18.3  To delete a note 

 

 Highlight the note to be deleted 

 Click on the delete button the right hand side  

 The following message appears: 
 

 
 

 Click on Yes 

 

5.18.4  Notes tab – Year selection 

 
Changing the year selection whilst on the Note tab will have no effect on the displayed 
information.  
 

5.18.5  Notes tab – Print button 

 
If no notes are highlighted and the Print button is selected on the Notes tab then all notes will be 
printed in the format illustrated below: 
 

 
 
If one or more notes are required to be printed, highlight the selected notes first and then click the 
Print button. 
  

5.18.6 Student Notes 

There are two options for printing Notes for students.  Notes can be printed from the Notes tab in 
the student screen or from the For Selected menu in the Student List window.  If no notes are 
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highlighted and the Print button is selected on the Notes tab then all notes will be printed in the 
format illustrated below. 
 

 
 
To print one or more notes, firstly highlight the note/s to be printed and then select the Print button. 
Only the highlighted note will be printed. 
 

 
 
Notes entered against student records will appear in the Student List window and are identified by 
a single ‘Tick’.  Clicking twice on the ‘Notes’ Header, will group the student notes at the top of the 
screen. 
 

 
 
Notes can be printed from this screen by highlighting the ‘Ticks’ and clicking on the ‘For Selected’ 
menu > Print Notes.  
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Prior to the report destination screen being displayed, a window allowing for a date range to be 
entered opens where the user can enter a date range for printing notes.  If a student has been at 
the school for a number of years, they may have numerous notes entered against their record.  
Entering a date range will allow the user to view current notes as printing an entire Note history for 
the student is not always necessary. 
 

 
 

 
 
Both the ‘From’ and ‘To’ date fields is set to blank initially 
 
Both fields are optional 
 
The ‘From’ date must be before the ‘To’ date 
 
If the user does not enter any dates, the report operates without a date range and returns all the 

notes recorded for the selected student 
 
If the user enters a ‘From’ date but does not enter a ‘To’ date, the report prints all notes from the 

start date onwards (including any future dated notes which may have been entered in error) 
 
If the user enters a ‘To’ date, but does not enter a ‘From’ date, the report prints all notes up to and 

including the ‘To’ date 
 
Once the date selection has been entered and validated, the report destination screen is displayed 
 
Only notes which are dated within the date range (inclusive) are printed 
 
If not date range is entered, then all notes for the selected students are printed 
 
If the user has selected a date range, then this is added after the heading ‘Student Notes Report’ 
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5.19  Invoices  

The first time that a billing item is created for a customer, an invoice is automatically created by the 
system. Future billing items created for the customer are automatically added to the same open 
invoice until it is ‘closed’ (see further explanation below). 
 
The Invoices tab appears as shown below: 
 

 
 
Highlighting an invoice in the top part of the window will cause the billing items assigned to that 
invoice to be displayed in the lower window. 
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The following information is displayed in the upper window: 
 
Invoice 
The invoice number. This is a unique sequential number assigned by the system to every invoice 
when it is created. 
 
Date 

The date the invoice was created. 
 
Year 
The billing year to which the invoice belongs. This will be the current billing year (as defined in 
Billing Parameters) when the invoice is created. 
 
Amount 

The amount of the invoice. 
 
Balance 
The balance owing on the invoice. 
 
 
Printed 

If the invoice has never been printed straight to the printer then this column will contain the letter 
‘N’. Once the invoice has been printed straight to the printer then this column will display the letter 
‘Y’. 
 
Once an invoice has been printed directly to the printer no further items can be added to that 
invoice (i.e. it is closed). A new invoice is automatically created for items billed after that point. 

 

5.19.1  Invoices tab – Year selection 

 
If the year selection is changed whilst on the Invoices tab, then only invoices which belong to the 
selected year will be displayed. If the ‘All Years’ option is selected then all invoices for the 
customer across all years will be displayed. 
 

5.19.2  Invoices tab – Print button 

 
Invoices can be printed from the Invoices tab by using the print button on the toolbar. 
 

5.19.2.1.1 To print an invoice 

 
Customers > Invoices tab 
Highlight the invoice to be printed (multiple invoices may be selected) 
Click on the Print button 

If a default message has been entered in Billing Parameters > Invoice tab, the message is 
automatically displayed in the Print Invoice message window.   

The user may accept the default message or enter a new message 
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If no default message has been entered, the message field will be blank and a message may be 

entered  
This message (if entered) is added to the invoice immediately underneath the key. 
Select the report destination 
The invoice is printed to the selected destination in the format illustrated below: 
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Note: BPAY information and/or a remittance advice can be included on the invoice if the 

appropriate options are chosen in Parameters > Billing Parameters > Invoices tab. 

 
 

5.19.2.1.2 Draft/Copy/Amended text on invoices 

 
To obtain an original invoice, the invoice must be printed directly to the printer (not to the screen 
and then to the printer). 
 
Invoices printed directly to the printer for the first time will contain no additional text. They will also 
be ‘closed’ by printing them straight to the printer.  
 
Invoices viewed to the screen will contain the text ‘DRAFT’. If sent to the printer from the screen, 
the printed copy will contain the text ‘DRAFT’. 
 
Copies of invoices printed to the printer for the second or subsequent time will contain the text 
‘COPY’. 
 
Invoices may also contain the text ‘Amended’ followed by a date. If an invoice is amended (i.e. 
changes are made to the billing items attached to the invoice once it has been closed) then an 
amendment number will be attached to the original invoice number (e.g. 36-1). The invoice will 
contain the ‘Amended’ text and the date of amendment. It is possible for an invoice to be amended 
more than once. Invoices will be amended if the billing items attached to them are reversed, 
adjusted or discounted once the invoice is closed.  



 
 
  

Billing Items 

6 
 

 

                          RM Billing Manual 
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6 Billing Items 
 
The Billing Items section allows the operator to create, view and manipulate Billing Item Batches – 
batches to hold billing items for students and customers. 
 
When the Billing Items icon is selected on the RM Billing sidebar the Billing Items window will open 
as illustrated below: 
 

 
 
Initially there will be no billing item batches in the datafile. These need to be created by the 
operator (with the exception of Subject Batches which are created by the system if the Timetabling 
module is being used). 
 
Once billing item batches have been created, they will be displayed in this window in batch number 
order with the open batches preceding the closed batches. 
 
The following columns are displayed on the Billing Items window: 
 
Batch No 

The batch number is generated by the system when a new batch is created (either by the system 
or by the operator). The batch number is a unique sequential number beginning at ‘1’ and padded 
with zeroes to a length of 5 digits e.g. 00001. 
 
Year 
The year tied to the billing items batch. This is the year selected by the operator when the batch is 
created. 
 
Description 

The description of the billing items batch. For user-created batches this is entered by the operator 
when creating the batch. The description for subjects batches is created by the system using the 
text ‘Subjects Batch’ followed by the relevant year, e.g. Subjects Batch 2009. 
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Open 

If the Billing Items batch is open the word ‘YES’ will appear in this column. Otherwise the word ‘NO’ 
will be displayed. 
 
Last Updated 

The date and time that the batch was last updated. 
 
Batch Total 

The total of all the billing items held in the batch. 

 

6.1.1 Year Drop Down List 

 

 
 
The Year Drop Down List displays all years present in the datafile along with an additional ‘All 
Years’ option.  Selecting a particular year from the list will enable billing items batches for that year 
to be displayed. If the ‘All Years’ option is selected then all billing items batches across all years 
will be displayed. 

 

6.1.2 To Sort the List of Billing Items Batches 

The batch list can be sorted by clicking on any of the list headings.  
 
For example, to sort the list in order of balances, click on the Batch Total heading. The list is 
sorted with the batch totals in ascending order. 
 
To sort the list in reverse order, click on the Batch Total heading again. The list is now sorted with 
the batch totals in descending order. 
 

6.1.3 Quick Search on Batch No 

 
A quick search on Batch No is available on this window. For example, if you click on the first batch 
in the list and then type all or part of the batch number, the cursor will move to the first batch 
beginning with the number/s entered.  
 

6.2 Billing Items Icons 

The following icons are available on the Billing Item Batches List screen: 
  

 Load All – Displays all batches for the selected year   

 Open Details – Opens the drill down facility for the selected batch 

 Print – Prints a list of all batches displayed in the list view 

 Print Selected – Prints a list of all selected (highlighted) batches in the list view 

 Hide Selected – Hides all selected batches 

 Hide Unselected – Hides all unselected batches 
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 Add Item – Allows a new batch to be created 

 Edit Item – Allows the selected batch to be edited (some restrictions apply) 

 Delete Item – Allows the selected batch to be deleted (some restrictions apply) 
 

6.3 Drill Down Facility 

Drill down functionality is instigated by double-clicking on a batch, highlighting the batch and 
pressing <enter> or highlighting a batch and using the Open Details icon. The Billing Items Batch 

Details tab will now be displayed.  

6.4 To Create a New Billing Items Batch 

 Click on Billing Items 

 Click on the Add pencil  

 The following window appears: 
 

 
 

 The Batch No is set by the system and cannot be changed 

 Select the required billing year from the drop down list (only the current or future years can 

be selected) 

 Enter a description for the batch 

 Click on OK to save 

 Now enter the tied billing items for this batch (see following section) 
 

6.4.1 To Enter Tied Billing Items 

 Click on the Add button on the right hand side  

 Enter a comment for the billing item (this will appear on the statement etc) and press 
<tab> 
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 Enter the amount of the billing item and press <tab> 

 Enter the GST code for the billing item (or press <tab> for a list) and press <tab> 

 Enter the Billing Code for the billing item (or press <tab> for a list) and press <tab> 

 Click on OK to save 

 Other billing items can now be entered in this list if required 
 
A sample billing items batch is illustrated below: 
 
 

 
 

 

6.4.2 To Edit a Billing Items Batch 

 Click on Billing Items 

 Highlight the batch to be edited 

 Click on the Edit pencil  

 The following screen listing the batch details appears: 
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 Edit the batch description as required 

 Click on OK to save 
 

Note: Subjects Batches which are created by the system (if using the Timetabling module) 
cannot be edited. If an attempt is made to edit a subjects batch then the following error 

message will be displayed: 

 

 

6.4.3 To Edit Tied Billing Items 

 Click on Billing Items 

 Double-click on the required batch 

 Highlight the billing item to be edited 

 Click on the edit pencil on the right hand side   

 Make the required changes 

 Click on OK to save 

6.4.4 To Delete a Billing Items Batch 

 Click on Billing Items 

 Highlight the batch to be deleted 
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 Click on the Delete button  

 The following message appears: 
 

 
 

 Click on Yes 

 The batch is deleted 
 
 

Note: Batches which contain transactions cannot be deleted. The following error message 

will be displayed if an attempt is made to delete a batch containing transactions: 

 

 

Note: Subjects Batches which are created by the system (if using the Timetabling module) 
cannot be deleted. If an attempt is made to delete a subjects batch then the following error 

message will be displayed: 

 

 
 

6.4.5 To Delete Tied Billing Items 

 Click on Billing Items 

 Double-click on the required batch 

 Highlight the billing item to be deleted 

 Click on the delete button on the right hand side   

 The following message appears: 
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 Click on Yes 

 

6.5 For Selected Menu 

The For Selected menu contains the following options: 
 

 
 

6.6 Close Batch  

This option allows a billing items batch to be closed. Once a batch is closed no further transactions 
can be added to the batch and the batch can no longer be used for billing students and/or 
customers. 
 

6.6.1 Close a Billing Item Batch 

 Click on Billing Items  

 Highlight the batch to be closed (multiple batches may be selected) 

 Click on For Selected 

 Choose Close Batch 

 The following message is displayed: 
 

 
 

 Click on Yes 

 The selected batch is closed 
 

Note: System-created batches cannot be closed by the operator. 

6.6.2 Duplicate Batch 

This option allows a billing items batch to be duplicated. The batch structure will be copied 
(including the tied billing items), but actual billing items contained in the batch will not be 
duplicated. The newly created batch will be empty. 
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6.6.3  To duplicate a billing items batch 

 

 Click on Billing Items  

 Highlight the batch to be duplicated (multiple batches may be selected) 

 Click on For Selected 

 Choose Duplicate Batch 

 The following message is displayed: 
 

 
 

 Click on Yes 

 The following screen appears: 
 

 
 

 Select the billing year for the batch 

 Enter the description for the batch 

 Click on OK to save 

 The new batch is created 
 

Note: System-created batches cannot be duplicated. 

 

6.7  Billing Items Batch Details View 

The Billing Items Batch Details view can be displayed in three ways: 
 
Either 

Click on a batch and then select the Open Details icon  
or 
Double-click on the required batch 
or 
Highlight the required batch and press <enter> 

 
The Billing Items Batch Details view will then be displayed as illustrated below:  
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6.8 Toolbar – Billing Items Batch Details View 

The toolbar on the Billing Items Batch Details View appears as shown below: 
 

 
 
  

6.8.1  Print Button 

 
 
The functionality of this button differs slightly depending on which tab pane is selected. See each 
individual section for more details. 
 

6.8.2  Return to View 

 
 
Clicking once on this icon will display the Billing Items Batches List View (front screen).  
 

6.8.3  Red Fields 
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The red fields of Batch No and Description are scroll fields. Clicking on the red Batch No will 
display the next batch in the list. <Shift> clicking will scroll through the batches in reverse order.   
 
To find a particular batch perform a right mouse click in a red field. Enter the batch or part thereof 
and press <enter> and the first or closest match will be displayed. 
 

6.8.4  Details tab 

The Details tab displays the following information: 
 
Batch No 
The batch number is generated by the system when a new batch is created (either by the system 
or by the operator). The batch number is a unique sequential number beginning at ‘1’ and padded 
with zeroes to a length of 5 digits e.g. 00001. 
 
Billing Year 

The year tied to the billing items batch. This is the year selected by the operator when the batch is 
created. 
 
Description 

The description of the billing items batch.  
 
Batch Total 

The total of all the billing items held in the batch. 
 
Updated 

The date and time that the batch was last updated. 
 
Created 

The date and time that the batch was created. 
 
Open 

If the Billing Items batch is open the word ‘YES’ will appear in this field. Otherwise the word ‘NO’ 
will be displayed. 
 
Tied Billing Items 

The billing items tied to the batch are listed in this section. 

 

6.8.5  Details tab – Print button 

 
If the print button is selected whilst on the Details tab, the information is printed in the format 
illustrated below: 
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6.9  Batch Billing Items  

This window will display all billing items which are held in the selected batch in the format 
illustrated below: 
 

 
 
The following information is displayed on this window: 
 
Ref 

The transaction reference number of the billing item. This is a unique sequential number assigned 
by the system to every transaction when it is created. 
 
Student/Cust 
The student name or the customer name. 
 
Year 

The current year group of the student (blank for customers). 
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Form 

The current form group of the student (blank for customers). 
 
Amount 

The dollar amount of the billing item (before any discount applied). 
 
GST 

The GST code of the item. 
 
Disc 

The discount amount applied to the item. 
 
Paid 

The amount paid against the item. 
 
Balance 
The balance owing against the item. 
 
Bill Code 
The billing code attached to the item. 
 
Comment 
The comment attached to the item. 
 
Status 

The status of the item, followed by the transaction reference numbers of all related transactions. 
 
Reason 

The reason stored with the item. 
 
Totals 

The Amount, Discount, Paid and Balance columns are totalled for all transactions in the batch. 
 
Selected Totals 

Once one or more lines have been selected in the main body of the window the selected totals will 
reflect the totals for the highlighted items. 

 

6.9.1 Show Outstanding Amounts 

 
When this button is clicked the display changes to show the transactions in a format which 
summarises the outstanding balances for transactions after any adjustments have been made. 
Transactions are displayed as follows: 
 

 No reversed or reversal transactions are displayed. 

 No transactions created as a result of an adjustment are shown. 

 Original transactions which have not been reversed or adjusted are shown. 

 Original transactions which have been adjusted but still have a partial balance owing are 
shown with the total outstanding balance reported in the balance column. 
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Note: In the case of a partially adjusted item, the amount minus any discount, minus the 
amount paid will not equal the balance, but the status flag will indicate that the item has 
been adjusted and explanatory text is displayed at the bottom of the window. 

After the ‘Show Outstanding Amounts’ button has been clicked the display changes as illustrated 
below. Note that the button now reads ‘Show All Transactions’. The ‘Add Receipts’ and the ‘Auto 
Allocate’ icons are enabled. 
 

 
 

6.9.2 Show All Transactions 

 
To revert to the previous screen display click on ‘Show All Transactions’. 
 
 

6.9.3 Filter Billing Items 

 
 
The filter icon can be used to filter the billing items according to certain criteria. When this icon is 
selected the following screen is displayed: 
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One or more options may be selected to search against using the tick boxes. Search criteria (such 
as =, <, >, <>) can be selected by clicking on the ‘=’ sign. A value can be selected from the drop 
down list (or the balance can be entered). 
 
Any number of billing codes may be selected from the billing code list. Combinations of selections 
can be treated either as a logical AND or logical OR by using the radio buttons. 
 
Once a selection has been made in the above window and the OK button is clicked, all billing items 
meeting the selection criteria are highlighted in the window. 
 

6.9.4 Print Selected 

 
 
This option can be used to print items which have been selected (highlighted) in the batch billing 
items window. The items will be printed in the format illustrated below: 
 

 
 
 

6.10 Add Receipts 

 
This option provides the facility to receipt money against unpaid billing items in the displayed 
batch. This is useful if a group of students are all paying the same amount for the same billing item 
(e.g. a group of students all paying $150 for the camp). 
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6.10.1 To add receipts to batch billing items 

 

 Click on Billing Items 

 Double-click on the required batch 

 Click on the Batch Billing Items tab 

 Click on the Show Outstanding Amounts button 

 Highlight all the items to be paid 

 Click on the Add Receipts button  

 The following screen appears: 
 

 
 

 Enter the receipts batch to hold the receipts (or press <tab> for a list) 

 The date defaults to today’s date (this can be changed if required) 

 Enter the total amount to be receipted for all selected students (this must match the 

selected total displayed below) 

 Enter the payment type (or press <tab> for a list) 

 Enter the comment (this will appear on the receipt) 

 Click on OK 

 The following message is then displayed: 
 

 
 

 Select Yes to print receipts now, otherwise select No. 

 

Note: If selecting to print receipts the option of ‘Receipts’ or ‘Record of Receipt Allocations’ 

is given. Refer to section 4.20.10 on page 4-71 for further details on printing receipts. 

 
 

6.11 Bulk Reversal of Billing Items 

 
 
This option provides the facility to reverse multiple billing items in the selected batch in one 
operation. This is useful if an error has been made in bulk billing students and a series of billing 
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items have been created and added to this batch in error. Using the bulk reversal facility provides a 
quick way of correcting the error without having to reverse each item individually.  
 

6.11.1 To reverse a group of billing items 

 

 Click on Billing Items 

 Double-click on the required batch 

 Click on the Batch Billing Items tab 

 Click on Show Outstanding Amounts (optional, but useful because it restricts the display 

of  ineligible items) 

 Highlight all the items to be reversed (note that some restrictions apply – see following 
section) 

 Click on the Reversal icon   

 The following message is displayed 
 

 
 

 Click Yes 

 The following window appears 
 

 
 

 Enter a reason for the reversals (this reason will be applied to all reversals) 

 Click OK 

 The selected items will be reversed 
 

6.11.2 Restrictions on Reversals 

The following items cannot be reversed. 
 

 Items which have already been reversed (e.g. status of ‘R’). 

 Items which have been created as a result of a reversal (e.g. status of ‘V’). 

 Items which have been adjusted (e.g. status of ‘A’). 

 Items which have been created as a result of an adjustment (e.g. status of ‘T’). 

 Items which have a discount applied 
 

If any of the above items are selected for reversal the following message will be displayed. 
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6.12 Bulk Discount 

 
 
This option provides the facility to discount multiple billing items in this batch in one operation. This 
is useful if a group of students are all being granted a discount for the same billing item; for 
example, all students are to receive a 5% discount on an excursion cost. 
 
This button also provides the facility to remove a discount already applied to a group of items. 
 

6.12.1 To add a discount to a group of billing items 

 

 Click on Billing Items 

 Double-click on the required batch 

 Click on the Batch Billing Items tab 

 Click on Show Outstanding Amounts (optional, but useful because it restricts the display 

of  ineligible items) 

 Highlight all the items to be discounted (note that some restrictions apply – see following 

section) 

 Click on the Discount icon   

 If all the selected items are eligible for discount then the following screen is displayed 
 

 
 

 Enter the discount percentage (between 0 and 100) 

 Enter a reason for the discount (this reason will be applied to all discounts) 

 Click OK 

 If the discount percentage can be applied to all the selected items, then the items are 
discounted 

 

6.12.2 Restrictions on Discounts 

The following items cannot be discounted. 
 

 Items which have been reversed (e.g. status of ‘R’). 

 Items which have been created as a result of a reversal (e.g. status of ‘V’). 

 Items which have been adjusted (e.g. status of ‘A’). 
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 Items which have been created as a result of an adjustment (e.g. status of ‘T’). 

 Items which have a discount applied 

 Items which are fully paid 
 
If any of the above items are selected for discount the following message will be displayed. 
 

 
 

Note: A part paid item can have a discount applied but the discount amount must be less 

than or equal to the balance owing on the item. 

 
Once the discount percentage has been entered, the system will check whether all of the selected 
items have less than the discount amount owing. If this is not the case, the following message will 
appear. 
 

 
 

Note: If some of the selected items have a discount applied and some do not, then the 
following message will be displayed. 

 

 
 

6.12.3 To remove a discount from a group of billing items 

 

 Click on Billing Items 

 Double-click on the required batch 

 Click on the Batch Billing Items tab 

 Click on Show Outstanding Amounts (optional, but useful because it restricts the display 

of  ineligible items) 
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 Highlight all the items from which the discount is to be removed (note that only items which 

already have a discount applied should be selected) 

 Click on the Discount icon   

 If all the selected items have a discount applied the following message will be displayed 
 

 
 

 Click on Yes to remove the discount from the selected items 

 

6.13 Automatic Allocation of Credit 

 
 
This option provides the facility to automatically allocate unallocated credit to selected billing items 
for a group of students in one operation.  
 
 

6.13.1 To automatically allocate credit to selected billing items 

 

 Click on Billing Items 

 Double-click on the required batch 

 Click on the Batch Billing Items tab 

 Click on Show Outstanding Amounts (mandatory – this causes the Auto Allocate icon to 

become active) 

 Highlight all the billing items to which unallocated credit is to be allocated (note that all 
selected items must have an outstanding balance) 

 Click on the Auto Allocate icon   

 If all the selected items are eligible for credit to be allocated to them then the following 
message is displayed 
 

 
 

 Click on Yes to continue 

 The system will work though the list of selected billing items for each student and allocate 
any available credit to these items (according to specific rules – see following section) 
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 If the system has allocated any unallocated credit during this process then the following 
message will be displayed 

 

 
 

 Check the printer and click OK when it is ready to print (note that this is the only time that 

this report can be printed – it is not available once this process has ended) 

 A report on the allocations made by the process will then be sent to the default printer in the 
format illustrated below 

 The following message will then be displayed 
 

 
 

 Click Yes if the report has printed OK, or No to print the report again 

 

 

6.13.2 Rules for allocating unallocated credit 

The following rules are used by the system when allocating unallocated credit. 
 
Any unallocated credit belonging to receipts of type GV (Government Subsidies) for the student will 
be allocated first, before receipts of any other payment type. Unallocated credit of type GV will be 
allocated to the selected billing items according to the billing category attached to each item. The 
following table shows the order in which GV credit will be applied to the selected billing items. Note 
that if there are no selected items which belong to a particular category than that category will be 
skipped. The oldest items within each category will be allocated first. 
 

Order of Priority for 
allocating GV receipts 

Billing Category 

1 Adult Student Fees 

2 Temporary Visa Overseas Students 

3 Voluntary Contributions 

4 Charges 

5 Residential Boarding Fees 

6 Other Optional Coasts 

7 Voluntary Approved Requests 
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Note that billing items in the category of ‘Not Applicable’ will be excluded from this allocation 
process. 
 
If there is more than one GV receipt for the student which contains unallocated credit then the 
oldest GV receipt will be allocated first, followed by any other GV receipts in transaction reference 
number order. 
 
Once all GV credit has been allocated (if possible), unallocated credit from receipts of other 
payment types for the student will be applied. The order in which non-GV credit will be allocated is 
shown in the following table. 
 

Order of Priority for 
allocating non-GV 

receipts 
Billing Category 

1 Adult Student Fees 

2 Temporary Visa Overseas Students 

3 Charges 

4 Residential Boarding Fees 

5 Voluntary Contributions 

6 Other Optional Coasts 

7 Voluntary Approved Requests 

8 Not Applicable 

 
Note that billing items in the category of ‘Not Applicable’ will be included in this allocation process 
for non-GV receipts. 
 
If there is more than one non-GV receipt for the student which contains unallocated credit then the 
oldest non-GV receipt will be allocated first, followed by any other non-GV receipts in transaction 
reference number order. 
 
 

6.13.3 Error messages which may be displayed during the Auto Allocate process 

 

 If some of the selected billing items are fully paid then the following message will be 
displayed. 

 

 
 

 If none of the selected students have any unallocated credit to apply, or the credit exists in 
GV type receipts and only ‘Not Applicable’ items have been selected, the following 
message will be displayed. 
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6.13.4 Sample report produced by the Auto Allocate process 

 
A sample report produced by the Auto Allocate process appears below. 
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Note: If a re-print of this report is required it is available from Reports > Transactional 
Reports > Re-Print Auto Allocate Transactions. See section 8.7.11 on page 8-46 for further 
details. 

 

6.14  Batch Billing Items tab – Print button 

If the print button is selected immediately after adding receipts (as outlined above), without 
switching tabs or exiting the screen etc, then the following message is displayed: 
 

 
 
If Yes is selected then the receipts just added via the ‘Add Receipts’ process will be printed. 
 
If No is selected then all billing items listed on the screen will be printed. (See section 6.9.4 above 

for the sample report layout.) 
 
If Cancel is selected then nothing is printed. 

 
If the Add Receipts process has not just been used then clicking on the Print button will produce a 
listing of all displayed billing items. (See section 6.9.4 above for the sample report layout.)  
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7 Receipts 
 
The Receipts section allows the operator to create, view and manipulate Receipts Batches – 
batches to hold receipts from students/parents and customers. 
When the Receipts icon is selected on the RM Billing sidebar the Receipts window will open as 
illustrated below: 
 

 
 
Initially there will be no receipt batches in the datafile. These will need to be created by the 
operator.  
 
Once receipt batches have been created, they will be displayed in this window in batch number 
order with the open batches preceding the closed batches. 
 
The following columns are displayed on the Receipts window: 
 
Batch No 

The batch number is generated by the system when a new batch is created. The receipts batch 
number commences with ‘B’ followed by a unique sequential number beginning at ‘1’ and padded 
with zeroes to a length of 5 digits e.g. B00001. 
 
Year 

The year tied to the receipts batch. This is the current billing year at the time the batch is created. 
 
Description 

The description of the receipts batch. This is entered by the operator when the batch is created.  
  
Open 

If the Receipts batch is open the word ‘YES’ will appear in this column. Otherwise the word ‘NO’ 
will be displayed. 
 
Last Updated 
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The date and time that the batch was last updated. 
 
Batch Total 
The total of all the receipts held in the batch. 
 

7.1 Year Drop Down List 

 

 
 
The Year Drop Down List displays all years present in the datafile along with an additional ‘All 
Years’ option.  Selecting a particular year from the list will enable receipt batches for that year to be 
displayed. If the ‘All Years’ option is selected then all receipt batches across all years will be 
displayed. 
 

7.2 To Sort the List of Receipts Batches 

The batch list can be sorted by clicking on any of the list headings.  
 
For example, to sort the list in order of balances, click on the Batch Total heading. The list is 

sorted with the batch totals in ascending order. 
 
To sort the list in reverse order, click on the Batch Total heading again. The list is now sorted with 

the batch totals in descending order. 
 

7.3 Quick Search on Batch No 

 
A quick search on Batch No is available on this window. For example, if you click on the first batch 
in the list and then type all or part of the batch number, the cursor will move to the first batch 
beginning with the number/s entered.  
 

7.4 Receipts Icons 

The following icons are available on the Receipts Batches List screen. 
  

 Load All – Displays all batches for the selected year   

 Open Details – Opens the drill down facility for the selected batch 

 Print – Prints a list of all batches displayed in the list view 

 Print Selected – Prints a list of all selected (highlighted) batches in the list view 

 Hide Selected – Hides all selected batches 

 Hide Unselected – Hides all unselected batches 

 Add Item – Allows a new batch to be created 

 Edit Item – Allows the selected batch to be edited (some restrictions apply) 
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 Delete Item – Allows the selected batch to be deleted (some restrictions apply) 
 

7.5 Drill Down Facility 

Drill down functionality is instigated by double-clicking on a batch, highlighting the batch and 
pressing <enter> or highlighting a batch and using the Open Details icon. The Receipts Batch 

Details tab will now be displayed.  

7.6 To Create a Receipts Batch 

 Click on Receipts 

 Click on the Add pencil  

 The following window appears: 
 

 
 

 Enter a description for the batch  

 Click on the OK to save 

 
 

7.7 To Edit a Receipts Batch 

 Click on Receipts 

 Highlight the batch to be edited 

 Click on the Edit pencil  

 The following screen appears: 
 

 
 

 Edit the batch description as required 

 Click on OK to save 

7.8 To Delete a Receipts Batch 

 Click on Receipts 

 Highlight the batch to be deleted 
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 Click on the Delete button  

 The following message appears: 
 

 
 

 Click on Yes 

 The batch is deleted 
 

Note: Batches which contain transactions cannot be deleted. The following error message 

will be displayed if an attempt is made to delete a batch containing transactions: 

 

 

7.9 For Selected Menu 

The For Selected menu contains the following options: 
 

 
 

7.9.1 Print Receipts 

This option allows receipts or records of receipt allocations to be printed for the selected batch(es).   

7.9.1.1  To print receipts for selected batches 

 Click on Receipts 

 Highlight the batch for which receipts are to be printed (multiple batches may be selected) 

 Click on For Selected 

 Choose Print Receipts 

 The following window appears: 
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 Make the required selection 

 Click on OK 

 

Note: Refer to section 4.20.10 on page 4-71 for further information on receipt printing. 

7.9.2 Print Daily Banking 

This option allows a report to be printed for the selected batches to assist with reconciling the daily 
banking totals. 
 

7.9.2.1  To print the daily banking summary 

 

 Click on Receipts 

 Highlight the batch(es) for which the summary is to be printed (multiple batches may be 

selected) 

 Click on For Selected 

 Choose Print Daily Banking 

 Select the report destination 

 The daily banking summary is printed in the format illustrated below 
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7.9.3 Print Receipts Summary 

This option allows a report to be printed which classifies the receipts in the batch.  The report will 
group the transactions by budget, analysis and GST code. This report is useful for manually 
transferring data to RM Finance. 
 

7.9.3.1  To print the receipts summary 

 

 Click on Receipts 

 Highlight the batch(es) for which the summary is to be printed (multiple batches may be 

selected) 

 Click on For Selected 

 Choose Print Receipts Summary 

 Select the report destination 

 The following message is displayed: 
 

 
 

 Select Yes for the detailed version or No for the totals only version 

 The receipts summary is printed in the format illustrated below: 
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Receipts Summary Report – Detailed Version  
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Receipts Summary Report – Totals Only Version  

 

 

 
 
 
 

7.9.4 GST Summary 

This option allows a report to be printed which classifies the transactions by GST code.   

7.9.4.1  To print the GST summary 

 

 Click on Receipts 

 Highlight the batch(es) for which the summary is to be printed (multiple batches may be 

selected) 

 Click on For Selected 

 Choose GST Summary 

 Select the report destination 

 The following message is displayed: 
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 Enter the required date range 

 Click on OK 

 The report is printed in the format illustrated below: 
 

 
 
 
 

7.9.5 Close Batch 

This option allows a receipts batch to be closed. Once closed no further receipts can be input into 
the batch.  The Close Batch process will operate slightly differently depending on whether or not 
the ‘Enable Export to RM Finance’ tick box (in Billing Parameters) is checked. 

7.9.5.1  To close a receipts batch (exporting) 

 
If the ‘Enable Export to RM Finance’ option is ticked the Close Batch process will operate as 
follows. 
 

 Click on Receipts 

 Highlight the batch(es) to be closed (multiple batches may be selected) 

 Click on For Selected 
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 Choose Close Batch 

 The following message is displayed: 
 

 
 

 Click on Yes 

 The batch is closed 
 

7.9.5.2  To close a receipts batch (not exporting) 

 
If the ‘Enable Export to RM Finance’ option is not ticked the Close Batch process will operate as 

follows: 
 

 Click on Receipts 

 Highlight the batch(es) to be closed (multiple batches may be selected) 

 Click on For Selected 

 Choose Close Batch 

 The following message is displayed: 

  

 
 

 Click on Yes 

 The Print Setup screen appears as illustrated below: 
 

 
 

 Adjust any settings as required 

 Click on OK 

 The following message appears: 
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 Select Yes for the detailed summary or No for the Totals Only version 

 The Receipts Summary report is printed to the printer (this is used to input the 

transactions manually into RM Finance) 

 Go to the printer and check the report has printed correctly 

 The following message is then displayed: 
 

 
 

 If the report has not printed successfully select No and restart this process from the 

beginning. The batch will not be closed and the transactions will not be marked as posted.  
In this case the following warning message will be displayed: 

 

 
 

 If the report has printed successfully select Yes. The batch is closed and all transactions 

are marked as posted. 
 
 

7.10  Receipts Details View 

The Receipts Details view can be displayed in three ways: 
 
Either 

Click on a batch and then select the Open Details icon  
or 
Double-click on the required batch 
or 
Highlight the required batch and press <enter> 

 
The Receipts Details view will then be displayed as illustrated below: 
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7.10.1 Toolbar – Receipts Details View 

The toolbar on the Receipts Details View appears as shown below: 
 

 
 
  

7.10.1.1  Print Button 

 
 
The functionality of this button differs slightly depending on which tab pane is selected. See each 
individual section for more details. 
 

7.10.1.2  Return to View 

 
 
Clicking once on this icon will display the Receipts Batches List View (front screen).  
 

7.10.2  Red Fields 

 
 
The red fields of Batch Number and Description are scroll fields. Clicking on the red Batch Number 
will display the next batch in the list. <Shift> clicking will scroll through the batches in reverse order.   
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To find a particular batch perform a right mouse click in a red field. Enter the batch or part thereof 
and press <enter> and the first or closest match will be displayed. 
 

7.10.3  Details tab 

The Details tab displays the following information: 
 
Batch No 

The batch number is generated by the system when a new batch is created. The receipts batch 
number commences with ‘B’ followed by a unique sequential number beginning at ‘1’ and padded 
with zeroes to a length of 5 digits e.g. B00001. 
 
Year 

The year tied to the receipts batch. This is the current billing year at the time the batch is created. 
 
Description 

The description of the receipts batch. This is entered by the operator when the batch is created.  
 
Batch Total 

The total of all the receipts held in the batch. 
  
Open 

If the Receipts batch is open the word ‘YES’ will appear in this column. Otherwise the word ‘NO’ 
will be displayed. 
 
Date Created 

The date and time that the batch was created. 
 
Date Updated 

The date and time that the batch was last updated. 
 
 

 

7.10.3.1  Details tab – Print button 

 
If the print button is selected whilst on the Details tab, the following message is displayed: 
 

 
 
 
 

7.10.4  Batch Receipts tab 

This window will display all receipts which are held in the selected batch in the format illustrated 
below: 
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If a receipt is highlighted in the top window, the billing items to which the receipt is allocated are 
displayed in the lower window. 
 
The following information is displayed for each receipt:  
 
Ref 

The transaction reference number of the receipt. This is a unique sequential number assigned by 
the system to every transaction when it is created. 
 
Rec # 

The actual receipt number assigned to the receipt. This is a unique sequential number assigned by 
the system to receipt related transaction only. 
 
Date 

The date the transaction was created. 
 
Type 

The transaction/payment type. For a receipt this could be any valid payment type (from Parameters 
> Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
Amount 

The amount of the receipt. 
 
Student/Cust 

The name of the student or the customer name attached to the receipt. 
 
Comment 

The comment attached to the receipt. This will be the comment input by the operator when the 
receipt is entered. 
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Status 

This column will show the status of a receipt that has been reversed or refunded. The status could 
be blank (not reversed or refunded) or one of the following: 
 
R Transaction which has been reversed 
V Transaction created as the result of a reversal 
F Transaction which has been refunded 
D Transaction created as the result of a refund 
 
The transaction reference number of the related transaction will appear after the status character. 
 
Reason 

If a transaction has been modified in some way (i.e. reversed or refunded) then the reason field will 
begin with standard system-generated text followed by the reason entered by the operator. 
 

7.10.4.1 Batch Receipts tab – Print button 

 
If no receipts have been highlighted in the window and the print button is selected whilst on the 
Batch Receipts tab, a listing of all receipts in the batch is produced in the format illustrated below: 
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If one or more receipts have been highlighted in the window and the print button is selected whilst 
on the Batch Receipts tab, the following message is displayed: 
 

 
 
If Yes is selected then individual receipts (or record of receipt allocations) are printed for the 

selected receipts. 
 
If No is selected then the summary report listing all receipts in the batch (as shown above) is 

printed. 
 

7.10.5  Bulk Receipts tab 

The bulk receipts tab allows a group of receipts to be input in a list format, one after the other, 
without the need to access every individual student record. This method is useful when inputting a 
group of receipts which are mixed in nature – for example, different students paying different 
amounts for different items. 
 
The Bulk Receipts tab is displayed as shown below: 
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7.10.5.1 To enter bulk receipts 

 

 Click on Receipts 

 Double-click on the batch to hold the receipts 

 Click on the Bulk Receipts tab 

 Click on the Add button on the right hand side  

 Enter the student’s surname (or part thereof) in the Student Name field and press <tab> 

to select the student from a list 

 The year group of the student is automatically displayed 

 Enter the amount of the receipt and press <tab> 

 Press <tab> in the items field 

 Highlight the items to be paid, click on OK and press <tab> 

 Enter a comment 

 Press <tab> to move to the next line 

 Repeat this process for the next student 

 Once all receipts have been entered, click on OK to save 

   
 

An example of the Bulk Receipts window showing data entered is displayed below: 
 

 
 

Note: If  a blank line is accidentally created, a right mouse click can be performed on the 

blank line. The Remove Line option will then be displayed.     
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IMPORTANT  

The receipts are not saved until the OK button at the bottom of the 
screen is clicked. It is therefore recommended that shorter lists are 

entered and saved regularly to minimise loss of data in the event of a 
power failure etc. 

 

7.10.5.2 Applying Individual Government Subsidies 

An individual Government Subsidy can be applied to a student by using the method outlined above 
(Receipts > Bulk Receipts). 
 

7.10.5.2.1 To apply the subsidy: 

 

 Choose the correct Government Subsidy receipts batch. 

 Follow the method listed above but enter the payment type as GV.  

 Also enter the correct comment for the subsidy. 

 

7.10.5.3 Bulk Receipts tab – Print button 

 
If a list of receipts have been entered in bulk and saved and the receipts are still displayed on the 
screen, the print button can be used to print receipts (or record of receipt allocations) for the 
entered data. 
 
Once the entered data has been cleared from the screen (by exiting the screen or switching tabs), 
receipts cannot be printed and the following message is displayed if the print button is selected. 
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8 Reports 
The Reports section contains a variety of standard reports.  
 
When the Reports icon is selected on the RM Billing sidebar the Reports window will open as 
illustrated below: 
 

 
 

8.1 Charges and Contributions Templates 

Initially the Charges and Contributions Templates folder will be empty and the yellow folder will not 
appear in the reports list view (only the name will be displayed). Charges and Contributions 
templates need to be created by the operator. 
 
In RM Billing, Charges and Contributions sheets are created based on a template. The sheets are 
not based on actual billing items. Therefore they can be created before any billing has occurred 
within the system. 
 
Subject information which needs to appear on the Charges and Contributions sheet is taken from 
the Primary Preferences held for each student in the Timetabling module (if being used) along with 
the subject costs entered in RM Billing for those subjects. This information will automatically 
appear on the Charges and Contributions sheet for each student (unless the code NA is used in 
the RM Billing subject table). 
 
Other information (such as Other Optional Costs, Government Subsidies etc.) which needs to be 
displayed on the Charges and Contributions sheet is entered manually by the operator into a 
template. 
 

8.1.1 To Create a Charges and Contributions Sheet Template 

 Click on Reports 

 With Charges and Contributions Templates highlighted on the left hand side, click on 
the Template Manager button on the right hand side 
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 The following screen opens: 
 

 
 

 Click on the Add pencil (red pencil) to create a new template 

 The template screen is displayed as shown below: 
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 Enter the name for the template (e.g. Year 11). Note that the first part of the name is 
already created (‘2008 Charges and Contributions’). The descriptor entered will be added to 
the end of the standard text.  

 

 Select a Year (if necessary) from the drop down year list. (Only the current or future years 
can be selected). 

 

8.1.2  To enter the required costs 

All required charges and contributions can be entered on the appropriate tab. For example, Other 
Optional Costs can be entered on the Other Optional Costs tab. Any costs entered in each section 
will appear under that heading on the Charges and Contributions sheet.  
 
The Subject information does not need to be entered as this will be picked up automatically from 
the student’s Primary Preferences in Timetabling (if being used). 
 
An example of entering data for the Other Optional Costs section is given below. 
 

 Click on the Other Optional Costs tab 

 Click on the Add button on the right hand side  

 Type in the Other Optional Costs (example below). Each item needs a description, a GST 
code (press <tab> for the list) and an amount. 

 Pressing the <tab> key after entering the amount will cause an additional blank line to be 
created so that multiple lines of data can be entered if required. 
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Note: If an additional blank line is accidentally created it can be removed by performing a 

right mouse click on the blank line. The option to remove the line will then be displayed. 

 

Note: Data can be entered on any tab in a similar manner. 

 

8.1.3  To enter a Government Subsidy 

 
One or more Government Subsidies can be entered on the Government Subsidies tab. The order 
in which the subsidies are entered is the order in which they will be displayed on the Charges and 
Contributions sheet. 
 

 Click on the Government Subsidies tab 

 Click on the Add button on the right hand side  

 Type in the Government Subsidies (example given below) 
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8.1.4  To enter the footer message (optional) 

 

A standard message can be displayed at the bottom of each Charges and Contributions Sheet if 
required. This message should be entered into the ‘Footer Message’ section of the template. An 
example is shown below: 
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Note: The footer message can be entered no matter which tab is currently selected. 

 

8.1.5  To save the template 

None of the entered data will be saved until the ‘Save’ button is clicked. 
 

 Click on  to save the template 

 The newly created template now appears in the list (example shown below) 
 
 

 
 
 

8.1.6 To Edit a Charges and Contributions Sheet Template 

Charges and Contributions Sheet Templates can be edited and saved with either the same name 
(which replaces the original template) or a different name (which leaves the original untouched and 
creates a new template). 
 

 Click on Reports 

 With Charges and Contributions Templates highlighted on the left hand side, click on 
the Template Manager button on the right hand side 

 The list of templates is displayed as illustrated below: 
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 Highlight the template to be edited 

 Click on the edit pencil   

 Make any required changes 

 Click on Save 

 If the name and/or year of the template has not been changed the following message will 
be displayed: 

 

 
 

 Click on Yes to overwrite the existing template or No to have the chance to rename the 

template 

 If the name and/or year of the template has been changed, the new template will be saved 
with the new name (no warning message will be displayed) 

 

8.1.7 To Delete a Charges and Contributions Sheet Template 

Charges and Contributions Sheet Templates can be deleted as required. There are no restrictions 
on deleting these templates.  
 

 Click on Reports 

 With Charges and Contributions Templates highlighted on the left hand side, click on 
the Template Manager button on the right hand side 

 The list of templates is displayed as illustrated below: 
 

 
 

 Highlight the template to be deleted 

 Click on the delete button  

 The following message is displayed: 
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 Click on Yes to delete the template 
 

8.1.8 To Print Charges and Contributions Sheets 

 

 Click on Reports 

 Click on the Charges and Contributions templates folder on the left hand side to display 

the reports which have been created 

 The list of reports is displayed as illustrated below: 
 

 
 

 Highlight the report to be printed 

 The window now appears as shown: 
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 The Page Footer section contains the default message (as entered in the chosen template). 
This can be edited at this stage if required, but any changes will be used for this print run 
only and will not be saved to the template. 

 Click on the New Query button 

 Use the find tool to select all required students 

 Select either the current or proposed year/form. (The proposed year/form can be used 

when printing sheets in advance for next year. Note that this information must be set up in 
the Administration module before it can be used in RM Billing.) 

 Click on the Print button 

 Select the report destination  

 The reports are printed to the selected destination for the selected students 
 
A sample Charges and Contributions report appears below: 
 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 8-10 

© 2016 Civica Education Pty Ltd 
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Note: The layout of the above report can be varied slightly by altering the parameter 
settings for the Charges and Contributions sheet.  See section 3.4.2 on page 3-9 for more 
details 

 

Note: Charges and Contributions sheets can also be printed from the Students section. See 

section 4.3 on page 4-6 for further details. 

 

IMPORTANT  

If a student’s preferences are changed in the Timetabling module then 
the subject information printed on the Charges and Contributions sheet 

will automatically change the next time a sheet is printed. 

 

8.2 Charges and Contributions Reports 

The Charges and Contributions Reports folder contains the following reports. 
 

 
 

8.2.1 Charges and Contributions by Department (Timetabling Only) 

This report calculates and displays how much is due to be paid in Charges and Voluntary 
Contributions amounts per subject per department for a selected year. The report is based on the 
number of enrolled students per subject for the selected year (taken from Timetabling) and the 
Charges and Voluntary Contributions amounts listed against the subjects for the selected year in 
RM Billing > Parameters > Subjects. 
 

Note: This report will not be visible in the list if the Timetabling module is not installed. 

 

8.2.2 To print the Charges and Contributions by Department report 

 

 Click on Reports 

 Click on the Charges and Contributions Reports folder 

 Highlight Charges and Contributions by Department 

 The window appears as shown below: 
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 Select the required year for the report – past, present and future years are available for 

selection 

 If each Department should start on a new page tick the box for New Page per Department 

 A range of departments can be selected by using the From Department…To Department 

drop down lists 

 A percentage of the total (e.g. 80%) can be entered in the ‘Include Percentage of Total’ 

box. This will display the entered percentage of the total along with the overall total. 

 Click on the New Query button to select the students to be included in the report 

 A report message (to be displayed at the bottom of the report) can be entered if required. 

This message is saved and can be used next time the report is run. 

 Click on Print 

 Select the report destination 
 

A portion of a sample report is displayed below: 
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The columns on the report have the following meanings: 
 
Subject Name 

The name of the subject. Only timetabled subjects for the selected year will be displayed. 
 
Code 

The subject code. 
 
Students 

The number of students that are enrolled in the subject for the selected year. This information is 
taken from the Timetabling module. 
 
Contributions 

The voluntary contributions amount entered for the subject in the RM Billing > Parameters > 
Subjects table for the selected year. 
 
Charges 

The charges amount entered for the subject in the RM Billing > Parameters > Subjects table for the 
selected year. 
 
Totals for Contributions 
The contributions amount multiplied by the number of students. 
 
Totals for Charges 

The charges amount multiplied by the number of students. 
 
Total 

The contributions total plus the charges total. 
 

8.2.3 Outstanding Amounts by Category 

The Outstanding Amounts by Category report summarises outstanding amounts per student, 
broken into Voluntary Contributions, Charges and all other categories. Unpaid billing items for the 
student for the selected year are used to create the report. 
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8.2.4  To print the Outstanding Amounts by Category report 

 

 Click on Reports 

 Click on the Charges and Contributions Reports folder 

 Highlight Outstanding Amounts by Category 

 The window appears as shown below: 
 

 
 

 Select the year for the report 

 Click on the New Query button to select the students for the report 

 Select a Student Billing Category (optional) if required. If all categories are required N/S 

(Not Specified) should be used. 

 Select the required sort 

 If New Page with Subtotals is ticked then each subtotalled group (sort) will begin on a new 
page 

 Click on Print 

 Select the report destination 
 
A portion of a sample report appears below: 
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The columns on the report have the following meanings: 
 
Student Name 
The name of the student. 
 
Year 
The current year group of the student. 
 
Form 
The current form group of the student. 
 
Student Category 

The student billing category for the student for the selected year. 
 
Debtor 

The title, initial and surname of the current fees biller for the student. 
 
Previous Years 

The sum of all unpaid billing items for the student for all previous years (prior to the selected year). 
 
Charges 

The sum of all unpaid billing items which belong to the category of ‘Charges’ for the student for the 
selected year. 
 
Vol Cont 

The sum of all unpaid billing items which belong to the category of ‘Voluntary Contributions’ for the 
student for the selected year. 
 
All Other 

The sum of all unpaid billing items which belong to all other categories (other than ‘Charges and 
‘Voluntary Contributions’) for the student for the selected year. 
 
Follow Years 
The sum of all unpaid billing items for the student for all years after the selected year. 
 
Total 
The sum of all the outstanding balances. 
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Last Receipt 

The amount of the last receipt entered against the student. 
 
Date Last Receipt 

The date of the last receipt entered against the student. 
 

8.3 Financial Reports 

The Financial Reports folder contains the following reports: 
 

 
 

8.3.1 Statement - Students 

This report enables a current statement to be produced for one or more students. Statements are 
addressed to the current fees biller for each student. 
 

8.3.2  To print a statement for students 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Statement - Students 

 The window appears as shown below: 
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The ‘From’ date will default to the first day of the current month. All transactions from this date 

onwards will be listed on the statement. Any transactions dated prior to this date will be 
summarised in an ‘opening balance’ figure. If this is the first statement being sent to the 
parent/guardian then it is advisable to enter an earlier date so that all transactions for the 
current year are listed. 

The ‘To’ date will appear blank but will default to today’s date if left blank. Otherwise an end date 
may be entered. Transactions dated after the ‘To’ date will not be included on the statement. 

The default message entered in the Billing Parameters section will be displayed. This can be 
edited at this point if required but the changes will be used for this statement run only and will 
not be saved. 

 
Change the settings as required 
Click on the New Query button to select the students for whom statements are to be printed 
Click on Print 
Select the report destination 

Statements for the selected students are printed to the selected destination 
A sample statement appears below: 
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Type 

If the transaction is a billing item or a billing item reversal or adjustment, then the category of the 
billing item (e.g. Charges) will be displayed. 

If the transaction is a receipt or receipt reversal, then the payment type (e.g. Cash) will be 
displayed. 

If the transaction is a Government Subsidy or Government Subsidy reversal then ‘Government 
Subsidies’ will be displayed. 

If the transaction is a refund then ‘Refund’ will be displayed. 

Tx# 

The transaction reference number. 
 

Date 

The date the transaction was created. 

Inv# 

The invoice number attached to the billing item (blank for receipt transactions). 

Details 

The comment attached to the transaction. 

Amount 

The amount of the transaction.  
Billing items are displayed as positive numbers and receipts as negative numbers 
Reversals, Adjustments and Refunds are opposite in sign to the original transaction. 

Statement Summary Table 

A summary table detailing the outstanding amount per category appears on the statement.  
This will list the applicable categories in the first column and then display the amounts owing for 

each category for all previous years, the current billing year and any future years. 

Note: The layout of the Statement can be varied slightly by altering the statement 
parameters available in the Parameters > Billing Parameters section. Please refer to section 

3.4.3 on page 3-11 for further details. 
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Note: Statements with zero balances will be printed if transactions have been processed 
against the student. If no transactions have been entered for the selected student then a 
statement will not be printed. See section 4.2.5 on page 4-6 for details on how to print 

statements for outstanding debtors only. 

 

Note: Statements can also be printed from the Students section. Refer to section 4.2.3 on 

page 4-5 for further details. 

8.4 Statement - Customers 

This report enables a current statement to be produced for one or more customers.  
 

8.4.1  To print a statement for a customer 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Statement - Customers 

 The window appears as shown below: 
 

 
 
 
The From and To dates and the default message operate as outlined in the above section for 

student statements 
Change the settings as required 
Click on the Customer Find Tool (binoculars) button to select the customers for whom 

statements are to be printed 
The following window appears: 
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The top ‘Customer Name’ field is a search field. Enter the customer name or part thereof and click 

on Search. All customers meeting the search criteria will be displayed. For example, enter ‘M’ 
and click on Search to display all customer names beginning with ‘M’. Use of this field is 
optional. 

 
Highlight the customers to be selected in the main window. 
Click on Select 

The Customer Find window is closed and the number of selected customers is displayed on the 
report options screen 

Click on Print 
Select the report destination 

Statements for the selected customers are printed to the selected destination 
 

Note: Please refer to the above section 8.3.1 on page 8-16 regarding student statements for 
further details about the statement layout which is the same for customers. The summary 

table of outstanding amounts does not appear on the customer statement. 
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8.5 Unprinted Invoices – Students 

This report enables all (or a selection) of unprinted student invoices to be printed directly to the 
printer. There is no choice to print to other destinations such as screen. 
 

8.5.1  To print unprinted invoices for students 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Unprinted Invoices - Students 

 The window appears as shown below: 
 

 
 

 Click on the New Query button to select the required students 

 Click on Print 

 The following message is displayed: 
 

 
 

 Click on Yes 
 
The following default message is displayed if entered via Parameters > Billing Parameters > 
Invoice tab. The user can accept the default message or enter a new message in the window. 
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Click OK 
The following confirmation message then appears: 
 

 
 

Select ‘Yes’ if the invoices have printed OK (If not select ‘No’ and restart the process) 

The new message (if entered) is added to the invoice immediately underneath they key 
If no default message has been entered, the invoice will be sent straight to the printer  
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8.5.2 Unprinted Invoices – Customers 

This report enables all (or a selection) of unprinted customer invoices to be printed directly to the 
printer. There is no choice to print to other destinations such as screen. 
 

8.5.3  To print unprinted invoices for customers 

 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Unprinted Invoices - Customers 

 The window appears as shown below: 
 

 
 

 Click on the Customer Find Tool (binoculars) to select the required customers (see 

section 8.4.1 above for details) 

 Click on Print 

 The following message is displayed: 
 

 
 

 Click on Yes 

 The invoices are sent to the printer 

 The following confirmation message then appears: 
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 Select ‘Yes’ if the invoices have printed OK (If not select ‘No’ and restart the process) 
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8.6 Summary Aged Debt List - Students 

This report prints a summary aged debt list for students. This is a list of students with outstanding 
debt classified in the categories of current, 30 days, 60 days and 90+ days.  
 

8.6.1  To print a summary aged debt list for students 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Summary Aged Debt List - Students 

 The window appears as shown below: 
 

 
 

 Click on the New Query button to select the required students 

 Click on Print 

 Select the report destination 
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A sample report appears below: 
 

 
 
The following information is displayed on this report: 
 
Student Name 
The name of the student. 
 
Year 

The current year group of the student. 
 
Form 

The current form group of the student. 
 
Debtor 

The name of the current fees biller for the student. 
 
Current 

The total unpaid billing items for the student which are less than 30 days old. 
 
30 Days 

The total unpaid billing items for the student which are 30 or more days old but less than 60 days 
old. 
 
60 Days 

The total unpaid billing items for the student which are 60 or more days old but less than 90 days 
old. 
 
90+ Days 

The total unpaid billing items for the student which are greater than 90 days old.  
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8.6.2 Summary Aged Debt List - Customers 

This report prints a summary aged debt list for customers. This is a list of customers with 
outstanding debt classified in the categories of current, 30 days, 60 days and 90+ days.  
 

8.6.3  To print a summary aged debt list for customers 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Summary Aged Debt List - Customers 

 The window appears as shown below: 
 

 
 

 Click on the Customer Find Tool (binoculars) to select the required customers (see 

section 8.4.1 above for details) 

 Click on Print 

 Select the report destination 

 
 
A sample report appears below: 
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The following information is displayed on this report: 
 
Debtor 
The name of the customer. 
 
Current 
The total unpaid billing items for the customer which are less than 30 days old. 
 
30 Days 

The total unpaid billing items for the customer which are 30 or more days old but less than 60 days 
old. 
 
60 Days 
The total unpaid billing items for the customer which are 60 or more days old but less than 90 days 
old. 
 
90+ Days 
The total unpaid billing items for the customer which are greater than 90 days old.  
 

8.6.4 Reminder Unpaid Billing Items – Students 

This report resembles the student statement, but instead of listing all transactions it will only 
display the billing items which have not been fully paid (for the current and any past years) along 
with their outstanding balances. Any unallocated credit is not shown on this report. 
 

8.6.5  To print the Reminder of Unpaid Billing Items – Students report 

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Reminder Unpaid Billing Items - Students 

 The window appears as shown below: 
 

 
 

 Click on the New Query button to select the required students 
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 Click on Print 

 Select the report destination 

 
 

A sample report appears below: 
 
 

 
 

 

8.6.6 Unallocated Credit Listing 

This option allows a report on unallocated credit to be printed for either students or customers.   
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8.6.7  To print the unallocated credit listing  

 Click on Reports 

 Click on the Financial Reports folder 

 Highlight Unallocated Credit Listing 

 The window appears as shown below: 
 

 
 
 

8.6.8 Unallocated Credit Listing - Students 

 

 Select the Students radio button (as illustrated above) 

 Choose sort fields and totals as applicable (student name is the default sort) 

 Click on Print 

 Select the report destination 
 
A sample student report appears below: 
 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 8-32 

© 2016 Civica Education Pty Ltd 
 

  
 
Student Name, Year and Form 
The name of the student and current year and form group of the student. 
 
Balance 

The overall balance for the student. A negative balance indicates a credit. 
 
Unpaid Billing Items 

The sum of all unpaid billing items for the student/customer. 
 
Unallocated Credit 

The unallocated credit is reported in three sections. 
 GV 

 The amount of unallocated credit in GV receipts for the student. 
 Other Receipts 

 The amount of unallocated credit in non-GV receipts for the student. 
 Total 

The total amount of unallocated credit for the student (GV + non-GV credit). 
 
Asterisk (*) 

If a student has an asterisk against their name this indicates that some/all of the unallocated credit 
for that student belongs to a Government Subsidy receipt. 
 
 
 

8.6.9 Unallocated Credit Listing - Customers 

 

 Select the Customers radio button (as illustrated below) 
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 Click on Print 

 Select the report destination 

 
A sample customer report appears below – it is slightly different to the student report. 
 

 
 
 
 
The following information is shown on the customer report. 
 
Customer Name 

The name of the customer. 
 
Balance 
The overall balance for the customer. A negative balance indicates a credit. 
 
Unpaid Billing Items 
The sum of all unpaid billing items for the customer. 
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Unallocated Credit 

The amount of unallocated credit for the customer. 
 

8.7 Transactional Reports 

The Transactional Reports folder contains the following reports: 
 

 
 

Note: Print Re-allocation Transactions will not be displayed in the above list if ‘Enable 

Export to RM Finance’ is ticked in Billing Parameters. 

 

8.7.1 Transaction Summary 

The Transaction Summary report allows the operator to obtain a listing of transactions which meet 
certain criteria.  

 

8.7.2  Radio Buttons 

One of three radio buttons can be selected – Billing Items, Receipts or Both.  
 
If the ‘Billing Items’ radio button is selected then the report will display billing items only which meet 
any selected criteria. 
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If the ‘Receipts’ radio button is selected then the report will display receipts only which meet any 
selected criteria. 
 
If the radio button is set to ‘Both’ then the report will display both billing items and receipts which 
meet any selected criteria. 
 

8.7.3  Search Options – Billing Items 

The available search options for billing items are shown below. All searches are optional. All 
criteria entered will operate as a series of logical ‘ANDs’ and only billing items which match the 
criteria will be reported. 
 
If no search criteria are entered and the date selection is cleared, then the system will report on 
every single billing item transaction in the datafile. 
 

 
 
Students 

Students can be selected for the report by clicking on the New Query button. Once students have 
been selected then the ‘Group and subtotal by student’ tick box and the ‘Student totals only’ tick 
box become enabled. 
 
Group and subtotal by student 

If this box is ticked then student transactions will be grouped alphabetically by student surname 
and subtotalled. 
 
Student Totals only 

If this box is ticked then the option to ‘Group and subtotal by student’ will be ticked on 
automatically. When the ‘Student Totals only’ box is ticked only the totals for each student will be 
displayed. All transactions making up these totals will be suppressed. 
 
Customers 
Customers can be selected for the report by using the Customer Find Tool (binoculars). If both 
students and customers are selected for the report then the students will appear in one section and 
customers in another – with separate totals for each. 
 
From…To Date 
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A date range may be entered in these fields. The default dates are the first and last days of the 
previous month. Only transactions dated within the selected range are reported. 
 
From..To Ref 

A range of transaction reference numbers may be entered in these fields. 
 
Billing Codes tab 

The list of all available billing codes (except SUS) is displayed here. One or more billing codes may 
be selected. 
 
Billing Options tab 

The ‘Billing Options’ tab appears as shown below. This provides the following additional search 
criteria: 
 

 
 
Billing Item Batch 

Type an asterisk (*) in this field to display the list of available billing items batches. One batch may 
be selected from this list. 
 
Show discounted billing items only 
Tick this box on to only show billing items which have been discounted. 
 
Billing Item Balance 
Click on the equals sign (=) to display the logical operators. Billing item balances meeting different 
criteria may be searched for. 
 
Other tab 
The ‘Other’ tab appears as shown below. This provides the following additional search criteria. 
 

 
 
Corrections 

The following options are available. 
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No Search 

All transactions are available for reporting. 
 
Original Tx 
Transactions created as the result of a reversal, adjustment or refund will not be available for 
reporting. Original transactions only will be displayed. 
 
Adjustments/Reversals/Refunds 
Only transactions which have been created as the result of an adjustment, reversal or refund will 
be available for reporting. 
 
Adjustments/Reversals/Refunds with Original Tx 
Transactions which have been created as the result of an adjustment, reversal or refund, together 
with their original transactions will be available for reporting. 
 
Reason Containing 

Text may be entered into this field. The system will search the reason field of each transaction and 
only transactions where the reason contains the entered text will be reported. The search is not 
case sensitive. 
 
 

8.7.4  Search Options – Receipts 

The available search options for receipts are shown below. All searches are optional. All criteria 
entered will operate as a series of logical ‘ANDs’ and only receipts which match the criteria will be 
reported. 
 
If no search criteria are entered and the date selection is cleared, then the system will report on 
every single receipt transaction in the datafile. 
 

 
 
Students 

Students can be selected for the report by clicking on the New Query button. Once students have 
been selected then the ‘Group and subtotal by student’ tick box and the ‘Student totals only’ tick 
box become enabled. 
 
Group and subtotal by student 
If this box is ticked then student transactions will be grouped alphabetically by student surname 
and subtotalled. 
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Student Totals only 

If this box is ticked then the option to ‘Group and subtotal by student’ will be ticked on 
automatically. When the ‘Student Totals only’ box is ticked only the totals for each student will be 
displayed. All transactions making up these totals will be suppressed. 
 
Customers 

Customers can be selected for the report by using the Customer Find Tool (binoculars). If both 
students and customers are selected for the report then the students will appear in one section and 
customers in another – with separate totals for each. 
 
From…To Date 

A date range may be entered in these fields. The default dates are the first and last days of the 
previous month. Only transactions dated within the selected range are reported. 
 
From..To Ref 

A range of transaction reference numbers may be entered in these fields. 
 
Receipt Options tab 

The ‘Receipt Options’ tab appears as shown below. This provides the following additional search 
criteria: 
 

 
 
Payment Type 

Type an asterisk (*) in this field to display the list of valid payment types. One payment type can be 
selected from this list (or leave the field blank for all payment types). 
 
From…To Batch # 

A range of receipt batch numbers may be entered in these fields. 
 
From…To Rec # 

A range of receipt numbers may be entered in these fields. 
 
Other tab 

The ‘Other’ tab appears as shown below. This provides the following additional search criteria. 
 

 
 
Corrections 
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The following options are available: 
 

 
 
No Search 
All transactions are available for reporting. 
 
Original Tx 
Transactions created as the result of a reversal, adjustment or refund will not be available for 
reporting. Original transactions only will be displayed. 
 
Adjustments/Reversals/Refunds 
Only transactions which have been created as the result of an adjustment, reversal or refund will 
be available for reporting. 
 
Adjustments/Reversals/Refunds with Original Tx 
Transactions which have been created as the result of an adjustment, reversal or refund, together 
with their original transactions will be available for reporting. 
 
Reason Containing 
Text may be entered into this field. The system will search the reason field of each transaction and 
only transactions where the reason contains the entered text will be reported. The search is not 
case sensitive. 
 

8.7.5  Search Options – Both 

The available search options for both billing items and receipts are shown below. All searches are 
optional. All criteria entered will operate as a series of logical ‘ANDs’ and only transactions which 
match the criteria will be reported. 
 
Please refer to the previous sections on search options for billing items and receipts for a 
description of the criteria shown below: 
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8.7.6  To print the transaction summary report  

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Transaction Summary 

 The window appears as shown below: 
 

 
 
 

 Set any required search criteria 

 Click on Print 

 Select the report destination 
 

A sample report appears below: 
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Note: The search criteria entered will be displayed in the top left hand section of the report 

header. 

 
The following information is displayed on this report: 
 
Ref 

The transaction reference number. 
 
Date 

The date the transaction was created. 
 
Rec # 

The receipt number of the transaction (displayed for receipt transactions only). 
 
Type 

The transaction type/payment type.  
 
For a receipt this could be any valid payment type (from Parameters > Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
For a billing item this could be one of the following: 
 
DR Debit (normal billing item) 
RV Reversal 
AD Adjustment 
 
Status 

The status flag followed by the transaction reference number of the related transaction. 
 
Bill Code 

The billing code attached to the transaction (billing item transactions only). 
 
Amt 

The dollar amount of the transaction. 
 
GST 

The GST amount of the transaction. 
 
Disc 

The amount of any discount applied to the billing item (billing items only). 
 
Bal 
The balance owing on the billing item (billing items only). 
 
Student/Cust 
The student name or the customer name. 
 
Description 
The comment attached to the transaction.  
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Reason 

The reason attached to the transaction. 
 
Operator 

The User Name of the user who entered the transaction. 
 
 

8.7.7 Print Re-allocation Transactions (Only available if not exporting) 

IMPORTANT  

This report is not available if the automatic export to RM Finance has 
been turned on, i.e. when the ‘Enable Export to RM Finance’ option in 

Billing Parameters is ticked. 

 
At times the allocation of receipts may change in RM Billing. For example, a parent may pay some 
money in advance to be used throughout the year. The money is entered in RM Billing as 
unallocated credit. It is then transferred into RM Finance and posted against the suspense account 
(N3199). 
 
Then the student is billed for a camp and the parent instructs for some of the money to be used. So 
the money is now allocated in RM Billing to the Camp billing items for the student.  
 
What has happened is that the allocations in RM Billing have changed, and therefore a change 
needs to be made in RM Finance to ‘move’ the money out of the suspense account and into the 
appropriate ‘C’ account for the camp. 
 
The ‘Print Re-allocation Transactions’ function produces a Receipts Summary report which lists 

these types of changes only, so that the necessary adjustments can be made in RM Finance. 
 
This report must be printed and the transactions marked as posted before the Export to RM 
Finance can be turned on. 
 
 

8.7.8  To print re-allocation transactions 

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Print Re-allocation Transactions 

 The window appears as shown below: 
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 Click on Print 

 Select the report destination as Printer 

 The Detailed report is printed, followed by the Totals Only report (example below) 
 

 
 
 

 Go to the printer and check whether the report has printed successfully 

 The following message is then displayed: 
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If the report has not printed correctly click on ‘No’ and restart this process 
If the report has printed successfully click on ‘Yes’ 
If ‘Yes’ has been selected then the transactions will be marked as posted and the following 

message will be displayed 
 

 
 

Click on OK. 

 
 

Note: The transactions will not be marked as posted if the report is printed to the screen. In 

this case the following message will be displayed.  

  

The transactions listed in the report should now be entered into RM Finance. 

Note: The overall total of the Print Re-allocation Transactions report will always be zero. 
This is because it represents the movement of monies between accounts (e.g. debit one 
account and credit another, so the overall effect is zero). In the sample report shown above 
an income correction transaction for $20 would be entered against the suspense account 

(N3199), and an income transaction for $20 would be entered against the C account (C1001). 

 

8.7.9 Re-Print Re-allocation Transactions 

Each time a re-allocation report is printed it is saved by the system. This will allow the user to re-
print a previous re-allocation report. 
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8.7.10  To Re-Print Re-allocation Transactions 

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Re-Print Re-allocation Transactions 

 The window appears as shown below: 
 

 
 

 Highlight a previous report (named by the date and time the report was initially printed) in 

the list on the right hand side 

 Click on Print 

 Select the report destination 

 The report is printed in the format illustrated below (a portion of the detailed report is 
shown) 
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The date and time of printing of the original report is listed in the report title.  
 
The detailed version of the report is printed followed by the ‘totals only’ version. 
 

8.7.11 Re-Print Auto Allocate Transactions 

In the Billing Items > Batch Billing Items window there is a facility that enables unallocated credit to 
be automatically allocated to billing items. (See section 6.13 on page 6-20.) This is achieved by 

clicking on the icon illustrated in the window below. 
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At the completion of this process a report is produced listing the allocations which have been 
made. 
 
These reports are saved and may be re-printed at a later time if required. 
 
This report option allows the user to re-print a previously printed report. 
 

8.7.12  To Re-Print Auto Allocate Transactions 

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Re-Print Auto Allocate Transactions 

 The window appears as shown below 
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 The list of previously printed reports appears on the right hand side. These are labelled by 
the date and time the previous report was run 

 Highlight the report to be re-printed 

 Click on Print 

 Select the report destination 
The report is printed in the format illustrated below 
 

 
 
The date and time of printing the original report is listed in the report title. The word ‘Re-Printed’ 
indicates this is a re-print of the original report. 
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8.7.13 Timetabled Subjects and Billing Items 

 

Note: This report will only appear in the list if the Timetabling module is installed. 

 
This report identifies mismatches between the subjects in which a student is enrolled (in 
Timetabling) and the subject billing items which have been created (or not) for the student in RM 
Billing. It is a useful tool in identifying whether students have been correctly billed for the subjects 
they are studying. 
 
Three versions of the report are available. 

8.8  Report Version 1 – Subjects with no Billing Items 

This report will identify if a student is enrolled in a subject in Timetabling (i.e. has a primary 
preference for a subject) but does not have a matching billing item for that subject in RM Billing (for 
the selected year). 
 
For example, the student shown below has the following primary preferences for 2011. 
 

 
 
However, she has no subject billing items for any of these subjects. 
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The report will identify any students who have one or more subjects without matching subject 
billing items. 
 

 

8.8.1  To Print a Report on Subjects with No Billing Items 

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Timetabled Subjects and Billing Items 

 The window appears as shown below 
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 Select the year to be reported 

 Click on New Query and select the students to be reported 

 Click on Subjects with no Billing Items 

 Click on Print 

 Select the report destination 

 The report is printed in the format illustrated below 
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8.9  Report Version 2 – Billing Items with no Subjects 

The purpose of this report is to identify if a student has billing items for subjects in which they are 
not enrolled. For example, the student has a billing item for a subject but they do not have a 
primary preference in Timetabling for that subject (for the selected year).  
 
The student shown below has the following primary preferences for 2011. 
 

 
 
She has the following billing items for 2011. Note that a billing item has been created for 2BBIO 
Biological Sciences 2B 2011 but there is no primary preference for this subject. 
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The report will identify any students who have one or more subject billing items without matching 
subjects. 
 

Note: If a subject billing item has been reversed, adjusted, discounted or written-off, then it 
will not be reported if there is no matching subject. This is because the user has already 

dealt with this item (by reversing, adjusting, discounting or writing it off). 

 

8.9.1  To Print a Report on Billing Items with No Subjects 

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Timetabled Subjects and Billing Items 

 The window appears as shown below 
 
 

 
 

 Select the year to be reported 

 Click on New Query and select the students to be reported 

 Click on Billing Items with no Subjects 

 Click on Print 

 Select the report destination 

 The report is printed in the format illustrated below 
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8.9.2  Report Version 3 – Both 

This version of the report will combine the information shown in version 1 and version 2 of the 
report. 
 
The report will list students who have subjects with no billing items and students who have billing 
items with no subjects. If a student falls into both categories then the student name will be listed 
once and both sections will appear for that student. 
 
 

8.9.3 To Print a Report on Both 

 Click on Reports 

 Click on the Transactional Reports folder 

 Highlight Timetabled Subjects and Billing Items 

 The window appears as shown below 
 

 

 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 8-55 

© 2016 Civica Education Pty Ltd 
 

 
 

 

 Select the year to be reported 

 Click on New Query and select the students to be reported 

 Click on Both 

 Click on Print 

 Select the report destination 

 The report is printed in the format illustrated below 
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8.10 Secondary Financial Assistance Summary 

The Secondary Financial Assistance Summary Report will print a list of students who have made 
an application for Secondary Financial Assistance. The report will display the Status of the 
application made. Details on how to make applications for Financial Assistance are explained in 
Section 4.9 of this Manual. 
 

 
 
The Report can be filtered by Year, Assistance Type or the Status of the Application as required. 
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8.11 Audit Reports 

The Audit Reports folder contains the following reports: 
 

 
 

8.11.1 Audit Report 

The Audit Report prints an audit trail (transactional listing) of all transactions which have not yet 
been printed.  
 

8.11.2  To print the audit report 

 Click on Reports 

 Click on the Audit Reports folder 

 Highlight Audit Report 

 The window appears as shown below: 
 

 
 

 Click on Print 

 Select the report destination 

 A list of all transactions which have not been printed are printed to the selected destination 
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Note: If no new transactions have been entered since the last audit report was printed the 

following message will be displayed: 

 

 
A portion of a sample report appears below: 
 
 

 
 
The following information is displayed on this report: 
 
Tx Ref 

The transaction reference number. 
 
Date 

The date the transaction was created. 
 
Type 

The transaction type/payment type.  
 
For a receipt this could be any valid payment type (from Parameters > Valid Payment Types) or  
 
RV Reversal 
RF Refund 
 
For a billing item this could be one of the following: 
 
DR Debit (normal billing item) 
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RV Reversal 
AD Adjustment 
 
Status 

The status flag followed by the transaction reference number of the related transaction. 
 
Bill Code 

The billing code attached to the transaction (billing item transactions only). 
 
Disc 
If a discount has been applied to a billing item this column will contain the letter ‘Y’ (billing items 
only). Otherwise it will be blank. 
 
Amount inc disc 

The dollar amount of the transaction after any discount. 
 
GST 
The GST amount of the transaction. 
 
Student/Customer 
The student name or the customer name. 
 
Batch # 
The billing items batch number (for billing items) or the receipts batch number (for receipts) of the 
batch which contains the transaction. 
 
Description 
The comment attached to the transaction.  
 
Operator 
The User Name of the user who entered the transaction. 
 

8.11.3 Audit Reprint 

The Audit Reprint allows a previously printed audit trail to be re-printed.    
 

8.11.4  To reprint an audit report 

 Click on Reports 

 Click on the Audit Reports folder 

 Highlight Audit Reprint 

 The window appears as shown below: 
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 The list of previously printed audit reports appears on the right hand side. These are 
labelled by the date and time the previous report was run. 

 Highlight an audit report to be printed 

 Click on Print 

 Select the report destination 
 
A portion of a sample audit reprint is shown below. Note that the report heading indicates it is a 
reprint. Otherwise all details of the report match the original. 
 

 
 

8.11.5 Re-print Receipts Batch Export Summary 
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Receipt batches which have been exported into RM Finance can be reprinted through the ‘Re-print 
Receipts Batch Export Summary’ Audit Reports.  These are reports which have been previously 
printed are listed in date/time order descending, with the most recent report appearing at the top of 
the list. 
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There are two radio buttons on the report window.  The first radio button displays the text ‘Show 
reports after’, followed by a date.  The default date displayed is set to three months prior to the 
current system date.  The date selector is displayed to the right of this field and standard 
functionality applies. 
The second radio button displays the text ‘Show all reports’.  If the user selects this radio button, 
then all reports which have been previously printed using RM Billing v1.30.10 are displayed in the 
list.   
The user can select one report to re-print, by highlighting it in the list on the right hand side. 
 

 
 
When the user clicks the Print button, the report destination screen is displayed.  Once the user 
has selected the required destination, the report is printed. 
 

 



 
 
  

Utilities 

9 
 

                          RM Billing Manual 
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9 Utilities 
 
The section provides a number of utilities or processes which can be carried out by the system. 
 
When the Utilities icon is selected on the RM Billing sidebar the Utilities window will open as 
illustrated below: 
 

 
 

9.1 Create Subject Billing Items 

IMPORTANT 

This function is only available when the Timetabling module is installed. 
If this option is selected when the Timetabling module is not installed 

then the following message will be displayed: 

 

 
If the Timetabling module is installed then this function will enable subject billing items (based on 
the current Primary Preferences in Timetabling) to be created in bulk for a group of students. 
 
This process can only be run once for each student in each billing year. Once subject billing items 
have been created for a particular student, any changes required to those items must be handled 
from the Students > Billing Items section. Refer to section 4.14.4 on page 4-50 for further details. 
 

9.1.1 To create Subject billing items 

 Click on Utilities 

 Double-click on Create Subject Billing Items 

 The following message is displayed: 
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 Click on Yes 

 If future years exist in the datafile then the year selection box will be displayed (showing 

current and future years only) 

 If no future years exist then this step will be omitted and the current billing year will be used 

 Select the required year for the creation of subject billing items (if appropriate) 

 The following window will now appear: 
 

 
 

 Use the student find tool (binoculars) to select the students for whom subject billing items 

are to be created 

 Click on OK 

 The window now reflects the number of students selected 
 

 
 
 
 

 Click on OK 

 The following message appears: 
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 Click on Yes 

 Subject billing items are created for the selected students using the method outlined 
below. 

 If all subject billing items are able to be created for the selected students then the 
following message is displayed: 

 

 
 
The following rules apply when creating subject billing items: 

9.1.2  Rules for creating subject billing items 

 
Each student can have at most two billing items created for a subject – one for Cost Type 1 and 
one for Cost Type 2.  The following table shows which cost types are associated with each student 
billing category. 
 

Student Billing Category Cost type 1 Cost Type 2 

Kindergarten Voluntary Contributions Compulsory Charges 

Pre-Primary Voluntary Contributions Compulsory Charges 

Primary Voluntary Contributions Compulsory Charges 

Secondary (Vol,Chg) Voluntary Contributions Compulsory Charges 

Secondary (Chg) Compulsory Charges Not Applicable 

Adult Adult Students Compulsory Charges 

Temporary Visa Temporary Visa Overseas 
Students 

Compulsory Charges 

Full Fee Paying Not Applicable Not Applicable 

 
Where a Cost Type is listed as Not Applicable in the table above a billing item will not be created. 
So for example, Full Fee Paying students cannot have any subject billing items created by this 
process. Secondary (Chg) will only be able to have one billing item per subject created (in the 
Charges category). 
The rules used to create these billing items are as follows. 
 
For the billing category of the first selected student: 
If Cost Type 1 <> 0 then a billing item for the first subject (primary preference from Timetabling) will 
be created using the Amount, GST code and Billing Code from the subjects table for the selected 
year for this cost type. The comment for this billing item will be - the subject code, followed by the 
subject name, followed by the year to which the subject belongs (which will be the year selected by 
the user). For example, 9Art–Art 9 2006.  
 
If Cost Type 1 = 0 then no billing item will be created for this cost type. 
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If Cost Type 2 <> 0 then a billing item for the first subject (primary preference from Timetabling) will 
be created using the Amount, GST code and Billing Code from the subjects table for this cost type. 
The comment for this billing item will be as explained above.   
 
If Cost Type 2 = 0 then no billing item will be created for this cost type. 
 
This process will be repeated for each primary preference stored in Timetabling (for the selected 
year) for the first student. 
 
The process will then be repeated for each student selected. 
 
These subject billing items will be placed into a special system-generated billing items batch 
named with the text ‘Subjects Batch’ followed by the selected year.  For example ‘Subjects Batch 
2008’. 
 

9.1.3  Exception Report 

 
If there are any students for whom no billing items can be created then an exception report will be 
produced which lists the students and the reason why no billing items could be created for each 
one.   
 
The reason could be one of the following: 
 

Student does not have a fees biller  

Student does not have a student billing category defined for the selected year 

Student is a Full Fee Paying student 

All related values in the subject table for this student are set to zero 

There are no billing subjects defined for this student 

Subject billing items have already been created for this student in the selected 
year 

 
A sample exception report appears below: 
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9.2 Export Secondary Financial Assistance 

Secondary Financial Assistance Applications can be exported at any time prior to the cut-off date. 
This date will vary from year to year and you should seek clarification for DoE if unsure. 
 
For full details on managing Secondary Financial Assistance Applications see Section 4.9 of this 
Manual. 
 
To Export completed applications: 
 
Navigate to Billing | Utilities 
 

 
 
Double click on Export Secondary Financial Assistance 
Check the Confirmation Email message and Click Yes if the address is correct 
 

 
 

 
 
The file will be exported. The location of the file is dependent on the file path set up in the Billing 
Parameters. See Section 3.4 of this Manual for details. 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 9-7 

© 2016 Civica Education Pty Ltd 
 

 
Once a file has been exported, the student record will be updated so that the Status of the 
application is changed to Sent. 
 

 
 
The exported file can be viewed at the saved location. The File will be a text file containing the 
details of the applications included in the current export. Each export file will be uniquely named 
with the school code and date and time values (See example below). 
 

 
 
This file must be emailed as an attachment to student.allowances@education.wa.edu.au at 
Schools Resourcing and Support Directorate at the Department of Education. 
 
  

mailto:student.allowances@education.wa.edu.au
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9.3 Export to RM Finance 

IMPORTANT 

This function is only available when the ‘Enable Export to RM Finance’ 
option is enabled in Billing Parameters.  If this option is not ticked and 

the Export to RM Finance function is selected then the following 
message is displayed: 

 

The ‘Export to RM Finance’ option allows receipts to be exported automatically (under user control) 
to RM Finance removing the need to re-enter data into RM Finance. All Receipts are available for 
export with the exception of Government Subsidies. Any Government Subsidies which are entered 
into RM Billing will be automatically excluded from the export function. This is because 
Government Subsidy money is entered directly into RM Finance. 
 
 

9.3.1 To export receipts to RM Finance 

 Click on Utilities 

 Double-click on Export to RM Finance 

 The following message is displayed: 
 

 
 

 Click on Yes 

 A list of batches containing transactions which have not been exported is displayed as 
illustrated below (see section 9-9 below for more detail) 
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 Select the batches to be exported (multiple selection permitted) 

 The Print Setup screen is displayed: 

 

 
 

 Make any required changes 

 Click on OK (selecting Cancel will cancel the entire export process) 

 The Receipts Batch Export Summary is printed to the printer (see section 9.3.3 below 

for more details) 

 The transactions are exported to RM Finance and the following message is displayed: 
 

 
 

 Click on OK 
 

9.3.2  List of Batches to be Exported 

When the batch selection screen is presented for export all open receipts batches will be displayed 
(with the exception of batches which contain Government Subsidies only).  
 
Closed receipts batches which contain receipts linked to new allocation records (because the 
allocations have changed since the last export took place) will also be listed. These batches will be 
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denoted by an asterisk (*) and the text ‘Re-allocation transactions’ will appear at the bottom of the 
window. 
 
Generally all batches should be selected for export unless there is a particular reason for not 
exporting (i.e. a batch has been opened for next month’s transactions). 
 

9.3.3  Receipts Batch Export Summary 

This is a report which is printed automatically to the printer at the time of exporting. It cannot be 
printed to the screen or any other destination. It lists all batches which have been exported and all 
batches which have not been exported during the export process. 
 
A sample report appears below: 
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Note: The School Principal is required to sign this report at the end of each month. The 
report should show that all batches have been exported. Any exceptions to this require an 
explanation to be provided (e.g. next month’s transactions).  

This report will be printed even if there are no batches to be reported. In this case both 
sections – ‘Batches Not Exported’ and ‘Batches Exported’ - will have the text ‘No Batches’ 

listed under the heading. The Principal is still required to sign this report. 

 

9.3.4  Grouping of transactions for RM Finance 

When transactions are exported from RM Billing to RM Finance, the transactions are not exported 
individually. The transactions are grouped by budget, analysis and GST code and an overall total is 
exported for each grouping. Details of the individual transactions are available within RM Billing. 
 

9.3.5  Updating transactions in RM Finance 

When the transactions are exported from RM Billing to RM Finance they are placed in a normal 
RM Finance batch.  
 
Once the export is complete, each batch needs to be checked and updated in RM Finance. This 
involves following the normal RM Finance process of printing the batched transactions report for 
checking, and if everything is correct, updating the batch. 
 
Refer to the RM Finance manual for more detail on this if required. 
 

9.3.6  Closing of receipts batches 

All batches exported to RM Finance are automatically closed by the system. 
 
 

9.3.7  Possible Error Messages when Exporting 

The following messages/reports may be displayed when exporting to RM Finance. 
 

9.3.8 No default bank account 

 

 
 
The default bank account must be nominated in RM Finance before the export can proceed. 
Consult the RM Finance manual for further details. 
 

9.3.9 Invalid Codes 
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One or more RM Finance budget and/or analysis codes which have been attached to a billing code 
in RM Billing, no longer exist in RM Finance. A report on the missing codes can be printed to the 
default printer by clicking OK. The missing codes will need to be re-created in RM Finance before 
attempting the export again. 
 
A sample report appears below. 
 

 
 

9.4 Import Receipts for Secondary Assistance 

Once an Export file has been sent to the Schools Resourcing and Support Directorate, it will be 
evaluated and then Import Receipts files will be emailed back to the school. These files will need to 
be imported to create Secondary Assistance receipts for the students in the application. For full 
details on the Application process see Section 4.9 of this Manual. 
 
Files may be for the (EPA) Education Program Allowance (GV for $235) or (CLA) Clothing 
Allowance (DD for $115) if the parent has nominated that the Clothing Allowance be paid directly to 
the school (See Samples Below). Both types of Receipt file are imported in the same way. 

Sample Education Program Allowance Receipt File 

 

Sample Clothing Allowance Receipt File 
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To Import the Receipts: 
 
Navigate to Billing | Utilities 
 

 
 
Double Click on Import Secondary Financial Assistance Receipts 
Navigate to the location where the Import File was saved 
 

 
 
Double Click on the file or highlight and click Open 
Click OK and OK to the messages 
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Importing receipts in this way will create a Receipts Batch for the Secondary Assistance receipts. 
This batch can be viewed in Billing | Receipts and will be named according to the type of 

allowance and the date the file was created. 
 

 
 

9.5 Purge Former Roll Students 

As a school’s datafile increases in size it may be desirable to purge some old data from the datafile 
to prevent the number of transactions from becoming unwieldy and to improve datafile 
performance. 
 
This utility allows old RM Billing transactions for students on the former roll to be removed.  
 
The routine will only purge transactions for students on the former roll with a zero transactional 
balance and a leave date of at least one year prior to the last year end date stored in Billing 

Parameters. 
 
The routine will remove the following: 
 

 All transactions and their associated links and invoices linked to the eligible selected 
students. 

 Any billing item batches which are closed and empty (due to removal of transactions). 

 Any receipt batches which are closed and empty (due to removal of transactions). 
 
 

IMPORTANT 

A backup copy of the datafile must be taken before running this routine. 

 

9.5.1  To purge records for former roll students 

 

 Ensure all users are logged out 

 Take a backup of the datafile 

 Log in and place the datafile in Single User mode 

 Click on Utilities 
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 Double-click on Purge Former Roll Students 

 The following message is displayed 
 

 
 
 

 Edit the message as required and click OK 

 A message similar to the following will then appear (note the date displayed will be one 
year prior to the last year end date) 
 

 
 
 

 If you have made a backup click Yes 

 Otherwise click ‘No’. The process will abort so a backup can be taken. 

 Once a backup has been made the following window will be displayed 
 

 
 

 Click on the binoculars to open the student find tool 
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 The roll status selection will default to the former roll as illustrated above 

 Select the students for whom transactions are to be purged and click OK 

 

IMPORTANT  

It is recommended that only a small number of students are selected at 
one time. This is because the purging routine could take a significant 

amount of time to run if a large number of students are selected. 

 

 Once students have been selected the system will check which ones meet the required 
criteria 

 All selected students meeting the criteria will then be displayed in the following window 
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 Highlight the student records to be purged 

 Click Purge Selected Students 

 The following message will then appear 
 

 

 
 

 Click Yes to continue or No to abort the process 

 Once Yes is selected the purging will begin 

 A series of working messages will be displayed whilst the process is being carried out 
 

IMPORTANT  

Do not interrupt the process whilst it is running. This could cause 
corruption to the datafile. 

Wait until the ‘Purging complete’ message is displayed. 
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 When the process has completed a message similar to the following will be displayed.  
 

 
 
 

 A report on the purged transactions will be created and saved to the billing archive folder 
(as listed in Billing Parameters) 

 

9.5.2  To view the Archive Report 

 

 Select File > Print Saved Reports (from disk) 

 Navigate to the Billing Archive folder path (e.g. K:\RMDB\OLDDATA\Billing Archive) 

 Double-click on the report to be viewed 

 The report will now be displayed and can be printed by the normal methods if required 

 A portion of a sample report appears below 
 
 

 
 

Note: The report will be named ‘BillingArchiveddmmyy.rep’ where ‘ddmmyy’ represents the 
day, month and year the report was created. If two or more reports are created on the same 
day then the filename will be appended with ‘_1’, ‘_2’, etc. as illustrated in the following 

example. 
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9.5.3  Possible messages 

 
When running the purge routine the following messages may be displayed at certain times.  

9.5.4 Billing Archive folder path incorrect 

 

 
 
The path listed in the message does not exist. Either create the path listed, or go to Parameters > 
Billing Parameters > General and select a valid archive folder path. 
 

9.5.5 Archive folder path access denied 

 

 
 
The logged-in user does not have write access to the billing archive folder path as listed in the 
message. Write access must be granted before the process can continue. Contact the System 
Administrator at your school or the Customer Service Centre for assistance. 
 

9.5.6 No students matching the criteria 

 

 
 
This message will be displayed if none of the selected students meet the required criteria. 
 

9.5.7 Students with no data to purge 
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The students selected meet the criteria but they had no transactions to purge. 
 
 
 
 

9.6 Update Student Names from Admin 

 
The student name entered in the Administration module is also saved in the RM Billing module. It 
is necessary to save the student name in RM Billing because it is possible that a student may be 
deleted from the Administration module. If this student has transactions in RM Billing then the 
name of the student would be lost if it was not saved within the RM Billing module. 
 
However, there are cases where the student name changes in the Administration module (either 
due to an actual name change or a data entry error) and therefore must be updated in RM Billing.  
 
The ‘Update Student Names from Admin’ utility will allow the user to update all student name 
changes in the RM Billing module to ensure they match the names stored in the Administration 
module. 
 

9.6.1 To Update Student Names from Admin 

 Click on Utilities 

 Double-click on Update Student Names from Admin 

 The following message is displayed: 
 

 
 

 Click on Yes 

 Select the report destination 

 A report will be produced in the format shown below listing the names which have been 
updated  
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Note: If all names match correctly then the report will not be printed and the following 

message will be displayed. 

 

 

Note: If the student name stored in RM Billing does not match the student name stored in 
the Administration module then the light globe icon will appear on the Students > Details 
tab. This enables the student name for an individual student to be updated from this area. 

Refer to section 4.11 on page 4-41 for further details. 

9.7 Write off/Cancel Customer Debt 

 
The ‘Write off/Cancel Customer Debt’ option allows debt to be written off for a customer when it is 
likely it will never be recovered. 
 

Note: All write offs must be carried out in accordance with the WA Department of Education 

and Training’s write off policy. 

 
Before using this function it is necessary to create a special billing items batch to hold the write-
offs. This can be done via the Billing Items section. The batch created should not contain any tied 
billing items. A sample batch appears below: 
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9.7.1 To write off/cancel a customer debt 

 Click on Utilities 

 Double-click on Write off/Cancel Customer Debt 

 The following message is displayed: 
 

 
 

 If a write-off batch has not been created, click on No. The batch can then be created and 

this process re-started. 

 If a write-off batch has been created, click on Yes 

 The following screen is then displayed: 
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 Select the year to which the debt belongs (all past years plus the current billing year are 

available for selection) 

 Use the customer find tool (binoculars) to select the required customer (only one 

customer can be selected) 

 The billing items for the selected customer and year will then be displayed as illustrated 
below: 

 

 
 

 Highlight the billing items to be written off  

 Click on OK 

 The following message is displayed: 
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 Click on Yes 

 The batch selection screen is then displayed: 
 

 
 

 Enter the appropriate write-off batch (or press <tab> for a list of all open batches) 

 Enter a reason for the write-off 

 Click on OK 

 The following confirmation message is then displayed: 
 

 
 

 Click on OK 
 
The write-off transaction is created against the customer record as illustrated below: 
 

 
 

 

9.8 Write off/Cancel Student Related Debt 

 
The ‘Write off/Cancel Student Related Debt’ option allows debt to be written off or cancelled for a 
student when it is likely it will never be recovered. 
 

Note: All write offs must be carried out in accordance with the WA Department of Education 

and Training’s write off policy. 
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Before using this function it is necessary to create a special billing items batch to hold the write-
offs/cancellations. This can be done via the Billing Items section. The batch created should not 
contain any tied billing items. A sample batch appears below: 
 

 
 
 

9.8.1 To write off/cancel a student related debt 

 Click on Utilities 

 Double-click on Write off/Cancel Student Related Debt 

 The following message is displayed: 
 

 
 

 If a write-off batch has not been created, click on No. The batch can then be created and 

this process re-started. 

 If a write-off batch has been created, click on Yes 

 The following screen is then displayed: 
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 Select the year to which the debt belongs (all past years plus the current billing year are 

available for selection) 

 Use the student find tool (binoculars) to select the required students (multiple students 
can be selected) 

 The number of selected students will then be displayed on the window 
 

 
 

 Click on OK 

 The following window then appears. (Only the selected students who have outstanding debt 
for the selected year will be displayed.) 

 

 
 
Sorting by clicking on column headings is enabled. 
 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 9-28 

© 2016 Civica Education Pty Ltd 
 

The quick search on student surname is available on this window. Click in the students column 

and enter the full or partial surname of the student. 
 
The following information is displayed on this window: 
 
Student Name 
The name of the student. 
 
Year  

The current year group of the student. 
 
Form  

The current form group of the student. 
 
CHG 

The total of unpaid billing items for the student for the selected year in the category of Charges. 
 
VOL 

The total of unpaid billing items for the student for the selected year in the category of Voluntary 
Contributions. 
 
ADU 

The total of unpaid billing items for the student for the selected year in the category of Adult 
student fees. 
 
TMP 

The total of unpaid billing items for the student for the selected year in the category of Temporary 
Visa Overseas Students. 
 
RES 
The total of unpaid billing items for the student for the selected year in the category of Residential 
Boarding Fees. 
 
VAR 

The total of unpaid billing items for the student for the selected year in the category of Voluntary 
Approved Requests. 
 
OOC 

The total of unpaid billing items for the student for the selected year in the category of Other 
Optional Costs. 
 
N/A 

The total of unpaid billing items for the student for the selected year in the category of Not 
Applicable. 
 
Total 

The total of the amounts listed on the screen for the student. 
 

9.8.2  To print the write-off report 

 
The Write-off/Cancel report must be printed and approval obtained before actually performing any 
write-offs/cancellations. 
 

 Highlight the students for whom the debt is to be written-off/cancelled 
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 Tick the appropriate tick boxes on the column headings to select the categories to be 

written off/cancelled. Only the amounts in the ticked columns will be removed for each 
selected student (see example below) 

 

 
 
 
  

 Click on Print Selected   

 Select the report destination 
 

Note: The Print button on the top tool bar will print a list of all students and amounts 
currently displayed on the screen. This report cannot be used to obtain approval for write-

offs/cancellations. 

 
A sample report is shown below: 
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Once approval has been obtained and the above form has been signed, the write-
offs/cancellations can be performed. 
 

9.8.3  To write-off/cancel the debt 

 With the selection of students still highlighted and the correct boxes ticked, click on For 
Selected 

 Click on Write-off/Cancel Student Related Debt 

 The following message is displayed: 
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 If the report has not been printed click on ‘No’. Print the report and then re-start this 

process. 

 If the report has been printed click on ‘Yes’ 

 The following message is then displayed: 
 

 
 

 Click on Yes 

 The batch selection screen is then displayed: 
 

 
 

 Enter the appropriate write-off batch (or press <tab> for a list of all open batches) 

 Enter a reason for the write-off 

 Click on OK 

 The following confirmation message is then displayed: 
 



 
IntegrisRMBillingManual.docx 26-Jul-16 

Page 9-32 

© 2016 Civica Education Pty Ltd 
 

 
 

 Click on OK 
 

The write-off transactions are created against the student records.   
 
These transactions can also be viewed by looking at the Billing items write-off batch. 
 

 

9.9 Year End Processing 

 
The option allows the user to perform a year end roll over.  
 

9.9.1 Preparing for Year End Processing 

A number of actions must take place before year end processing can be carried out. These actions 
are described below. 
 

 The system date on the workstation must be at least one year in advance of the last year 
end date stored in Billing Parameters. Year End cannot be run twice in the same year. 

 

 All transactions must have been printed in an audit trail prior to performing year end. 
(Reports > Audit Reports > Audit Report). 
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 If the ‘Enable Export to RM Finance’ is ticked then all receipts must have been exported to 
RM Finance prior to performing year end. 

 

 If the ‘Enable Export to RM Finance’ is not ticked then all receipts must have been marked 
as posted (with the exception of Government Subsidies), i.e. receipt batches closed and all 
re-allocation transactions printed. 

 

 The calendar for the new year (i.e. the subsequent year to the current billing year) must be 
created in Admin prior to performing the year end. 

 
If any of these conditions are not met the year end process cannot be run and a message will be 
displayed detailing why the year end cannot continue. 
 
Some sample messages are displayed below: 
 

 
 

 
 

 
 

9.9.2 Possible Year End Error Messages 

The error messages which may be displayed when attempting to perform the year end roll over are 
listed in the table below: 
 

Possible Year End Error Messages 

Last Year End date is 31 Dec 2006.  The process cannot be run until 12 months after this 
date. 

All transactions must be printed in an audit trail prior to performing year end. 

There are receipts which have not been exported to RM Finance. 

All receipts must be marked as posted prior to performing the Year End process. 

Year 2008 has not been created in General > School Details > School Diary > Setup School 
Year. 
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9.9.3 To perform the year end roll over 

 

Note: Year End Processing must be carried out in single user mode. Ensure all other users 

are logged out before beginning the year end process. 

 

 Click on Utilities 

 Double-click on Year End Processing 

 The following message is displayed: 
 

 
 

 Select ‘Yes’ if a backup has been made. If not, select ‘No’ to exit from the year end 

process. 

 If ‘Yes’ is selected the following message is then displayed: 
 

 

 
 

 The locked message and the estimated time can be edited as required 

 Click on OK to proceed 

 The year end process will then be performed and working messages such as the following 
may be displayed whilst the process is running. 
 

 
 

 

 When the process is complete the following message appears: 
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 Click on OK 
 

9.9.4 Year End Actions 

The following actions are carried out as part of the year end process: 
 

 Billing Item batches (apart from Subject batches) attached to the current year are closed. 
Those created which are attached to the new year are left open. All subject batches remain 
open. 

 Receipt batches in the current year are closed. 

 The Last Rollover Date is updated in Billing Parameters to be the system date on which the 
year end process is performed. 

 The Last Year End date is incremented by one year in Billing Parameters. 

 The current billing year is incremented by one year. 

9.9.5 Year End Report 

A report which details the actions carries out during the year end process is sent to the 
…Integris\Outbox. 
 
A sample report appears below: 
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11 Support  

11.1 WA 

Should you require support please contact the Customer Service Centre (CSC) at the Department 
of Education. 
 
Contact details below: 
 

Phone (CSC) 

Metro:   9264 5555 
Country:  1800 012 828 
 
Please be prepared to supply your ID number, contact details and a brief description of the 
problem. 
 

Fax (CSC) 

9264 4701 
 
Please include your ID number, contact details and a brief description of the problem. 
 

Email (CSC) 

customer.service.centre@education.wa.edu.au 
 
Please include your ID number, contact details and a brief description of the problem. 

 
 

11.2 NT 

Should you require support please contact the following: 

DEET SAMS Support  

Email  sams.deet@nt.gov.au 
Or Call DEET Hotline 8999 3531 
Or Fax SAMS/DEET 89995611 
Or Web Site  http://www.latis.net.au/sams/ 
 
 

mailto:customer.service.centre@education.wa.edu.au
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